# Table of Contents

## Introduction
- Welcome to IP Communications Management .................................................. 1
- About this Guide .................................................................................................. 2
- Audience and Expertise ..................................................................................... 2

## Overview
- Introduction to IPCM ......................................................................................... 3
- IPCM Terminology ............................................................................................... 4
- IPCM Architecture ............................................................................................... 5
- Client Applications and Web Interfaces .............................................................. 7

## Preparation
- System Requirements .......................................................................................... 10
- SIP Hardware Requirements .............................................................................. 11
- Network Requirements and Recommendations .................................................. 11
- License File Requirement .................................................................................... 12
- System Reliability and Availability ..................................................................... 12
- Database Planning ............................................................................................... 12
- Integration Options .............................................................................................. 12
- Configuration with FRS Products ...................................................................... 13
- Phone Options: Desktop Phone vs. Softphone .................................................... 13
- Text-to-Speech (TTS) Integration Option ............................................................. 14
- Backup Server Option ......................................................................................... 14
- Ports and Firewall Settings .................................................................................. 16
- IPCM Deployment Process .................................................................................. 17

## Installation
- Server Installation ............................................................................................... 19
  - Microsoft SQL Server Setup ........................................................................... 19
  - Installation Procedure ....................................................................................... 19
- Management Console ........................................................................................ 26
  - Server Verification ............................................................................................ 26
- Client Installation .............................................................................................. 27
- Unattended Client Installation .......................................................................... 31
- Management Portal ............................................................................................ 32
  - Navigation ........................................................................................................ 33
  - Entering/Editing Data ....................................................................................... 34

## Dial Plan
- What is a Dial Plan? ............................................................................................. 35
- Dial Plan Implementation .................................................................................... 36
- Dial Plan Best Practices ...................................................................................... 38
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Plan</td>
<td></td>
</tr>
<tr>
<td>Role Configuration</td>
<td>53</td>
</tr>
<tr>
<td>Privileges</td>
<td>53</td>
</tr>
<tr>
<td>Roles</td>
<td>55</td>
</tr>
<tr>
<td>Create Roles</td>
<td>57</td>
</tr>
<tr>
<td>Organizing the Contact Center</td>
<td></td>
</tr>
<tr>
<td>Process Overview</td>
<td>59</td>
</tr>
<tr>
<td>User Profile Management</td>
<td>59</td>
</tr>
<tr>
<td>Create Users</td>
<td>60</td>
</tr>
<tr>
<td>Delete Users</td>
<td>61</td>
</tr>
<tr>
<td>Configure the User Profile</td>
<td>61</td>
</tr>
<tr>
<td>Skill Configuration</td>
<td>64</td>
</tr>
<tr>
<td>Working with Skills and Skill Groups</td>
<td>64</td>
</tr>
<tr>
<td>Delete Skills</td>
<td>66</td>
</tr>
<tr>
<td>Delete Skill Groups</td>
<td>66</td>
</tr>
<tr>
<td>Edit Skill and Skill Group Names</td>
<td>66</td>
</tr>
<tr>
<td>Not Ready Reasons Configuration</td>
<td>67</td>
</tr>
<tr>
<td>Agent Groups</td>
<td>68</td>
</tr>
<tr>
<td>Create Agent Groups</td>
<td>69</td>
</tr>
<tr>
<td>Add Agents to a Group</td>
<td>71</td>
</tr>
<tr>
<td>Move Agents to and from Agent Groups</td>
<td>71</td>
</tr>
<tr>
<td>Edit Agent Groups</td>
<td>72</td>
</tr>
<tr>
<td>Delete Agent Groups</td>
<td>72</td>
</tr>
<tr>
<td>Add Agents</td>
<td>72</td>
</tr>
<tr>
<td>Delete an Agent</td>
<td>73</td>
</tr>
<tr>
<td>Disable Agents</td>
<td>73</td>
</tr>
<tr>
<td>Configure Agent Properties</td>
<td>74</td>
</tr>
<tr>
<td>Agent Settings Tab</td>
<td>74</td>
</tr>
<tr>
<td>Agent Skills Tab</td>
<td>78</td>
</tr>
<tr>
<td>System-Wide Agent Settings</td>
<td>80</td>
</tr>
<tr>
<td>Routing Rules</td>
<td>81</td>
</tr>
<tr>
<td>Configure Routing Rules</td>
<td>82</td>
</tr>
<tr>
<td>Skill-Based Routing: Common Approaches</td>
<td>85</td>
</tr>
<tr>
<td>Create and Configure Routing Rules</td>
<td>87</td>
</tr>
<tr>
<td>Delete Routing Rules</td>
<td>90</td>
</tr>
<tr>
<td>Services</td>
<td>90</td>
</tr>
<tr>
<td>Create Services</td>
<td>91</td>
</tr>
</tbody>
</table>

Phone Number Ranges: 39
Dial Plan Worksheet: 40
Create Users and Assign Extensions: 41
Dial Plan Shortcuts: 41
Trunks and Gateways: 41
Add Trunk/Gateway Entries: 41
Prefix Manipulation: 44

Phone Number Ranges: 39
Dial Plan Worksheet: 40
Create Users and Assign Extensions: 41
Dial Plan Shortcuts: 41
Trunks and Gateways: 41
Add Trunk/Gateway Entries: 41
Prefix Manipulation: 44

Security Plan
Role Configuration: 53
Privileges: 53
Roles: 55
Create Roles: 57

Organizing the Contact Center
Process Overview: 59
User Profile Management: 59
Create Users: 60
Delete Users: 61
Configure the User Profile: 61
Skill Configuration: 64
Working with Skills and Skill Groups: 64
Delete Skills: 66
Delete Skill Groups: 66
Edit Skill and Skill Group Names: 66
Not Ready Reasons Configuration: 67
Agent Groups: 68
Create Agent Groups: 69
Add Agents to a Group: 71
Move Agents to and from Agent Groups: 71
Edit Agent Groups: 72
Delete Agent Groups: 72
Add Agents: 72
Delete an Agent: 73
Disable Agents: 73
Configure Agent Properties: 74
Agent Settings Tab: 74
Agent Skills Tab: 78
System-Wide Agent Settings: 80
Routing Rules: 81
Configure Routing Rules: 82
Skill-Based Routing: Common Approaches: 85
Create and Configure Routing Rules: 87
Delete Routing Rules: 90
Services: 90
Create Services: 91
# Table of Contents

Delete Services ............................................. 91  
Queues .......................................................... 91  
Create and Delete Queues .................................. 92  
Queue Configuration ......................................... 94  
Alarms ............................................................ 99  

## Preparing for Incoming Calls

Voice Application Support .................................. 101  
Application Builder .......................................... 102  
  Applications Page ......................................... 102  
  Application Building Blocks ............................... 103  
  Create a New Application ................................ 104  
  Open an Application ....................................... 104  
  Conditional Exits ......................................... 106  
  Prompts ...................................................... 106  
  Best Practices: Voice Applications ...................... 114  
  Application Builder Applications: File Locations .... 115  
Applications Selector ....................................... 115  
  Configure an Application for Use ....................... 116  
Order of Applications ..................................... 120  
Application Builder Example .............................. 120  
Applications Selector Example ........................... 121  
Text-to-Speech (TTS) Voice Specification ................ 122  

## Office Phone System

Unified Messaging (UM) ..................................... 123  
  Attendant Application .................................... 124  
  Answering Application .................................... 125  
  Access Application ........................................ 126  
  Changing the Start Criteria for UM Applications .... 127  
General UM Settings ........................................ 128  
Unified Messaging (UM) User Settings .................... 130  
  Mail Processing Order Examples ......................... 133  
Global Address Book Management ........................ 134  
Phone Groups ................................................ 135  
  Create and Delete Phone Groups ......................... 135  
Class of Restrictions (COR) ................................ 136  
  Call Restriction Levels ................................... 136  
  Create and Delete a Restriction Class ................. 136  
Authorization Codes ........................................ 139  
User Codes ................................................... 139  

## IPCM Communicator

Configuring the Communicator .............................. 142
Resources

Additional Documentation ................................................................. 147
Contact Us ......................................................................................... 148
Support Site ......................................................................................... 148
Contact Information ........................................................................... 148

Supervisor Functions

Monitor Agents Using the Agent Dashboard ...................................... 149
Log In ................................................................................................. 150
Agent Dashboard Interface ................................................................. 150
Softphone Tab ..................................................................................... 151
Queue Tab ......................................................................................... 152
Quality Management Tab ................................................................. 153
Assign Calls to Agents ...................................................................... 154
Participate in Conversations .............................................................. 154
Monitor Conversations ....................................................................... 155
Recording Agent Conversations ......................................................... 155
Whisper Conferencing ....................................................................... 156
Statistics Console ............................................................................... 156
Viewing Statistics ............................................................................. 158
Log Out Agents ................................................................................. 159
Interaction Reports ............................................................................ 160
Recordings: Search, Listen, and Rate ............................................... 161
Saving Searches ................................................................................ 163

Index
Introduction

Welcome to IP Communications Management

IP Communications Management (IPCM) uses the next-generation, standards-based IP communication transport - Session Initiation Protocol (SIP) - to integrate automated call routing and management, bringing computer-based intelligence to your telephony functionality and tangible benefits to your customers, agents, and managers.

Your workforce is optimized with each phone call - IPCM identifies, evaluates, prioritizes, and distributes each customer’s incoming request quickly and appropriately. IPCM uses Interactive Voice Response (IVR) and availability-based or skill-based routing to ensure customers quickly receive the requisite attention from the proper agent.
About this Guide

The *IP Communications Management Administrator Guide,* (subsequently referred to as *IPCM Administrator Guide*) provides the information necessary to install the IPCM server and client components, as well as IPCM configuration and administrative procedures for setting up your contact center.

Most configurations in this guide are not final; if you change your mind about an option or expand your system, you can adjust the IPCM deployment without having to reinstall the application.

**Audience and Expertise**

This guide is for system administrators with expert-level understanding of the following:

- Microsoft Windows administration
- Telephony concepts
- Server concepts
- Network technology and components

Administrators who plan to integrate IPCM with SIP-enabled phones and gateways must have a working knowledge of those components.

Administrators who plan to integrate IPCM with a CSM/CRM product, such as ISM, Foundation/ITSM, CSM, and GMEE, or GoldMine, must have a working knowledge of that product and security rights to the product administration.

Administrators who plan to customize IPCM must have expert-level knowledge of Extensible Markup Language (XML) and COM.

In addition, Chapter 11: Supervisor Functions, provides procedural information for Contact Center supervisors.
Overview

Introduction to IPCM

**IP Communications Management (IPCM)** is a robust telephony system with a software-based switching platform for bridging traditional telephony networks with VoIP networks. The system offers numerous features, including unified messaging (UM) for end users, advanced networking options, automated voice applications, etc. Integrate IPCM with business applications from both ISM and third-parties such as Microsoft, and link IPCM with VoIP service providers.

IPCM operates from a central server that integrates with your existing telephony network and various data sources, such as ISM, Foundation (ITSM, CSM, and GMEE), and GoldMine applications. Client interfaces can operate locally on the central IPCM server, and remotely from workstations that have continuous access to the central IPCM server.

The solution includes multiple applications and interfaces for the following different types of users:

- **System administrators** - Technical experts who install, configure, and administer IPCM, and manage IPCM users.
- **Application developers** - Developers who create voice applications for IPCM.
- **Contact center supervisors** - Contact center managers who monitor contact center activity.
- **Contact center agents** - Contact center employees who handle calls.
- **Business users** - Users who are not agents or supervisors, but still use a softphone or desktop SIP phone to access IPCM telephony functionality, and can have a unified messaging (UM) account, address book, and dial plan configuration.

IPCM maximizes the potential of contact centers in a variety of ways, including:

- Callers using a public telephone network interact with automated call processing applications, and have real-time conversations with contact center agents who use phones connected to a LAN.
- Various automated call processing applications retrieve data from customers, access databases, authenticate callers, and route calls to the most suitable agent.
- Contact center agents perform basic call tasks (such as answering and transferring calls) from their computers and/or integrated desktop phones.
- Contact center supervisors monitor statistical data about contact center activity, and listen to conversations between agents and callers.
- System administrators monitor server and application activity locally and remotely.

IPCM can be configured to work with ISM, Foundation (ITSM, CSM, and GMEE), and GoldMine Corporate Edition (CE) and Premium Edition (PE) applications. For more information, refer to the following topics in the online help: "IPCM/ISM Configuration," "IPCM/Foundation Configuration," and "IPCM/GoldMine Configuration."
Overview

IPCM Terminology

IPCM call processing uses the following terminology:

- **Agent** - An IPCM user who handles calls, and possesses a set of skills relevant to your contact center that you define in IPCM. Utilizing Contact Center functionality, system administrators designate which IPCM users are agents, and define the skills each agent possesses. IPCM determines automatically which calls the agent is qualified to handle based on the skills the system administrator defines, and routes calls to the user accordingly. IPCM also tracks the agent’s activity for monitoring and reporting purposes.

- **Call** - An open communication line (such as a phone call or chat session) between a caller and a server, or a caller and an agent. There are two types of calls:
  - **Inbound** - A call coming into the contact center.
  - **Outbound** - A call originating from within the contact center.

- **Interaction** - A caller’s attempt to communicate with an agent. Each interaction can involve only one call and one agent, or one call and zero agents if the caller disconnects before IPCM connects the caller to an agent. An interaction begins when IPCM accepts a call, or when an agent transfers the call to another agent. The interaction ends only when the caller disconnects before reaching an agent, or when the agent involved with the interaction completes the after-call work following a conversation with the caller.
IPCM Architecture

The following diagram illustrates the basic IPCM architecture.

This simplified deployment involves the following:

- A single Server installation on a central server (the IPCM host computer)
- A single Client installation on a client computer
- A single database connection (stores interaction data and log data).
- Deployments in real production environments are more complex, involving numerous agent workstations, remote installations of IPCM management tools accessing multiple servers, a third-party reporting interface (such as Crystal Reports) connected to the IPCM database, and additional databases, such as customer information databases, possibly residing on separate computers.
### Overview

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| **SIP Soft Switch**| • Provides telephone number-to-IP address mapping for all SIP-enabled extensions, including the voice server and agent phones.  
• Provides conditional call forwarding, ensuring fault tolerance and reliability by spanning call volumes on multiple gateways.  
• Acts as a SIP registrar, allowing SIP extensions to register IP addresses and use dynamic IP addresses.  
• Provides security for extensions that have user names and passwords set up in the Dial Plan, as the extension must provide valid credentials for registering with the SIP server. Extensions specified with a trusted IP address cannot register (i.e., they cannot change their IP addresses).  
• Connects with a telephony gateway through which IPCM accesses a public phone network such as the United States Public Switched Telephone Network (PSTN). |
| **Media Server**   | Handles actual voice data transported using RTP (Real Time Protocol) protocol.                                                                |
| **Voice Server**   | A SIP extension that provides telephony and voice functionality to IPCM applications, such as playing voice files, recording voice files, playing common data like numbers, currency amounts, etc. (CDS). |
| **License Server** | Verifies the license file; keeps track of licensed features and use.                                                                           |
| **Conference Server** | Manages agent conferencing functionality.                                                                                                     |
| **Contact Center Server** | Provides Contact Center functionality, including user management, call routing, interaction management, agent management, etc.            |
| **Statistics and Metrics Engine** | A component of the server that tracks the activities of agents, interactions, and calls to provide real-time statistics and historical reporting. The Statistics and Metrics Engine stores statistical data in the IPCM database. |
| **Message Server** | Manages communication from the IPCM Integrated Voice Toolbar, used in applications such as ITSM 7.0 to communicate with the IPCM server. Also provides integrated security to support single sign-on. |
| **Management Console** | A client application that lets system administrators start and stop servers and services, reset telephony server channels, and monitor information about current server activity. |
| **Management Portal** | A browser-based interface that lets system administrators control IPCM configurations and management tasks. Includes:  
• System Configuration - Enables configuration of servers, dial plan, users, etc.  
• Application Builder - Development tool used to create multiple voice applications for an IPCM deployment.  
• Log Viewer - Displays data pertaining to server events; useful for troubleshooting.  
• Reporting - Enables the running of statistical reports. |
Client Applications and Web Interfaces

IPCM includes various interfaces and client applications for different types of users. The IPCM installation wizard installs shortcuts to many of these client applications and interfaces in the **Start** menu (**Start>Programs>FrontRange Solutions>IP Communications Management**). Other options are accessible within the IPCM Management Portal (**Start>Programs>FrontRange Solutions>IP Communications Management>Management Portal**).

**Note:** Some IPCM client applications and interfaces are password-protected. Use the default user name **admin** with the default **password** for initial access.

### Client Applications and Web Interfaces

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPCM Communicator</td>
<td>A softphone client application that ships with IPCM - lets end users perform basic telephony tasks such as making phone calls, initiating conference calls, placing calls on hold, transferring calls, etc.</td>
</tr>
<tr>
<td>IPCM Client</td>
<td>A client application (either the IPCM Agent Dashboard or the IPCM Integrated Toolbar) running on the computer of each agent and supervisor in the contact center. The IPCM Integrated Toolbar provides basic call control functionality, such as answering, transferring, and dialing calls using a softphone or IP Desk phone, and also notifying the server of the agent’s availability to receive calls. The Agent Dashboard provides additional functionality for agents: • Instant Messaging among agents • View the properties of calls in the queue. and supervisors: • View the states of all agents and monitor calls. • View the properties of calls in the queue; assign calls to an agent.</td>
</tr>
</tbody>
</table>
Overview
Preparation

This chapter lists the requirements and options to consider before installing IPCM, including:

- System Requirements
- SIP Hardware Requirements
- Network Requirements and Recommendations
- License File Requirement
- System Reliability and Availability
- Database Planning
- Phone Options: Desktop Phone vs. Softphone
- Text-to-Speech (TTS) Integration Option
- Backup Server Option
- Ports and Firewall Settings
- IPCM Deployment Process
System Requirements

The information contained in the table below lists the minimum requirements for running IPCM. These requirements are sufficient for 100 concurrent users and 100 concurrent calls, with 10 calls generated per second.

**Note:** IPCM is not compatible with Kerio WinRoute firewall.

ISM recommends using a dedicated Microsoft SQL server for handling reporting and Quality Management features.

<table>
<thead>
<tr>
<th>Component</th>
<th>Hardware Requirements</th>
<th>Software Requirements</th>
</tr>
</thead>
</table>
| IPCM server host computer | • 10 to 20 agents: 2 CPU/Core (3GHz or greater)  
• 20 to 50 agents: 4 CPU/Core (3GHz or greater)  
• 50 to 100 agents: 8 CPU/Core (3GHz or greater)  
• Minimum 2 GB RAM  
• 2 GB HDD; if you plan to record calls, you will need significantly more space, preferably on a separate RAID server  
• Monitor 1024 x 768 or greater (for Management Console)  
• 100-MBit LAN card and 100MBit switched LAN or vLAN with TCP/IP V4 network participation | • Windows Server 2008 R2 (64-bit) with latest service packs installed  
• Desktop Experience (and its required sub-features)**  
• TCP/IP V4 configuration (domain membership is recommended, not required)  
• Internet Explorer 6.0 or later  
• .NET 3.5 SP1 (includes .NET 3.5.1, Web Server IIS and Windows Process Activation Service roles and required sub-features)  
• Optional software: SAPI5-compliant text-to-speech engine or engines  
Database Management Software:  
• Microsoft SQL Server 2008 R2 (recommended)  
• Microsoft SQL server 2014  
• Windows 2012 R2 Standard (64 bit) with latest service packs along with above settings |

| | | **Optional software: SAPI5-compliant text-to-speech engine or engines**  
Database Management Software:  
• Microsoft SQL Server 2008 R2 (recommended)  
• Microsoft SQL server 2014  
• Windows 2012 R2 Standard (64 bit) with latest service packs along with above settings |

| IPCM client computer | • 1 GHz Pentium III  
• 2 GB RAM for client computers using Windows 7  
• 1 GB HDD  
• Video 16-bit 1024x768  
• A high-quality soundcard for softphone users. Motherboard soundcards may not be sufficient for high-quality telephone audio because of shielding issues.  
• LAN card and TCP/IP V4 network participation | • Windows 10 64-bit (recommended)  
• Windows 10 64bit  
• TCP/IP V4 configuration  
• Internet Explorer 6.0 or later  
• Adobe Flash plug-in and Adobe SVG Viewer are required (latest versions), and JavaScript support must be enabled |

**You must install Desktop Experience prior to installing IPCM (otherwise, the IPCM Server installation will be interrupted by a prompt to install Desktop Experience before continuing the IPCM installation).**
SIP Hardware Requirements

Ensure all gateways and telephones are:

- SIP-enabled
- RFC-3261 SIP/2.0 UDP-compliant.
- RFC-2833 telephony signals compliant (for DTMF recognition).

Ensure all SIP endpoints (including the voice server) can access the SIP Soft Switch for telephone number-to-IP address mapping.

Network Requirements and Recommendations

- **Required:** Assign a static IP address to the IPCM server target host computer.
- **Required:** The following network settings must be configured in the Advanced TCP/IP Settings dialog box on the DNS tab of the network interface: the DNS suffix should be specified; there must be at least one DNS server configured; this connection address, with the configured DNS suffix, must be registered with DNS. Verify the settings by clicking Start>Run to open the Windows command prompt, then type **nslookup <name>**, where **<name>** is the value of the Computer Name field. The command should successfully find the IP address.

- **Recommended:** Use a 100Mbit LAN with switches. Do not use hubs.
- **Recommended:** Install your gateways and other endpoints on the same IP network. Do not install IP gateways between endpoints. If you install gateways between endpoints, implement some type of Quality of Service (QoS) technology, such as Cisco CBWFQ/LLQ (Class-Based Weighted Fair Queuing/Low Latency Queuing), on the egress ports of all gateways through which voice traffic will travel.
License File Requirement

ISM provides a custom digital license file to each IPCM customer. License files contain information such as the modules licensed, customer name, customer ID, partner name, the name of the person who generated the license file, etc., and might contain expiration dates for licensed features.

Obtain a license and copy it to the IPCM server host computer. If you do not have a license file, IPCM runs only in a demonstration mode, allowing the following limited functionality:

- 4 IVR ports
- 2 Unified Messaging ports
- 2 Auto Attendant ports
- 2 agents
- 1 supervisor
- 5 phone entries
- 1 Statistic Console connection
- Historical reporting
- Quality Management
- 1 Quality Management supervisor
- 1 Quality Management concurrent recording channel

You can add a license file into your configuration later or replace an existing one, if necessary. Refer to the online help topic "Server Administration" for more information.

System Reliability and Availability

Since IPCM is a critical application to your business, consider redundancy and backup options to ensure IPCM reliability and availability. For information on these topics, contact your ISM representative.

Database Planning

If you are using a SQL Server database, refer to the online help topic "IPCM Database Details" for database-related planning issues.

In addition, you may want to integrate other databases with IPCM, as IPCM can access databases for caller authentication, customer information, and other purposes.

Integration Options

IPCM uses an open integration API to integrate with various database-driven applications, such as ticketing, service management, etc. The integrations enable automatic screen-pops displaying customer information based on information arriving with a call, such as customer ID, ticket number, etc.
Configuration with FRS Products

IPCM comes ready to configure with the following Ivanti products:

- ISM - If you plan to configure IPCM with the ISM application, you can install ISM either before or after installing IPCM. The configuration requires access and administrator rights to the ISM Administrator and Call Logging modules. Refer to the IPCM online help for configuration details.

- Foundation /ITSM, CSM, and GMEE - Install the Foundation client before you install the IPCM server to avoid having to manually register the configuration component with IPCM. Refer to the IPCM online help for configuration details.

- GoldMine CE and PE - If you plan to configure IPCM with GoldMine, install GoldMine before installing IPCM. Installing GoldMine after IPCM results in irrevocable data loss. Refer to the IPCM online help for configuration details.

Phone Options: Desktop Phone vs. Softphone

Each IPCM Communicator or Agent Dashboard can be used in lieu of a SIP-enabled desktop phone. The Communicator is essentially the softphone. The Agent Dashboard implements the softphone in addition to the agent-specific functionality. The agent may choose to use either the softphone (which is part of the Dashboard) or to use the desktop phone instead. But the agent will always need to use the Dashboard (even if using a desktop phone) for its agent functionality.

The question of whether or not to use an SIP handset or an SIP softphone depends on budget, management, and deployment requirements. Use the following comparison table to decide which type of phone is right for your environment.

<table>
<thead>
<tr>
<th></th>
<th>SIP Softphone</th>
<th>SIP-enabled desktop phone</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Definition</strong></td>
<td>A software-based phone that functions like a typical desk phone. To use a softphone, the computer must have full duplex audio hardware (enabling simultaneous record/playback) and a headset/microphone. The computer software handles the codec processing. The softphone is often used in remote installations or used with teleworkers to limit the cost of deployment as well as to make it easier to manage remote phones from the IT staff.</td>
<td>A conventional physical phone but with built-in SIP technology. It uses an Ethernet port (instead of a normal phone jack) to communicate with the Contact Center server and other SIP hardware. Codecs are located within the phone hardware. You must configure the phone to work with your environment.</td>
</tr>
</tbody>
</table>
TEXT-TO-SPEECH (TTS) INTEGRATION OPTION

Text-to-Speech (TTS) engines are applications that read text aloud. Contact your sales representative to learn which TTS engines IPCM supports.

**IMPORTANT:** When installing a TTS engine, install it so all users can access it, not just you.

You can install multiple TTS engines both before and after installing IPCM. IPCM requires a TTS engine for each language for which you plan to use dynamic prompts. If you do not have a TTS engine for a language IPCM uses, you can alternatively record prompts for that language, but doing so prevents you from using variables. For information on prompts and variables, refer to Chapter 9, Preparing for Incoming Calls. For information on basic TTS configuration, refer to the online help topic "Voice Server Configuration."

## Backup Server Option

Ivanti recommends setting up a backup server to run IPCM if the primary host computer goes down.

1. **To Set Up the Backup Server:**

   1. Replicate your IPCM server installation on the backup server.

      **IMPORTANT:** The backup server must have its own license.

   2. Open the `HostConfiguration.xml` file and `Addressbook.xml` file in the `<install_dir>\FrontRange Contact Center\Data` directory on the backup server, and verify all instances of the `Host Name` element are set to the name of the backup server (search for `Host Name` in the `HostConfiguration.xml` file to locate all instances of the element). Remember to save the file if you make changes.
After your IPCM deployment goes live, keep the backup server up to date. To do this, regularly overwrite the following directories and files on the backup server with the versions on the primary server:

- `<install_dir>\Data`
- `<install_dir>\Applications`
- `<install_dir>\Data\Users`
- `<install_dir>\Data\AppSelector.xml`
- `<install_dir>\Data\SipServerConfiguration.xml`

**IMPORTANT:** Each time you copy the `HostConfiguration.xml` file to the backup server, change all instances of the `Host Name` element in the version of the `HostConfiguration.xml` file on the backup server to the name of the backup server.

If the primary server fails, manually change your IPCM environment to use the backup server:

1. Reconfigure the gateway to direct calls to the backup server instead of the primary server.
2. Reconfigure each Agent Dashboard to connect to the backup server:
   a) Restart each Agent Dashboard. The **Connect to Contact Center** dialog box open upon restart.
   b) In the **Connect To** section on the **Connect to Contact Center** dialog box, do one of the following:
      - Select the **Discovered Server** radio button, then select the name of the backup server in the **Server Name** drop-down list.
      - Select the **Network Address** radio button, then enter the name and port of the backup server the **Host Name** and **Port** fields.
## Ports and Firewall Settings

The following table describes each port IPCM uses. Configure your firewall to make these ports available.

<table>
<thead>
<tr>
<th>Port</th>
<th>Transport</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1972</td>
<td>TCP</td>
<td>SME connections from the Statistics Console. This port is not configurable.</td>
</tr>
<tr>
<td>1973</td>
<td>UDP</td>
<td>The IPCM server discovery port (server side), to which clients broadcast. This port is not configurable.</td>
</tr>
<tr>
<td>1974</td>
<td>UDP</td>
<td>The IPCM server discovery port on the client side. The IPCM servers broadcast to that port to advertise themselves. This port is not configurable.</td>
</tr>
<tr>
<td>1975</td>
<td>TCP</td>
<td>The client-to-server connection (CCL to Management Agent). This port is configurable in XML, but not in the Management Portal.</td>
</tr>
<tr>
<td>5060</td>
<td>UDP (SIP)</td>
<td>The default port for the SIP Soft Switch. This port is configurable.</td>
</tr>
<tr>
<td>5070</td>
<td>UDP (SIP)</td>
<td>The default port for the voice server. This port is configurable.</td>
</tr>
<tr>
<td>5073</td>
<td>UDP</td>
<td>The default port for the MWI service. This port is configurable.</td>
</tr>
<tr>
<td>5090</td>
<td>UDP (SIP)</td>
<td>The default SIP port used by the Agent Dashboard softphone. This port is configurable.</td>
</tr>
<tr>
<td>5743</td>
<td>TCP</td>
<td>Message server. The IPCM port to which IPCM toolbar and ISM Service management communicate via the message server.</td>
</tr>
<tr>
<td>7770</td>
<td>TCP (HTTP)</td>
<td>The port for the Management Portal.</td>
</tr>
<tr>
<td>7776</td>
<td>TCP (HTTP)</td>
<td>Web Statistics port. For more information on Web Statistics, refer to the online help topic &quot;Web Statistics Overview.&quot;</td>
</tr>
<tr>
<td>10000</td>
<td>UDP (RTP)</td>
<td>The RTP ports on the server side that are allocated as necessary. The first port (10000) is configurable.</td>
</tr>
<tr>
<td>44000</td>
<td>UDP (RTP)</td>
<td>The range of SIP server RTP ports.</td>
</tr>
</tbody>
</table>
IPCM Deployment Process

►To Deploy IPCM:

- Use the information in this chapter to plan your setup and prepare your environment.
- Set up a database for storing IPCM data.
- Run the IPCM installation wizards. Refer to Chapter 4, Installation.
- Create the Dial Plan. Refer to Chapter 6, Dial Plan.
- Determine if the delivered user roles meet the needs of your business. If not, configure the roles as needed. Refer to Chapter 7, Security Plan.
- Create user profiles for all IPCM users. Refer to Chapter 8, Organizing the Contact Center.
- If you purchased Contact Center licenses, configure the following: create skills and skill groups, create agent groups and add agents to groups, configure individual agent skills and settings, create and configure routing rules, create services, create queues or modify default queues to meet your business needs. Refer to Chapter 8, Organizing the Contact Center.
- If your business requires one or more custom voice applications, use Application Builder to create them. Refer to Chapter 9, Preparing for Incoming Calls. IPCM ships with three UM applications that suit the basic voice application needs of most non-contact center businesses. Refer to Chapter 10, Office Phone System for information regarding how these applications operate.
- If you create a new voice application, use Applications Selector to register the voice application with IPCM and configure how IPCM uses it (start criteria). Refer to Chapter 9, Preparing for Incoming Calls.
- Use the Management Portal to configure the Unified Messaging (UM) system-wide and user settings. Refer to Chapter 10, Office Phone System.
- Configure each installation of the Communicator softphone and all SIP-enabled desktop phones in your environment. Refer to Appendix A, IPCM Communicator for information. For desktop phone configuration, refer to the instruction manual included with the phone.

Post-Deployment

Refer to the IPCM Online Help for all other IPCM information including monitoring system activity and reporting.

You can make individual changes to your deployment at any time, according to your business and network needs, without repeating the entire deployment process. Changes typically include adding extensions, users, and agents as your business expands, modifying voice applications in Application Builder, changing network settings to accommodate greater bandwidth, updating user profile information, etc.
Preparation
Installation

IPCM has two installation wizards:

- **Server Installation** - Run this installation wizard once on the IPCM host computer. Installs the IPCM server and has options for installing integrations with HEAT, Foundation (ITSM, CSM, and GMEE), GoldMine, and SaaS integrations, all operating from a central server.

- **Client Installation** - Run this installation wizard on client computers in your IPCM network. Do **not** run the Client installation wizard on the IPCM server host computer, since the Server installation wizard allows you to install all of the client components.

  **Note:** You can also create a `.bat` file to use for an unattended installation on end-user workstations. Refer to Unattended Client Installation on page 31 for details.

Since you will not be specifying licensing info during the installation, IPCM runs in demonstration mode. The license file can be configured later, subsequent to the installation - refer to the online help topic "Host Configuration: License File Management."

Server Installation

The server installation installs the IPCM server (on the IPCM host computer) and has options for installing HEAT, Foundation (ITSM, CSM, and GMEE), GoldMine, and SaaS integrations, all operating from a central server.

IPCM uses a SQL Server database for storing information such as statistical values and interaction data. IPCM supports all editions of SQL Server 2005 or later. As indicated in the system requirements (refer to System Requirements on page 10), MS SQL Server 2008 is recommended.

Microsoft SQL Server Setup

Install and configure Microsoft SQL Server prior to installing IPCM.

This installation chapter only discusses instructions specific to the IPCM database setup, and assumes readers are expert-level SQL Server users. For details on specific SQL tasks, refer to the Microsoft documentation.

Installation Procedure

If you are installing IPCM on a SQL server other than the included MSDE version, you will also need to create a database for IPCM. Note that Windows Authentication is not supported.
**IMPORTANT:** This installation procedure presumes you have already created an empty database (generally referred to as a database shell), and that database logon credentials have been created.

**To Run the Server Installation Wizard:**

1. Verify that the target computer meets or exceeds the system requirements.
2. Exit all programs running on your system.
3. Double-click the **IPCMServer.exe** file.
4 Before the IPCM installation wizard opens, you will be asked to install Microsoft XML 4.0 and Microsoft Visual C++ 2008. Click **OK**.

5 When complete, the **IP Communications Management Server - InstallShield Wizard** dialog box opens.

6 Click **Next**. The **License Agreement** dialog box opens.

**Note:** If you are using Windows Server 2008, and have not yet installed Desktop Experience, you will see a prompt stating that Desktop Experience must be installed before proceeding with the IPCM installation. Click **OK** to close the message dialog box, then click **Finish** to close the wizard. Install Desktop Experience, then double-click the **IPCMServer.exe** file to start the installation wizard.
7 Review the licensing information and click the I accept radio button and check boxes if you agree to the terms.

8 Click Next. The Custom Setup dialog box opens, displaying the installation options as well as the default location for the program files.

9 In addition to installing the IPCM server, you have the option to install:

- Integration with HEAT
- Integration with Foundation
- Integration with GoldMine
- Integration with SaaS

Note: The Integration with SaaS option refers to integration with ISM 2013 or newer, either hosted or installed on premise.

To confirm that you have adequate disc space to load the selected features, click the Space button.

As you select the features to be installed, the default destination folder path displays. Accept the default folder as Ivanti recommends, or click the Change button to select another folder into which you will install the program files. If you select another folder, substitute that folder’s path as necessary when following the subsequent instructions in this guide.

10 Click Next.

- If you selected the Integration with Foundation option, the Integration with Foundation dialog box opens:
  
  a) Select the appropriate version of Foundation.

  Note: As a result of specifying the Foundation version, three configuration files, \ITSMConnector.dll.config, \ITSMLiason.exe.config, and \VxCL.exe.config, do not have to be manually configured to reflect the correct assembly version. However, if you need to manually configure these files for any reason, refer to the online help topic "IPCM/Foundation Configuration" for details.

  b) Click Next. Proceed to step 11.

- If you did not select the Integration with Foundation option, proceed directly to step 11.
11 The **Database Server type** dialog box opens.

12 On the **Database Server type** dialog box, you can choose the **Select an existing MSSQL server** option, opt to **Install MSDE locally**, or, if using an Oracle database, select the **Setup connection string manually** option. Ivanti recommends you use MSDE for demo or evaluation purposes only.

- If you selected the **Select an existing MSSQL Server** option, continue to step 13 on the following page.

- If you selected the **Install MSDE locally** option, follow the steps below to complete the IPCM installation:
  a) Click Next. The **Setup MSDE** dialog box opens.

  ```plaintext
  Note: If you attempt to install MSDE, you may get an incompatibility message. As previously stated, Ivanti recommends you use MSDE for demo or evaluation purposes only.
  ```

  b) Leave the defaults, and specify the password the system administrator will use to log on to MSDE.

  c) Click Next. MSDE is installed. When MSDE installation is complete, you will be asked to restart your computer. Click Yes to restart your computer.

  d) When you log on to your computer after restart, the **Ready to Install the Program** dialog box opens. Click Install.

  e) When the installation is complete, the **InstallShield Wizard Completed** dialog box opens. Click Finish.

- If you selected the **Setup connection string manually** option, follow the steps below to complete the IPCM installation:
  a) Click Next. The **Database connection string** dialog box opens.

  b) Do one of the following:

    » Type the OLE DB connection string in the field provided (use the Ctrl+Enter keys for a line break). For example, for an Oracle database: Provider=OraOLEDB.Oracle.1; Password=password;Persist Security Info=True;User ID=IPCM55;Data Source=ORCL. Or, if you need to store record notes for interactions that are longer than 100 symbols:
Installation

Provider=OraOLEDB.Oracle.1;ChunkSize=500; Password=password;Persist Security Info=True;User ID=IPCM;Data Source=AGASIM.

» Click the Wizard button to open a wizard that will guide you in generating the connection string.

c) Click Next.

d) The Ready to Install the Program dialog box opens. Click Install.

e) When the installation is complete, the InstallShield Wizard Completed dialog box opens. Click Finish.

13 After selecting the Select an existing MSSQL Server option, click Next. The Database Server dialog box opens.
14 Accept the Database Server default or click **Browse** to select from the list of database servers. Or you can type the name of an existing server in the Database Server field.

15 Specify the SQL Login ID and Password.

16 Click **Connect** to select the database on the specified server.

17 Click **Next**. The **Ready to Install the Program** dialog box opens.

18 Click **Install**.

**Note:** The Adobe SVG Viewer 3.0 Setup dialog box may appear. If so, click **Yes** since the IPCM server requires this specific version.

19 When the installation is complete, the **InstallShield Wizard Completed** dialog box opens. Click **Finish**.
Management Console

The Management Console is a client application that lets system administrators start and stop servers and application services, and monitor current server activity.

To open the Management Console, click **Start>Programs>FrontRange Solutions>Communications Management>Management Console.**

The **Objects Pane**, on the left, displays the names and locations of all IPCM server objects in a hierarchy. The server objects listed depends on the installation. Examples: if the **Integration with Foundation** option was selected during installation, the **Foundation Sync Server** displays; if Outbound Dialer was installed, the **Outbound server** is listed.

**Note:** For detailed information about the Management Console, refer to the IPCM online help topic “Server Administration.”

Green icons indicate running servers; red icons indicate stopped servers. The data in the **Properties** pane, on the right, varies according to what you select in the **Objects** pane. For example, if you select the Contact Center Server in the **Objects** pane, the **Properties** pane displays information about Agents and Interactions. If you select the voice server, the **Properties** pane displays information about Application Contexts, Calls, and ASR Channels. The **Events Log**, at the bottom, displays critical log messages.

Server Verification

**To Verify Successful IPCM Server Installation:**

1. On the IPCM server host computer, select **Start>Programs>FrontRange Solutions>Communications Management>Management Console.** The first time an installation of the Management Console launches, the **New Connection** dialog box opens, requesting a user name, password, and the IPCM server selection. Enter the default user name and password, which are **admin** and **password**, respectively. The **Management Console** opens. Subsequent logins do not require a password

2. Expand the hierarchy in the left pane to view the servers. A green icon indicates the server is running; a red icon indicates the server is not running.

3. If a server has a red icon, right-click the icon and select **Start Application.** The icon turns green, indicating the server is running.
Client Installation

You can install the IPCM client directly on the end-user workstations, or create a .bat file to use for an unattended installation (refer to Unattended Client Installation on page 31).

► To Run the Client Installation Wizard:

1 Verify that the target computer meets or exceeds the system requirements in System Requirements on page 10, and exit all programs running on your system.

2 Double-click the IPCMClient.exe file.

3 Before the IPCM installation wizard opens, you will be asked to install Microsoft Visual C++ 2008. Click OK.

4 When complete, the IP Communications Management Client InstallShield Wizard dialog box opens.
5 Click **Next**. The **License Agreement** dialog box opens.

6 Review the licensing information and click the **I accept** radio button and check boxes if you agree to the terms.

7 Click **Next**.

8 The **Custom Setup** dialog box opens, displaying the installation options as well as the default location for the program files. You have the option to install:

- **IPCM Communicator** - Installs the softphone for users other than contact center agents. Some communicator settings (on the **SoftPhone**, **SIP Registration**, and **STUN** tabs) are pre-configured during installation, but can be edited as needed.

- **Agent Dashboard** - Installs on client computers used by agents and supervisors.

- **Management Console** - Installs on the client computer used by the system administrator.

- **Statistics Console** - Installs on client computers used by supervisors.

- **Integration with Foundation** - Installs on client computers that need the two configuration files: **ITSMConnector.dll.config** and **VxCCL.exe.config**, correctly configured with the appropriate assembly version for the Foundation version you specify (in step 10). Refer to the IPCM online help topic "IPCM/Foundation Configuration" for details.
To confirm that you have adequate disc space to load the selected features, click the Space button. As you select the features to be installed, the default destination folder displays. Accept the default folder, or click the Change button to select another folder into which you will install the program files. If you select another folder, substitute that folder path as necessary when following the subsequent instructions in this guide.

9 Click Next.

10 The IPCM Server dialog box opens:
   a) Type the server computer name.
   b) Accept the SIP Register port default or change it if needed.
   c) Click Next.
Installation

11 If you selected the **Integration with Foundation** option, the **Integration with Foundation** dialog box opens. Otherwise, proceed to step 12.

- Select the appropriate version of Foundation, then click **Next**.

  **Note:** As a result of specifying the Foundation version, two configuration files, **ITSMConnector.dll.config** and **VxCCL.exe.config**, **do not** have to be manually configured to reflect the correct assembly version. However, if you need to manually configure these files for any reason, refer to the online help topic “IPCM/Foundation Configuration” for details.

12 The **Ready to Install the Program** dialog box opens. Click **Install**.
When the installation is complete, the **InstallShield Wizard Completed** dialog box opens. Click **Finish**.

---

**Unattended Client Installation**

With an unattended installation, you can run the installation wizard in silent mode, with no user interface displaying and no interaction required by the user. An unattended installation is especially useful when deploying a large number of clients.

1. Create a new directory on the client computer to contain the client `.exe` file and a `.bat` file you will create; for example, `C:\Silent`.

2. Place the `IPCMClient.exe` on the new directory.

3. Create a `.bat` file in the same directory with following information:

   ```shell
   IPCMClient.exe /s /v"/qn INSTALLDIR="C:\Program Files\FrontRange Solutions" ADDLOCAL=ALL IPCM_SERVER=<name_of_IPCM_server>
   ``

   where:
   - `/s` = silent mode
   - `/v` = pass arguments to msiexec
   - `/qn` = no user interface
   - `INSTALLDIR` = path to the installation folder
   - `ADDLOCAL` = list of features to install (Root,Client,Agent,Manag,Stat)

   __Note: For some newer operating systems, you may need to use `/silent`.__

   - `/v` = pass arguments to msiexec
   - `/qn` = no user interface
   - `INSTALLDIR` = path to the installation folder
   - `ADDLOCAL` = list of features to install (Root,Client,Agent,Manag,Stat)

   __Note: Inclusion of the Root feature is mandatory.__

   - `ALL` = for full installation
   - `Client` = install IPCM Communicator
Installation

- **Agent** = install the Agent Dashboard
- **Manag** = install Management Console
- **Stat** = install Statistics Console

If installing the Integration with Foundation option, the .bat file should specify the Foundation version. For example:

```
IPCMClient.exe /s /v "INSTALLDIR="C:\Program Files\FrontRange Solutions" ADDLOCAL=ALL ITSM=ITSM70 IPCM_SERVER=<name_of_IPCM_server>
```

1. Run the .bat file. The IPCM client is installed at **C:\Program Files\FrontRange Solutions** (or in the directory you specified).

Management Portal

The Management Portal is a browser-based interface that provides the system administrator with access to the following:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agents/Skills/Services</td>
<td>Configure agents, skills and skill groups, routing rules, services, and agent Not Ready reasons.</td>
</tr>
<tr>
<td>Application Builder</td>
<td>Create multiple voice applications that implement call processing scenarios specific to your business needs.</td>
</tr>
<tr>
<td>User Account</td>
<td>Configure and manage users, the Global Address Book, Unified Messaging, and user roles.</td>
</tr>
<tr>
<td>Log Viewer</td>
<td>View log messages containing data about server events.</td>
</tr>
<tr>
<td>Quality Management</td>
<td>Configure Quality Management functionality, including scheduled conversation recordings and recording rating criteria.</td>
</tr>
<tr>
<td>Reporting</td>
<td>View historical reports, interactions (including agent recordings), application reports, and instant messaging reports.</td>
</tr>
<tr>
<td>System Configuration</td>
<td>Configure the IPCM servers and host computer.</td>
</tr>
<tr>
<td>SIP Soft Switch State</td>
<td>Monitor the current state of active calls, call history, DNs, and gateways.</td>
</tr>
</tbody>
</table>
Navigation

- **To Open the Management Portal:**

  1. Click **Start>Programs>FrontRange Solutions>Communications Management>Management Portal.**
  2. The **Enter Network Password** dialog box opens.
  3. Type your **User Name** and **Password**. The defaults are:
     - username = **admin**
     - password = **password**
  4. Click **OK**. The Management Portal menu page opens, displaying eight options. Click the desired option.

A navigation menu comprised of icons appears at the top of each page in the Management Portal.

- Move your mouse cursor over each icon to see the page that corresponds to that icon.
- Click an icon to advance to the desired page.
- Click the ISM IP Communications Management logo to return to the Management Portal menu page.
Entering/Editing Data

When you enter or edit data on the Management Portal, IPCM does not always apply those changes immediately (in some fields the text turns red indicating the changes are not applied). Use the following buttons to have your changes take effect:

- **Update** - Applies changes to the current screen, enabling you to go to another Management Portal screen without losing your changes. When you apply a change, the text changes to black if it was red.

- **Commit Changes** - Saves applied changes and immediately enacts those changes in IPCM. The Commit Changes button appears after you click an Update button. Once you click the Commit Changes button, you can close the Management Portal without losing your changes as long as you first clicked the Update button associated with the fields or forms you changed. If you edit multiple forms or multiple pages, you must click the Update buttons associated with each edited form before you click the Commit Changes button. (In the SIP Soft Switch configuration pages, this button will not appear; all SIP Soft Switch configuration changes are auto-committed.)

---

**CAUTION:** You cannot restore previous settings once you click the Commit Changes button. If you have not clicked the Commit Changes button and you want to discard your changes, use the Discard Changes button to revert edited fields and forms to the previous values.
Dial Plan

This chapter explains the following:

• What is a Dial Plan?
• Dial Plan Implementation
• Create Users and Assign Extensions
• Dial Plan Shortcuts
• Trunks and Gateways

What is a Dial Plan?

A dial plan is a plan for allocating telephone number ranges to specific destinations. For example, in the North American public telephone network (Public Switched Telephone Network - PSTN), the dial plan defines rules such as:

• Phone numbers starting with 1 are a long distance calls.
• Phone numbers starting with 011 are international calls.

Within the set of numbers starting with 1, the next three digits (the area code) define the general area to which a call will be routed; for instance, 925 is a Northern California area code. The area code is followed by another 3 digits which define a more localized destination within the area code; for example, 398 defines an area within Pleasanton, California.

When implementing your company’s phone system, such as IPCM, a dial plan is created to define how phone numbers will be routed. The dialed numbers may come from external gateways, or internal extensions.

The dial plan in IPCM consists of the following destination types:

• **Phones** - Destinations associated with an internal user. There are two basic types:
  
  » SIP-enabled desktop phone - A conventional physical phone with built-in SIP technology. It uses an Ethernet port instead of a phone jack to communicate with IPCM and other SIP hardware.
Softphone - A client application with a graphical user interface for performing basic telephony tasks such as answering, dialing, transferring, and hanging up calls. A microphone and speaker or headset attached to the computer enables users to audibly converse with callers, just as you would using a desktop phone. IPCM provides two different applications with built-in softphones, the Agent Dashboard and the Communicator. Softphones are common in remote installations or with tele-workers to limit the cost of deployment, and to make it easier for IT specialists to manage remote phones.

- **Trunks / Gateways** - Destinations that are associated with external phone numbers. There are two types:
  - Media Gateway - A physical device that converts the IPCM VoIP to analog or digital information. IPCM uses gateways to connect to public phone networks like the PSTN and private phone networks using traditional telephony technology.
  - Trunk - A connection to another SIP server or proxy server. IPCM uses SIP trunks to connect to private phone networks utilizing VoIP technology.

- **Voice Applications** - Destinations that provide automated call processing specific to your business needs (commonly referred to as IVR or voice menus). IPCM provides multiple voice applications used to implement various call processing scenarios and provides a tool, Application Builder, for creating voice applications.

A dial plan works like a tree in which a call travels from the trunk to a specific leaf. When the caller dials a phone number, each digit in the phone number selects the next branch the system looks at the number digit-by-digit to find the best destination match.

**Dial Plan Implementation**

Implementing a dial plan generally involves specifying the following three items:

- Create users, then assign extensions.
  - Configure the security settings for the user’s IP phones, if required.
- Create connections to external trunks or gateways.
  - Configure the number prefixes that will select these trunks for outbound calls
  - Configure the IP address of the trunk/gateway that will receive incoming calls
  - Configure the security settings for the trunks
  - Perform any necessary prefix manipulation to reformat incoming or outgoing numbers.
- Configure voice application start criteria (refer to Applications Selector on page 115).
The following table describes the differences between phone entries and trunk/gateway entries.

<table>
<thead>
<tr>
<th>Phone Entries</th>
<th>Trunk/Gateway Entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPCM matches phones in the dial plan by numbers.</td>
<td>IPCM matches gateways in the dial plan by prefixes.</td>
</tr>
<tr>
<td>Phone numbers must be unique: there can be only one phone device with each number.</td>
<td>Trunk/gateway prefixes do not have to be unique: you can configure multiple gateways and trunks with the same prefix to enable load balancing.</td>
</tr>
<tr>
<td>Phone numbers must match completely for a call to be sent to a phone.</td>
<td>Trunk/gateway prefixes match the first digits in the dialed number; they do not have to match the entire number.</td>
</tr>
<tr>
<td>Phones have forwarding options. For example, you can configure IPCM to forward calls if the phone is busy.</td>
<td>Trunks and gateways do not have forwarding options. If IPCM cannot connect a call with a trunk/gateway, IPCM tries to connect the call to another trunk/gateway with the same prefix.</td>
</tr>
<tr>
<td>Phones do not have least cost routing.</td>
<td>Trunk/gateways have least cost routing.</td>
</tr>
<tr>
<td>IPCM can override display names phone supply. That is, the display name you configure in IPCM appears on your SIP-enabled desktop phone display screen instead of the display name you configure using the phone settings.</td>
<td>IPCM does not override display names gateways/trunks supply.</td>
</tr>
<tr>
<td>IPCM does not send registration requests to phones.</td>
<td>IPCM can send registration requests to gateways/trunks.</td>
</tr>
</tbody>
</table>

Extension IP addresses can be set dynamically or statically by the extension (for example, after the phone obtains a DHCP address). Typically, IPCM environments have phones with dynamic DHCP addresses, because there are too many to manage each individually, and gateways with static addresses, because each gateway must be individually configured, and it is easier to manage a gateway that can always be found at a known address.
Dial Plan

Dial Plan Best Practices

When creating a dial plan:

• Do not use the same number twice.
• Your IPCM license determines the number of extensions you can use. If you configure extensions past your limit, an error generates if you try to use them.
• Most users are already used to dialing 8 or 9 when dialing an external number, so consider using these numbers to identify your trunks / gateways.
• Extensions and trunk/gateway prefixes do not need to be numerical, but most of the currently produced SIP devices make it easier to dial numeric strings. That is why in a typical case you create numerical extensions and prefixes.

Allocating appropriate ranges for your phones, trunks, and voice applications will make it easier to maintain the system over time. Some suggestions:

• Reserve sufficient contiguous numbers for your phones for as many users as you estimate you may need over time. For example, setting aside 3 digits (such as: 600-699) enables you to configure up to 100 extensions. If you estimate you may have more than 100 users, consider using 4 digits for your extensions (such as: 6000-6999).
• If your phone provider supplies Direct Inward Dial (DID) numbers, match your extensions to the last three or four digits of your assigned DID range. For example, if your carrier assigns the phone number range 925-398-1300 through 925-398-1399, use either 1300-1399 or 300-399 as your internal phone numbers.
Phone Number Ranges

IPCM comes with a default dial plan. Although all numbers used in this dial plan can be changed to match your requirements, Ivanti recommends working within the dial plan if possible, or making the minimal changes needed to fit your business environment. Some numbers are for specialized purposes which are not actually destinations, such as call restrictions (refer to Class of Restrictions (COR) on page 136), music on hold (refer to the online help topic "SIP Soft Switch Configuration: Special Numbers"), call pickup (refer to Phone Groups on page 135), phone groups (refer to Phone Groups on page 135), and authorization codes (refer to Authorization Codes on page 139).

This table provides suggested phone number ranges for each aspect of your call center:

<table>
<thead>
<tr>
<th>Phone Number begins with:</th>
<th>Purpose:</th>
<th>Default entries:</th>
</tr>
</thead>
</table>
| *                         | Special purpose numbers | *1 - Call pickup group  
|                           |                       | *1* - Call pickup directed  
|                           |                       | *2* - Call pickup from park |
| 0                         | Available            | None             |
| 1                         | Available            | None             |
| 2                         | Available            | None             |
| 3                         | Special purpose numbers | 3000 - Music on hold  
|                           |                       | 3001 - User login  
|                           |                       | 3002 - User logout  
|                           |                       | 3003 - Override class of service prompt |
| 4                         | Available            | None             |
| 501                       | Voice applications   | 501 - Demo IPCC application  
|                           |                       | 5010 - Message Waiting Indicator  
|                           |                       | 5011 - Attendant  
|                           |                       | 5012 - Answering  
|                           |                       | 5013 - Access |
| 6                         | User extensions      | 600 - John Smith  
|                           |                       | 601 - Peter Pan |
| 7                         | Manager extension    | 700 - Manager    |
| 8                         | Outbound trunks      | None             |
| 9                         | Outbound trunks      | None             |
Dial Plan Worksheet

The dial plan worksheet on the following page may assist you in creating your dial plan (or modifying the default dial plan). The following table shows an example of how the worksheet can be used.

<table>
<thead>
<tr>
<th>No.</th>
<th>User Name</th>
<th>Ext.</th>
<th>Type</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>frccserver</td>
<td>501</td>
<td>Server</td>
<td>206.104.144.250</td>
</tr>
<tr>
<td>2</td>
<td>janesmith</td>
<td>601</td>
<td>Supervisor</td>
<td>10.28.160.70</td>
</tr>
<tr>
<td>3</td>
<td>ebrown</td>
<td>602</td>
<td>Agent</td>
<td>10.28.160.71</td>
</tr>
</tbody>
</table>
Create Users and Assign Extensions

The Phones page (in the Management Portal, click System Configuration>SIP Soft Switch>Phones) lets you associate an extension with each softphone and SIP-enabled desktop phone in your IPCM environment.

However, if your contact center is using softphones, or desktop phones utilizing a username and password (rather than an IP address), Ivanti recommends that you create extensions for your dial plan when creating users (Management Portal>System Configuration>Users). Refer to User Profile Management on page 59. If you are using a desktop phone configured with an IP address, create extensions by following the procedure in the online help topic "SIP Soft Switch Configuration: Dial Plan Implementation."

Note: Your IPCM license determines the number of extensions you can use. If you attempt to configure extensions past your limit, an error generates if you try to use them.

Dial Plan Shortcuts

You can configure dial plan shortcuts, which are keypad shortcuts that all phones in your private network can use to connect directly to an extension without having to dial the full telephone number.

IMPORTANT: Each dial plan shortcut uses one phone entry license.

► To Create a Dial Plan Shortcut:

1. Create an extension in your dial plan without a static IP address. Set the Number/Extensions field to the global keypad shortcut.

2. On the Forwarding tab, configure the Unconditional Forward fields of the extension to automatically redirect callers to the phone number you want the global keypad shortcut to call.

Note: Refer to the instruction manual provided with your SIP-enabled phone for information on using its speed dial functionality. Refer to the online help topic "SIP Soft Switch Configuration: Configure Phone Entries: Forwarding" for more information on call forwarding.

Trunks and Gateways

The Trunks/Gateways page (in the Management Portal, click System Configuration>SIP Soft Switch>Trunks/Gateways) lets you configure each gateway and trunk in your network. Each entry on the page is assigned a unique ID which includes a configurable list of prefixes the SIP Soft Switch uses to select the trunk or gateway to use for an outbound call.

Add Trunk/Gateway Entries

Create an entry in the dial plan for each gateway and trunk in your IPCM environment.

When adding trunk/gateway entries:

• Do not use the same ID twice.

• Configure the Number tab, and Prefix Manipulation tab for each trunk/gateway entry you add.
To Add a Trunk/Gateway Entry:

1. In the Management Portal, click System Configuration>SIP Soft Switch>Trunks/Gateways. To add an entry, use the empty fields at the bottom of the Trunks/Gateways page. Open the online help topic "SIP Soft Switch Configuration: Gateway and Trunk Entries" for a complete explanation of the fields and options.

2. In the ID field, type a unique alphanumeric ID for the trunk or gateway.

3. In the Prefixes field, type the number(s) to dial within the IPCM network to access the trunk/gateway.

4. In the Memo field, type a description of the trunk/gateway (optional).

5. Click the Add button. The page refreshes, displaying the entry in the table.

6. In the table, click the ID link for your new trunk/gateway.

7. Configure the settings on the Number tab. Click the online help icon for detailed field explanations.
   a) The ID and Memo field settings carry over from the Trunks/Gateways page. Change the settings if needed.
   b) Only select the Trunk to conference server check box for a Conference server trunk/gateway.
   c) In the Static IP Address field, type the static IP address or resolvable domain name of the trunk/gateway. Change this field only if the trunk/gateway does not register with the SIP Soft Switch. If using a domain name, make sure all extensions in your network can resolve it.
   d) Type the static SIP port of the trunk/gateway in the Static SIP Port field. If this field is blank, the trunk/gateway uses the default port number 5060.
   e) In the Transport field, select the protocol for the extension to use to communicate with the SIP Soft Switch: Default, TCP and UDP.
   f) In the Keep-alive method field, specify the SIP Method to use as a keep-alive message in mid-call. For new trunk/gateway entries, the default is OPTIONS. Use INVITE if OPTIONS is not supported by the specific SIP implementation.
   g) If a SIP phone is behind the NAT router on a private network, but the SIP Soft Switch is on a public network or another NAT router, set the Registration expiration (Seconds) field to 30 (seconds) to ensure continuous data traffic between the SIP Soft Switch and the phone to keep the firewall/NAT mapping active.
   h) The Use SIP Address from field works in conjunction with the Registration expiration (Seconds) option, controlling how the SIP Soft Switch recognizes the location of the phone: Default, Remote, Contact, and Static.
i) The **Use SIP Port from** field is for phones behind NAT configurations, controlling how the SIP Soft Switch recognizes the SIP port of the phone. Options are **Default**, **Remote**, **Contact**, and **Static**.

j) If using a remote media server, select that server from the **Remote Media Server** list. For details, refer to the online help topic "Host Configuration: Remote Media Server Configuration."

k) Select the **Bridge RTP** if you need audio to always route through IPCM (for example, if using a VoIP service provider).

l) In the **Preferred Order of Codecs for Calls to this Gateway** field, type a comma-separated list of codec names (as defined by IETF RFCs) in order of preference.

m) In the **Override domain part in Request-URI** field, type the domain name or IP Address that will be used for the domain portion of the Request-URI (Uniform Resource Identifier) of an outgoing message. This setting should be used when the receiving gateway or trunk requires the URI to be from a specific domain or IP address, and would reject transfers from IPCM which would normally use the IPCM domain as the referring entity.

n) Use the **Add P-Asserted-Identity: header to outgoing messages** field to add a P-Asserted-Identity header (per RFC 3325) to all outgoing calls (a common identifying header). Create the header field value by utilizing a specified URI format (%macro% in the user section) with any one of the following macros:

   - **FROM_USER** - User in From header of outgoing request or To header of outgoing response.
   - **CONTACT_USER** - User in Contact header of outgoing request or To header of outgoing response.
   - **FROM_DISPLAY_NAME** - Display name in From header of outgoing request or To header of outgoing response.
   - **CONTACT_DISPLAY_NAME** - Display name in Contact header of outgoing request or To header of outgoing response.

   **Example:** With sip:123%FROM_USER%456@frs.com entered in the **Add P-Asserted-Identity** field and sip:John@frs.com in the **From** header, the header of an incoming SIP message, an outgoing SIP message will contain the **P-Asserted-Identity: sip:123John456@frs.com** header.

   **Note:** If the specified macro value is an empty string, it will not be used to construct the header value.

o) Use the **Prefix** and **Cost** fields in the **Prefixes** section to specify the prefixes that access this trunk/gateway and the cost of using the trunk/gateway for calls with that prefix. The SIP Soft Switch compares the costs of each and uses the most inexpensive one to achieve least-cost routing. Ivanti recommends using a relative value in the **Cost** field, as opposed to an actual monetary value. Click the **Add** button to add more **Prefix/Cost** pairs.

8. Click **Update**.

9 Configure the settings on the **Prefix Manipulation** tab. Click the online help icon for field explanations and refer to the **Prefix Manipulation Examples on page 46**. If needed, click the green + icon to configure multiple settings for the **Destination** or **Origination Number**.

10 When the configuration is complete, click **Update**.
Delete Trunk/Gateway Entries

To Delete Trunk/Gateway Entries from your Dial Plan:

- Click the red x icon on the Trunks/Gateways page.

Prefix Manipulation

On the Prefix Manipulation tab for each trunk/gateway, you can configure the SIP Soft Switch to automatically modify destination and origination numbers for inbound and outbound calls the trunk/gateway handles, depending on the prefix and, if needed, the length of the number the caller uses.

For example, configure the SIP Soft Switch to automatically insert the long distance prefix/area code to the beginning of an origination number if the caller dialed a local number without the long distance prefix/area code.

To configure the settings on the Prefix Manipulation tab, use the following fields:

- **Match** fields - These fields are the selection criteria the system uses to determine if an action (such as stripping digits, trimming non-relevant information, and/or inserting digits) needs to be performed on the origination or destination number. The number must match the information specified in both the **Prefix** and the **Number length** fields.
  
  - **Prefix** - The prefix to which the modification applies. Type an asterisk (*) in this field to indicate any prefix.
Trunks and Gateways

» **Number length** - The length of the number dialed. Using number length as match criteria enables the system to differentiate between types of phone numbers (such as internal 3- or 4-digit numbers, 7-digit local numbers, 10-digit long distance numbers, etc.). Type an asterisk (*) in this field to indicate numbers of any length.

• **Apply** fields - The fields in this section determine how the system will manipulate the destination or origination numbers (stripping digits, trimming non-relevant information, and/or inserting digits).

  » **Trim After** - The system uses the character in this field as a guide for removing non-relevant user information from the SIP initial invitation message, to prevent incorrect routing of the call. For example, by typing a semi-colon (;) in the **Trim After** field, the system will trim the following invitation from this:

  \[
  \text{<sip:Peter;phone-context=mycompany.udp@anycompany.com;user=phone>}
  \]

  to this:

  \[
  \text{<sip:Peter @anycompany.com;user=phone>}
  \]

  » **Strip** - The number of digits you want the SIP Soft Switch to remove from the beginning of the number (either destination or origination number, depending on which **Strip** field you configure). This feature is useful for stripping a 9 from a telephone number before sending a call to a gateway.

  » **Insert** - The digits you want the SIP Soft Switch to insert at the beginning of the number.

  » **Append** - The digits you want the SIP Soft Switch to add to the end of the user field. For example, if you used trim after for an incoming call, you may need to append the info trimmed for the outgoing call, changing from this:

  \[
  \text{<sip:Peter @anycompany.com;user=phone>}
  \]

  to this:

  \[
  \text{<sip:Peter;phone-context=mycompany.udp@anycompany.com;user=phone>}
  \]
Prefix Manipulation Examples

**Example 1:** The following example demonstrates the use of the Prefix and Insert fields to change a dialed extension to an acceptable number for a PSTN gateway. The outgoing origination number fields convert a caller’s number from a 3-digit extension, starting with 42 (such as 428), to a local PSTN number: 404-1428 (inserting 4041 in front of the 3-digit extension), allowing the PSTN destination to see the entire number.
Example 2: The following example demonstrates how to append a 9 to an incoming number to facilitate a subsequent call-back, if needed. The incoming origination number fields insert a 9 at the beginning of the call ID of incoming calls. This enables the call recipient to use the call-return features of the phone, since the call-back number is already configured in the correct format as a result of prefix manipulation settings (otherwise, the call return feature fails). By inserting a 9 for an incoming call such as 777-1234, the sequence of numbers: 9 777-1234, would correctly access the PSTN if the call recipient needs to return the call.
Example 3: The following example demonstrates the use of the **Number length** field. Number length is particularly useful if your end users dial less than the full phone number required to reach a given phone. In this example, multiple dialing scenarios are considered:

<table>
<thead>
<tr>
<th>Number Dialed</th>
<th>Prefix Manipulation:</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>555 1212</td>
<td>adds 91925</td>
<td></td>
</tr>
<tr>
<td>925 555 1212</td>
<td>adds 9</td>
<td>9 1 925 555 1212</td>
</tr>
<tr>
<td>9 925 555 1212</td>
<td>strips the 9, then adds 91</td>
<td></td>
</tr>
<tr>
<td>1 925 555 1212</td>
<td>adds 9</td>
<td></td>
</tr>
</tbody>
</table>

In the first, the end user dials only 7 digits for a local number (for instance 555-4321), but your carrier requires the full 10 digits (including area code) and the leading 1 to indicate North American long distance. Based on the **Prefix Manipulation** settings indicated below, the system reconfigures the number to be the full 10 digits required by the local carrier and includes the digit 9, needed for an outside line. In the second scenario, the number dialed is a 10-digit number, for instance (925) 555-4321; the system converts it to a PSTN number preceded by a 9: 9 1 925 555-4321. In the third scenario, the number dialed is an 11-digit local number, for instance 9 (925) 555-4321 (the long-distance prefix was not dialed); the system strips the 9 and inserts the required 9 and 1. In the fourth scenario, the number dialed is a 11-digit local number, for instance 1 (925) 555-4321 (the required 9 for an outside line was not dialed); the system inserts the required 9.
Example 4: The following example is a more complicated gateway prefix manipulation configuration, for an environment in which users wanting the highest quality connection can dial 884 before dialing the rest of an outbound number. The 884 prefix routes the call to Gateway 884, which is the best gateway in the environment.

In this prefix manipulation configuration:

- The **Outgoing Calls Destination Number** configuration causes the SIP Soft Switch to strip the first 3 digits from any destination number of an outgoing call if the first four digits of the destination number are 8849.
- The **Outgoing Calls Origination Number** configuration causes the SIP Soft Switch to insert the digits 4041 to the beginning of the origination number of all outgoing calls passing through this gateway.
- The **Incoming Calls Destination Number** configuration causes the SIP Soft Switch to strip the first 4 digits from the destination number of any incoming call it receives from any gateway or trunk.
- The **Incoming Calls Origination Number** configuration causes the SIP Soft Switch to insert a 9 at the beginning of the origination number of any incoming call it receives from any gateway or trunk.
The following diagrams use the prior example gateway (Gateway 884) to illustrate how the SIP Soft Switch handles prefix manipulation. The example assumes the dial plan is configured such that users must dial a 9 to place an outbound call, and that the gateways are configured to remove the prefix 9 from outbound calls.

1. A user at extension 600 calls an external phone at (415)111-2121. The call is important, so the user dials the prefix 884 to ensure the highest quality gateway (Gateway 884) handles the call.

2. The SIP Soft Switch receives the call, strips the digits 884 from the destination number, and prefixes the digits 4041 to the origination number before sending the call to Gateway 884.

3. Gateway 884 strips the prefix 9 from the destination number, and adds a 1 plus the area code to the origination number before sending the call to the PSTN.

4. The PSTN sends the call to its destination. The caller ID on the readout of the destination phone shows the modified origination number.
1 An external caller calls an IPCM user at (925) 404-1600. The call goes to the PSTN.
2 The PSTN receives the call and passes it to the IPCM gateway configured to receive incoming calls.
3 The gateway strips the first four digits (1925) from the destination number and sends the call to the SIP Soft Switch.
4 The SIP Soft Switch strips the first four remaining digits (4041) from the destination number, adds a 9 to the origination number, and sends the call to the IPCM user.
Dial Plan
Security Plan

IPCM utilizes role-based access rights. To ensure the security of IPCM functionality, a user can only access the features and functions assigned to the user by the system administrator. The system permissions are called privileges. There are privileges for primary functions in IPCM, such as accessing IPCM interfaces and performing specific configurations. Instead of granting individual privileges to users, IPCM lets you group privileges together as roles, enabling you to grant a collection of privileges to a user through the use of roles. Multiple roles can be assigned to any given user.

Role Configuration

Privileges

Roles in IPCM are comprised of privileges. The following table describes the privileges you can grant or deny to roles in an IPCM environment. The list of privileges is not editable.

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View configuration</td>
<td>View System Configuration and Log Viewer pages.</td>
</tr>
<tr>
<td>Change dial plan</td>
<td>Modify the SIP Soft Switch dial plan.</td>
</tr>
<tr>
<td>Configure system users</td>
<td>Create, modify, and delete IPCM user accounts.</td>
</tr>
<tr>
<td>Create and configure applications</td>
<td>Create voice applications with Application Builder.</td>
</tr>
<tr>
<td>Configure Contact Center agents</td>
<td>Manage agents.</td>
</tr>
<tr>
<td>Configure skills</td>
<td>Manage skills.</td>
</tr>
<tr>
<td>Configure routing rules</td>
<td>Manage routing rules.</td>
</tr>
<tr>
<td>Configure services</td>
<td>Manage services.</td>
</tr>
<tr>
<td>Configure Queue Monitor</td>
<td>Configure the queues.</td>
</tr>
<tr>
<td>Configure reporting</td>
<td>Configure the historical reporting.</td>
</tr>
<tr>
<td>Configure advanced Contact Center parameters</td>
<td>Modification of advanced Contact Center server parameters.</td>
</tr>
<tr>
<td>Privilege Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configure voice server</td>
<td>Configure the voice server.</td>
</tr>
<tr>
<td>Configure Quality Management</td>
<td>Configure the Quality Management functionality, including scheduled</td>
</tr>
<tr>
<td></td>
<td>conversation recordings and recording rating criteria.</td>
</tr>
<tr>
<td>View user’s configuration</td>
<td>View IPCM user configurations.</td>
</tr>
<tr>
<td>Edit user’s configuration</td>
<td>View and edit IPCM user configurations.</td>
</tr>
<tr>
<td>View SIP Soft Switch runtime state</td>
<td>View the <a href="#">SIP Soft Switch State</a> pages in the Management Portal.</td>
</tr>
<tr>
<td>Terminate active calls from Management Portal</td>
<td>Disconnect active calls using the <a href="#">SIP Soft Switch State</a> functions in</td>
</tr>
<tr>
<td></td>
<td>the Management Portal.</td>
</tr>
<tr>
<td>Control system</td>
<td>Manage the IPCM servers and applications using the Management Console.</td>
</tr>
<tr>
<td>ACD presence management</td>
<td>Access to the Agent Server for changing agent states.</td>
</tr>
<tr>
<td>Other agents presence management</td>
<td>Change other agent's status.</td>
</tr>
<tr>
<td>Use Instant Messaging</td>
<td>Use the Instant Messaging function.</td>
</tr>
<tr>
<td>Stop conversation recordings</td>
<td>Allows the agent to terminate the voice recording in progress at the caller's</td>
</tr>
<tr>
<td></td>
<td>request (this may be required by local laws).</td>
</tr>
<tr>
<td>View other agents in Address Book</td>
<td>Grants agents the ability to see other agents in the Address Book.</td>
</tr>
<tr>
<td>View agents</td>
<td>Access to the Agent Dashboard <a href="#">Quality Management</a> tab. The tab does not</td>
</tr>
<tr>
<td></td>
<td>display without this privilege.</td>
</tr>
<tr>
<td>Monitor conversations</td>
<td>Monitor conversations.</td>
</tr>
<tr>
<td>Participate in conversations</td>
<td>Participate in conversations.</td>
</tr>
<tr>
<td>Whisper in conversations</td>
<td>Use whisper conferencing (talking to an agent without a caller hearing you).</td>
</tr>
<tr>
<td>Record conversations</td>
<td>Record conversations.</td>
</tr>
<tr>
<td>View application flow reports</td>
<td>Run reports on previous voice application activities.</td>
</tr>
<tr>
<td>View interaction history reports</td>
<td>Run reports on previous interactions.</td>
</tr>
<tr>
<td>Listen interaction recordings</td>
<td>Listen to server side recordings of agent conversations.</td>
</tr>
</tbody>
</table>
Role Configuration

### Roles


You can modify a role to grant additional privileges. You can also add to this list as necessary by creating new roles. Configure each role you create by specifying the privileges the role grants or denies. You can delete unnecessary roles.

The following table lists the default roles and privileges each role grants.

<table>
<thead>
<tr>
<th>Name</th>
<th>Role Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>System configuration</td>
<td>• View configuration</td>
</tr>
<tr>
<td></td>
<td>• Configure dial plan</td>
</tr>
<tr>
<td></td>
<td>• Configure system users</td>
</tr>
<tr>
<td></td>
<td>• Configure voice server</td>
</tr>
<tr>
<td></td>
<td>• Configure Quality Management</td>
</tr>
<tr>
<td></td>
<td>• View user's configuration</td>
</tr>
<tr>
<td></td>
<td>• Edit user's configuration</td>
</tr>
<tr>
<td></td>
<td>• View SIP Soft Switch configuration</td>
</tr>
<tr>
<td></td>
<td>• Edit SIP Soft Switch configuration</td>
</tr>
<tr>
<td>Name</td>
<td>Role Privileges</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| System administrator        | • View user’s configuration  
• Edit user’s configuration  
• View SIP Soft Switch runtime state  
• Terminate active calls from Management Portal  
• Control system |
| Application developer       | • View configuration  
• Create and configure applications |
| Contact Center Administrator| • View configuration  
• Configure Contact Center agents  
• Configure skills  
• Configure routing rules  
• Configure services  
• Configure Queue Monitor  
• Configure reporting  
• Configure advanced Contact Center parameters  
• View user’s configuration  
• Edit user’s configuration  
• View historical reports |
| Contact Center Agent        | • View user’s configuration  
• Edit user’s configuration  
• ACD presence management  
• Use Instant Messaging  
• View other agents in Address Book  
• Browse queues  
• Pull interaction  
• Park interaction |
| Contact Center Supervisor   | • View user’s configuration  
• Edit user’s configuration  
• Other agents presence management  
• Use Instant Messaging  
• View other agents in Address Book  
• View agents  
• View application flow reports  
• View interaction history reports  
• Archive interaction history  
• View historical reports  
• View Instant Messaging logs  
• View runtime statistics  
• Browse queues  
• Assign interaction |
Create Roles

To Create Roles:

1. In the Management Portal, click **System Configuration>Users>Roles**. The Roles page opens.

2. Create a name for the new role and enter the name in the empty field at the bottom of the Role Name column.

3. Click the Add button.

4. Click the Commit Changes button. The role becomes available immediately for you to assign to IPCM users; however, the role does not grant any privileges until you configure the role.
To Configure Roles:

1. On the Roles page (in the Management Portal, click System Configuration>Users>Roles), click the role you want to configure. The Role properties page for that role opens, listing all privileges available in IPCM.

2. Grant or deny each privilege by selecting the Allowed or Denied check box next to each privilege (scroll to view all privileges). You can only select one check box for each privilege. If you are configuring a new role, all check boxes are clear by default; however, after selecting an option you must select either Allowed or Denied for each privilege. If you leave both check boxes deselected for a privilege, the role does not grant that privilege.

   **IMPORTANT:** Roles with privileges involving configuration functions in the Management Portal (such as Configure dial plan, Configure system users, Create and configure applications, etc.), must also have the View configuration privilege. Otherwise, the user cannot access the Management Portal functions to use the privileges. The exception is the Edit user's configuration role, which is a role assigned to users and agents to enable them to configure their own user settings.

3. Click the Update and Commit Changes button.

To Delete Roles:

   **Note:** If you delete a role that is assigned to a user, the user loses the privileges the role grants.

1. In the Management Portal, click System Configuration>Users>Roles. The Roles page opens.

2. Click the red x icon next to the role. A confirmation dialog box opens.

3. Click OK to confirm the deletion.

4. Click the Commit Changes button.
Organizing the Contact Center

Process Overview

Using IPCM to organize your contact center involves the following process:

- **User Profile Management** - Create and configure users (including designating selected users as agents).
- **Skill Configuration** - Create skills and skill groups, which will be used to establish agent skill proficiency levels.
- **Not Ready Reasons Configuration** - Configure Not Ready reasons (or use the default reasons), so you can require Not Ready reasons when configuring agent groups and agents settings.
- **Agent Groups** - Create agent groups and designate users as agents.
- **Configure Agent Properties** - Configure agent settings and skills.
- **System-Wide Agent Settings** - Configure WrapUp Timeout options, Not Ready reason settings, and agent audit settings for all agents system-wide.
- **Services** - Create services.
- **Queues** - Create and configure queues (optional - you can use the default queues).

User Profile Management

Create Users

IPCM has four default users, including two agents (John and Peter), a manager with Quality Management privileges (if your IPCM installation has a license for Quality Management features), and an administrator with all privileges. You can delete these default users.

► To Create Users:

1. In the Management Portal, click System Configuration>Users.
2. Create a login name for the user and type it in the empty field in the Login column.

   **IMPORTANT:** IPCM logins (usernames) are case-sensitive and can consist of characters (a-z, A-Z), digits (0-9), underscores(_), periods (.), and dashes (-). All other characters are prohibited. The maximum username length is 128 characters.

3. Type the first name of the user in the empty field in the First Name column.
4. Type the last name of the user in the empty field in the Last Name column.
5. Type an extension in the Extension column. If you enter an extension which does not yet exist in the dial plan, the Management Portal will automatically add the extension into the dial plan. Be sure to configure the extension as described in the online help topic "SIP Soft Switch Configuration: Dial Plan Implementation."

6. By default, the user is searchable by name, enabling the voice Attendant and Answering applications to find the user by name. This setting can be changed on the General tab for the user (refer to Configure the User Profile on page 61).

7. If you have a Contact Center license:
   - Select the Agent check box if you want the user to be an agent. Selecting the Agent check box automatically selects the Contact Center Agent role on the User’s General tab (refer to Configure the User Profile on page 61).
   - If you select the Agent check box, you can also assign the agent to an agent group in the Agent Group drop-down list. If you have not yet created agent groups, you can assign the user to an agent group on the Agents/Skills/Services>Agents page (refer to Add Agents to a Group on page 71).

8. Click the Add button. IPCM displays a confirmation dialog box.
9. Click OK. IPCM adds the user to the table.

   **Note:** The default for the user UI Language is Automatic: the GUI language will be chosen based on the user’s Windows local regional settings. If you need to specify a language for the user, click the login name link in the Login column to view that user’s properties page. On the General tab, select the specific language in the UI Language field from the list of languages supported by IPCM.

10. Click the Update and Commit Changes buttons to apply the changes.
Delete Users

►To Delete Users:

1  In the Management Portal, click System Configuration>Users.
2  Click the red x icon at the end of the row containing the user’s information.
3  The Remove User dialog box opens, asking if you also want to remove the user’s extension (uncheck the box if you want to keep the extension in the dial plan). Click Remove.
4  Click OK to confirm the deletion.
5  Click the Update and Commit Changes buttons to apply the change.

Configure the User Profile

On the Management Portal Users page, click the login name link in the Login column to view that user’s properties pages:

- General Tab
- Address Book Tab
- Unified Messaging Tab
- Forwarding Tab
- Dialable PIN Tab

![User Profile Management](image)
General Tab

The settings on the General tab page let you:

• Change or reset the user’s password.
• Enter contact information such as the user’s name and email address.
• Assign a dial plan extension to the user.
• Assign the user to an agent group if the user is an agent.
• Assign one or more roles to the user, determining the specific IPCM functionality the user can access.

Note: Depending on the role of the user, users can access and modify their user properties by clicking Start>Programs>FrontRange Solutions>Management Portal>User Account, then clicking the General tab.

To Configure User Settings on the General Tab:

1 In the Management Portal, click System Configuration>Users.
2 In the Login column on the Users page, click the name of the user. The User properties page for that user opens.
3 Click the General tab. By default a user’s password is password. To change a user’s password, click the Change button. The Change Password dialog box opens.
   • Type the new password in each field and click the Set button.
   IMPORTANT: IPCM passwords are case-sensitive, and can consist of any character with an ASCII code from 1-127, including Latin characters, digits, and punctuation signs. All national characters (characters that do not appear in English) are prohibited, since all national characters have an ASCII code greater than 127. The maximum length for passwords is 32 characters.
   • The Reset button is used to reset the user’s password to password.
   CAUTION: For security reasons, Ivanti recommends you change the password of the default admin user before going live in a production environment.
4 Enter the user’s email address in the E-Mail field.
5 The Extension was entered on the Users page when you created the user. You can change it on the General tab if needed.
6 If needed, you can also change the Searchable by name setting on this tab: unchecking the box prevents the voice Attendant and Answering applications from finding the user by name.
7 If you have a Contact Center license, select the Agent check box if you want the user to be an agent (if you didn’t check this box when creating the user). Selecting the Agent check box automatically selects the Contact Center Agent role.
8 If this user is an agent, you can assign the user to an agent group by selecting the group in the Agent group field. You can also assign the user to an agent group on the Agents/Skills/Services>Agents page (refer to Agent Groups on page 68).
9 The default for the user UI Language is Automatic: the GUI language will be chosen based on the user’s Windows local regional settings. If you need to specify a language for the user, select the specific language in the UI Language field from the list of languages supported by IPCM.
10 In the **Role** field, select the check box next to each role you want the user to have. If you assign a user one role that allows a privilege and a second role that denies that privilege, IPCM denies the user that privilege. If you assign a user one role that allows a privilege and a second role that neither allows nor denies that privilege (i.e., the privilege check box is not selected), IPCM grants the user the privilege. For more information on user roles, refer to **Role Configuration** on page 53.

**Note:** Currently, **object access control** is unavailable. For example, if a user has a role with the View queues privilege, that user can view all existing queues in the Contact Center. You cannot grant a user permission to view queue A, but not queue B. Such access control is handled within the configured object.

11 Click the **Update** and **Commit Changes** buttons to apply and apply the change.

**Address Book Tab**

On the **Address Book** page, users can populate their individual address books with contacts. Those contacts will be accessible to the user when logged in to and making calls from the Agent Dashboard softphone.

**Unified Messaging Tab**

For information on configuring the user **Unified Messaging** tab, refer to **Chapter 10, Office Phone System**.

**Forwarding Tab**

The **Forwarding** page contains the same set of fields as the **Forwarding** tab for an extension in the dial plan. Refer to the online help topic "SIP Soft Switch Configuration: Configure Phone Entries: Forwarding" for more information on configuring the settings.

**Dialable PIN Tab**

The dialable PIN is used in conjunction with a user code to allow a user to log into a phone in the IPCM environment and override the original COR/forwarding configuration of the phone. Although the dialable PIN and the associated user are specified on the **User Code** properties page (**System Configuration>SIP Soft Switch>User Codes**), on the **Dialable PIN** page, the user can change the PIN which authorizes use of the user code. Refer to **User Codes on page 139** for more information.
Skill Configuration

In IPCM, you can set skills and skill proficiency levels for agents in your contact center. For example, to indicates an agent can speak English fluently, the agent may have an English skill level of 90. The skill values are set in range from 0 to 100 (it is convenient to think of them as percentages). If a skill is not defined for an agent, it is assumed to be 0.

Skills are arranged in skill groups. There are two default skill groups: Language and Technical Skills. You can use these default skill groups and the skills they include, or you can modify or delete the groups. English and Spanish are skills that are part of the Language default skill group; Software and Hardware are skills that are part of the Technical Skills default skill group.

You will use the skill groups to set agent skill proficiency levels when configuring agent properties (refer to Agent Skills Tab on page 78).

The Contact Center server displays skills and skill groups on the Skills and Skill Groups page (in the Management Portal, click Agents/Skills/Services>Skills and Skill Groups).

Working with Skills and Skill Groups

On the Skills and Skill Groups page, you can:

- Create Skills and Skill Groups
- Delete Skills
- Delete Skill Groups
- Edit Skill and Skill Group Names
Create Skills and Skill Groups

To Create a Skill Group:

1. In the Skills and Skill Groups page (in the Management Portal, click Agents/Skills/Services>Skills and Skill Groups), click the Create group button. A new skill group with the name New group appears at the bottom of the table on the Skills and Skill Groups page.
   
   **IMPORTANT:** The Contact Center server does not let you create another group until you change the name of the new skill group from New group to a different name.

2. Highlight the name New group and type a name for the skill group.
   
   **IMPORTANT:** Each skill group must have a unique name. There are no other restrictions for skill group names.

3. Click the Update and Commit Changes buttons to apply the change. Click the Discard Changes button if you want to undo the change.

4. To add a skill to this skill group, type a skill name in the field below the skill group name.
   
   **IMPORTANT:** Each skill must have a unique name. Do not use the same name for multiple skills even if each skill is in a different group. There are no other restrictions for skill names. Also note that you cannot move the skill to another group once you create it. If you want the skill to appear under another skill group after creating the skill, you must delete the skill and recreate it in the other skill group.

5. Click the Add Skill button. The screen refreshes and the skill appears under the skill group name in the table.

6. Click the Commit Changes button.
Delete Skills

Deleting a skill from a skill group prevents you from assigning the skill to any more agents or using the skill in any more routing rules; however, the deletion does not remove the skill from agents to whom you already assigned the skill, nor does it remove the skill from existing routing rules.

► To Delete Skills:

2. Click the Delete skill(s) button. A dialog box opens, asking you to confirm the deletion.
3. Click Yes. The screen refreshes and the skill is deleted.
4. Click the Commit Changes button.

Delete Skill Groups

Deleting a skill group prevents you from assigning the skills in that skill group to any more agents, or using the skills in any more routing rules; however, the deletion does not remove the skills from agents to whom you already assigned the skill, nor does it remove the skill from existing routing rules.

► To Delete Skill Groups:

1. On the Skills and Skill Groups page (in the Management Portal, click Agents/Skills/Services>Skills and Skill Groups), click the red x icon next to each skill group you want to delete. A confirmation dialog box opens.
2. Click Yes. The screen refreshes and the skill group is deleted.
3. Click the Commit Changes button.

Edit Skill and Skill Group Names

► To Edit Names:

1. On the Skills and Skill Groups page (in the Management Portal, click Agents/Skills/Services>Skills and Skill Groups), edit the name of the skill or skill group.

   **IMPORTANT:** Each skill and skill group must have a unique name. Do not use the same name for multiple skills even if each skill is in its own group. There are no other restrictions for skill and skill group names.

2. Click the Reset button to undo any changes made on the Skills and Skill Groups page (before clicking the Update button). Click the Update and Commit Changes buttons to apply the changes made.
Not Ready Reasons Configuration

The Agent Dashboard enables agents to manually indicate when they are in the Ready state (i.e., available to handle calls) or the Not Ready state. If an agent switches to the Not Ready state, the Agent Dashboard allows the agent to select a predefined Not Ready reason from the drop-down list next to the Not Ready button on the Agent Dashboard Agent State bar. Supervisors use the Agent Dashboard Quality Management tab to view currently selected Not Ready reasons.

Note: Refer to the Agent Dashboard User’s Guide for more information about the Agent Dashboard.

You can add, edit, and delete Not Ready reasons as needed. The Contact Center server provides four default Not Ready reasons for all agents: Lunch, Break, Meeting, and Away from Desk.

You can also make it mandatory for agents to indicate a Not Ready reason. This can be done:

- At the agent level on the Agent Settings tab of the Agent Properties dialog box (refer to Agent Settings Tab on page 74).
- At the agent group level on the Agent Group Properties dialog box (refer to Create Agent Groups on page 69).
- System-wide on the Advanced Configuration page for the Contact Center server refer to System-Wide Agent Settings on page 80).

➤ To Edit, Add, or Delete Not Ready Reasons:


   - Modify a Not Ready reason by changing the text in the Reason name field.
   - Add a Not Ready reason by typing a Not Ready reason name in the blank field at the bottom of the Reason name column, and clicking the Add button.
   - Delete a Not Ready reason by clicking the red x icon at the end of the row.

2. Click the Update and Commit Changes buttons to apply the change.
Agent Groups

The Contact Center server displays agent group configurations in a table on the Agents page (in the Management Portal, click Agents/Skills/Services>Agents).

**Note:** The IPCM installation creates and the default groups Demo agent group (containing the default user John) and Ungrouped agents (which includes the default user Peter).

Use the Agents page to:

- Create Agent Groups
- Add Agents to a Group
- Move Agents to and from Agent Groups
- Delete Agent Groups
- Edit Agent Groups
- Designate users as agents: Add Agents
- Delete an Agent
- Disable Agents

You can also configure agent settings and skills from the Agents page; refer to Configure Agent Properties on page 74 for details.

The names of agent groups appear in shaded rows in the table. The icon next to the group name shows and hides the group members of each group. You can also select the check box next to an agent group name and click either the Show Group(s) or Hide Group(s) buttons at the top of the page.

Agent ID’s appear as links beneath the agent group to which they belong. To the right of the agent ID is the first and last name of the agent and agent’s proficiency levels for each skill in the selected skill group. To display skills belonging to another skill group, select that skill group from the Skill Group drop-down list above the list of groups and click the Show button. The page refreshes to display the skills from the other skill group.
Agent Groups

The table lists ungrouped agents under the **Ungrouped Agents** heading and in the drop-down lists next to each **Add** button.

**Note:** In order for a user to display in the drop-down list next to the **Add** button, the user must have the **Contact Center Agent** role and the **Agent** check box on the **Users** page is **not** selected. Refer to User Profile Management on page 59 for more information.

### Create Agent Groups

Some group settings, including **Not Ready Reason Required**, **Agent WrapUp Timeout**, **Initial Agent Status**, **Initial Not Ready Reason**, and **Audit group agents**, can also be configured at the agent level (refer to Agent Settings Tab on page 74) and system-wide (refer to System-Wide Agent Settings on page 80). The agent group setting overrides the system-wide setting and the agent setting overrides the agent group setting.

► **To Create an Agent Group:**

1. On the **Agents** page (in the Management Portal, click **Agents/Skills/Services>Agents**), click the **Create Group** button. The **New agent group** dialog box opens.

2. Type the name of the agent group you want to create.

3. You can change the agent group **Name**, if needed.

4. In the **Not Ready Reason Required** field, you can specify if all agents in the group must indicate a **Not Ready** reason when switching to the **Not Ready** state:
   - **Use server defined** - Use the **Not Ready Reasons Are Required** defined system-wide (refer to System-Wide Agent Settings on page 80).
   - **Required** - The agent must indicate a **Not Ready** reason when switching to the **Not Ready** state.
   - **Not Required** - The agent does not need to indicate a **Not Ready** reason when switching to the **Not Ready** state.
5 In the **Agent WrapUp Timeout** field, you can specify the automatic **WrapUp Timeout** for all agents in the group:

- **Use server defined** - Use the **WrapUp Timeout** defined system-wide (refer to System-Wide Agent Settings on page 80).
- **Use group defined** - Use the **WrapUp Timeout** defined for the agent group; the time frame (in seconds) is specified in the **Seconds** field.
- **Disable** - No limit on the **WrapUp Timeout** is imposed; the agent remains in the **After-Call Work** state until manually switching to the **Ready** state.

6 If you selected **Use group defined** in the **WrapUp Timeout** field, specify in the **Seconds** field the maximum amount of time the agent can spend in the **After-Call Work** state.

7 Specify the initial agent status upon login for all agents in the group:

- **Use server defined** - Use the **Initial Agent Status** defined system-wide (refer to System-Wide Agent Settings on page 80).
- **Ready** - Upon login, the agent status will be set to **Ready**.
- **Not Ready** - Upon login, the agent status will be set to **Not Ready**.

8 If you set the **Initial Agent Status** to **Not Ready**, you can specify the **Not Ready** reason default (if you created additional **Not Ready** reasons, or made changes to the names of the default reasons, they will appear in the list of options) for all agents in the group:

- **Use server defined** - Use the **Initial Not Ready Reason** defined system-wide (refer to System-Wide Agent Settings on page 80).
- **<no reason>**
- **Lunch**
- **Break**
- **Meeting**
- **Away from Desk**

9 In the **Audit group agents** field, specify if you want to record agent state changes in the IPCM database for historical reports:

- **Use server defined** - Use the **Audit Agents** option defined system-wide (refer to System-Wide Agent Settings on page 80).
- **Yes** - Select this option to enable auditing for all agents in the group.
- **No** - Select this option to disable auditing for all agents in the group.

10 Click the **OK** button. The new agent group appears on the **Agents** page.

11 Click the **Commit Changes** button on the **Agents** page to apply the change. Click the **Discard Changes** button if you want to undo the change.
Add Agents to a Group

To add an agent to a group, you will move them from the **Ungrouped agents** list to the new group. You can also select an agent group for an agent when configuring agent properties (refer to Configure Agent Properties on page 74).

➤ **To Add an Agent to a Group:**

1. On the **Agents** page (in the Management Portal, click **Agents/Skills/Services>Agents**), select the check box next to the name of an agent in the **Ungrouped agent** list. You can select more than one agent.

2. In the field to the right of the **Move Agent(s)** button, select the agent group to which you want the agent to belong. Click the **Move Agent(s)** button. The screen refreshes and the table lists the agent as a member of that group.

3. Click the **Commit Changes** button to apply the change. Click the **Discard Changes** button if you want to undo the change.

Move Agents to and from Agent Groups

➤ **To Move Agents:**

1. On the **Agents** page (in the Management Portal, click **Agents/Skills/Services>Agents**), select the check box next to the agent ID of each agent you want to move. You can also move an agent to another group when configuring agent properties (refer to Configure Agent Properties on page 74).

   • To move an agent from one group to another, select the name of the agent group to which you want to move the selected agent in the **<Select target group>** drop-down list at the top of the page.

   • To remove an agent from a group and add that agent to the **Ungrouped agents** list, select **Ungrouped agents** in the **<Select target group>** drop-down list at the top of the page.

2. Click the **Move Agent(s)** button. The screen refreshes and the selected agents reappear under the target agent group.
3 Click the Commit Changes button to apply the change. Click the Discard Changes button if you want to undo the change.

**Edit Agent Groups**

You can edit agent group properties as needed.

► **To Edit Agent Groups:**

1. On the Agents page (in the Management Portal, click Agents/Skills/Services>Agents), click the name of the group you want to edit. The Agent group properties dialog box opens. The settings in this dialog box are identical to those in the New agent group dialog box.

2. Make the necessary changes.

3. Click the OK button.

4. Click the Commit Changes button on the Agents page to apply the change. Click the Discard Changes button if you want to undo the change.

**Delete Agent Groups**

When you delete an agent group, the agents in the deleted agent group become ungrouped agents.

► **To Delete Agent Groups:**

1. On the Agents page (in the Management Portal, click Agents/Skills/Services>Agents), select the check box next to the name of each agent group you want to delete.

2. Click the Remove Group(s) button. A dialog box opens asking you to confirm the removal.

3. Click OK. The screen refreshes and the agent group is deleted.

4. Click the Commit Changes button on the Agents page to apply the change. Click the Discard Changes button if you want to undo the change.

**Add Agents**

When you add an agent, you actually designate an existing user as an agent.

**IMPORTANT:** Before adding a user as an agent, the user must have a user profile with the Contact Center Agent role assigned. Refer to User Profile Management on page 59 for information.

The Contact Center server creates agent data for each user you designate as an agent, enabling the server to track the user’s state changes and route calls to the user.

► **To Designate a User as an Agent:**

1. On the Agents page (in the Management Portal, click Agents/Skills/Services>Agents), do one of the following:

   - Select the name of the user in the drop-down list next to the Add button under the agent group to which you want this agent to belong.
   - Select the name of the user under the Ungrouped agents heading, if you don’t want this agent to belong to an agent group.
2 Click the **Add** button. The screen refreshes and the table lists the user as an agent, displaying the user’s agent ID, first name, last name as you configured it on the **Users** page (refer to **User Profile Management on page 59**). The user’s name no longer appears in the drop-down lists next to the **Add** buttons.

3 Click the **Commit Changes** button to apply your changes. Click the **Discard Changes** button if you want to undo your changes.

**Delete an Agent**

Deleting an agent is actually revoking a user’s designation as an agent. The user retains a user profile, but the Contact Center server deletes the agent information created for the user, and no longer tracks the user’s state changes nor routes calls to the user. If you no longer want the Contact Center server to route calls to the agent but you do not want to lose the agent’s data, disable the agent instead.

► **To Delete an Agent:**

1 On the **Agents** page (in the Management Portal, click **Agents/Skills/Services>Agents**), select the check box next to the agent ID of each agent you want to delete.

2 Click the **Delete Agent(s)** button. A dialog box opens, asking you to confirm the agent deletion.

3 Click OK. The screen refreshes and the agent’s name is deleted from the table and reappears in the drop-down lists next to the **Add** buttons.

4 Click the **Commit Changes** button to apply the change. Click the **Discard Changes** button if you want to undo the change.

**Disable Agents**

You can disable an agent without deleting the agent from the system. This is useful if:

• You no longer want to route calls to the agent, but you do not want to lose the data the Contact Center server created for the agent.

• You are approaching the maximum number of enabled agents your license permits.

► **To Disable an Agent:**

1 On the **Agents** page (in the Management Portal, click **Agents/Skills/Services>Agents**), click the name of the agent you want to disable or enable. The **Agent Properties** dialog box for the agent opens.
2 On the Agent settings tab, click the Disabled check box to disable the agent.

3 Click OK then click the Commit Changes button to apply the change, or click the Discard Changes button if you want to discard the change.

Configure Agent Properties

Click the Agent ID on the Agents page and the Agent Properties dialog box opens. The Agent Properties dialog box lets you perform some of the same functions as the Agents page, such as modifying the agent’s skill proficiency levels and moving the agent to another group.

You will see two tabs:
- Agent Settings Tab
- Agent Skills Tab

Agent Settings Tab

On the Agent Settings tab, you can configure the following:

- Enable Auditing - The Audited option allows you to configure the Contact Center server to record agent state changes in the IPCM database for historical reports. Agent audit settings can be configured:
  - At the agent level on the Agent Properties dialog box, Agent Settings tab. Agent auditing is disabled by default for each agent.
  - At the agent group level on the Agent Group Properties dialog box (refer to Create Agent Groups on page 69).
  - System-wide on the Advanced Configuration page for the Contact Center server (refer to System-Wide Agent Settings on page 80).

  **Note:** The agent group setting overrides the system-wide setting and the agent setting overrides the agent group setting.

- Disable Agent - Use this option if you no longer want the Contact Center server to route calls to the agent but you do not want to lose the agent’s data.
• **Specify Automatic WrapUp Timeout** - After hanging up with a caller, the agent state switches automatically to the **After-Call Work** state, during which time the agent is unavailable to take calls while completing the after-call work related to the call. In the default configuration, the agent remains in the **After-Call Work** state until the agent manually switches to the **Ready** state; however, you can use the **Agent WrapUp Timeout** option to determine the maximum amount of time an agent can spend in the **After-Call Work** state. When the time expires, the server automatically switches the agent to the **Ready** state.

   The **Agent WrapUp Timeout** can be configured:

   > At the agent level on the **Agent Properties** dialog box, **Agent Settings** tab.

   > At the agent group level on the **Agent Group Properties** dialog box (refer to Create Agent Groups on page 69).

   > System-wide on the **Advanced Configuration** page for the Contact Center Server (refer to System-Wide Agent Settings on page 80).

   **Note:** The agent group parameter overrides the system-wide parameter and the agent parameter overrides the agent group parameter.

• **Require a Not Ready Reason** - The Agent Dashboard enables agents to manually indicate when they are in the **Ready** state (i.e., available to handle calls) or the **Not Ready** state. If an agent switches to the **Not Ready** state, the Agent Dashboard allows the agent to select a predefined **Not Ready** reason.

   You can make it mandatory to indicate a **Not Ready** reason. This can be done:

   > At the agent level on the **Agent Properties** dialog box, **Agent Settings** tab.

   > At the agent group level on the **Agent Group Properties** dialog box (refer to Create Agent Groups on page 69).

   > System-wide on the **Advanced Configuration** page for the Contact Center server (refer to System-Wide Agent Settings on page 80).

   **Note:** The agent group parameter overrides the system-wide parameter and the agent parameter overrides the agent group parameter.

► **To Configure Agent Settings:**

1. Click the **Agent ID** link on the **Agents** page. The **Agent Properties** dialog box opens to the **Agent Settings** tab.
2 To move an agent to a different group, select that group from the **Group** drop-down list.

3 In the **Audited** field, specify if you want to record agent state changes in the IPCM database for historical reports:

   - **No** - Select this option to disable auditing for this agent.
   - **Yes** - Select this option to enable auditing for this agent.
   - **Use group defined** - Use the **Audit Group Agents** option defined for the agent group to which this agent belongs (refer to *Create Agent Groups on page 69*).

4 To disable the agent, select the **Disabled** check box.

5 Specify the automatic **WrapUp Timeout** for an agent:

   - **Use group defined** - Use the **WrapUp Timeout** defined for the agent group to which this agent belongs (refer to *Create Agent Groups on page 69*).

   - **Use agent defined** - Use the **WrapUp Timeout** defined for this agent; the time frame (in seconds) is specified in the **Seconds** field.

   - **Disable** - No limit on the **WrapUp Timeout** is imposed; the agent remains in the **After-Call Work** state until the agent manually switches to the **Ready** state.

6 If you selected **Use agent defined** in the **WrapUp Timeout** field, specify in the **Seconds** field the maximum amount of time the agent can spend in the **After-Call Work** state.
7 Specify if agent must indicate a Not Ready reason when switching to the Not Ready state:

- **Use group defined** - Use the Not Ready Reasons Are Required defined for the agent group to which this agent belongs (refer to Create Agent Groups on page 69).
- **Required** - The agent must indicate a Not Ready reason when switching to the Not Ready state.
- **Not Required** - The agent does not need to indicate a Not Ready reason when switching to the Not Ready state.

8 Specify the initial agent status upon login:

- **Use group defined** - Use the Initial Agent Status defined for the agent group to which this agent belongs (refer to Create Agent Groups on page 69).
- **Ready** - Upon login, the agent status will be set to Ready.
- **Not Ready** - Upon login, the agent status will be set to Not Ready.

9 If you set the Initial Agent Status to Not Ready, you can specify the Not Ready reason default (if you created additional Not Ready reasons, or made changes to the names of the default reasons, they will appear in the list of options):

- **Use group defined** - Use the Initial Not Ready Reason defined for the agent group to which this agent belongs (refer to Create Agent Groups on page 69).
- **<no reason>**
- **Lunch**
- **Break**
- **Meeting**
- **Away from Desk**

10 Click OK or click the Agent skills tab to configure the skills for this agent (refer to Agent Skills Tab on page 78 for details).

11 If you click OK, the Agent Properties dialog box closes. Click the Commit Changes button to apply the change.
Agent Skills Tab

Both the Agent Properties dialog box and the Agents page have editable tables listing skills and skill proficiency levels. The Agent Properties dialog box lets you set skill proficiency levels at the agent level; the Agents page lets you set skill proficiency levels at the skill-group level. Both procedures are described below.

► To Set Agent Skill Proficiency Levels on the Agent Skills Tab:

1. Click the Agent skills tab which displays the agent’s current skill proficiency levels (if any).

```
Agent properties

Agent: john

<table>
<thead>
<tr>
<th>Skill name</th>
<th>Skill value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Languages: English</td>
<td>80</td>
</tr>
<tr>
<td>Language: Spanish</td>
<td>70</td>
</tr>
<tr>
<td>Technical Skills: Software</td>
<td>100</td>
</tr>
<tr>
<td>Technical Skills: Hardware</td>
<td>50</td>
</tr>
</tbody>
</table>
```

2. Do one or more of the following:
   - Change the agent’s skill proficiency levels by editing the values in the Skill value column.
   - Remove a skill from the agent’s skill set by clicking the red x icon next to the skill. A confirmation dialog box opens. Click OK.

   **Note:** Removing a skill on the Agent Properties dialog box only removes the skill from the agent’s skill set; it does not delete the skill from the system.

3. Click the Update and Commit Changes buttons to apply the change, or click the Discard Changes button if you want to discard the change.

► To Set Skill-Group Skill Proficiency Levels on the Agents Page:

1. On the Agents page (in the Management Portal, click Agents/Skills/Services>Agents), in the Skill Group drop-down list select the skill group containing the skills for which you want to set proficiency levels.
2 Click the Show button. The skills for the skill group appear in columns on the right side of the table.

3 Change each agent's skill proficiency levels by editing the values under each skill. A value of 0 indicates the agent does not have the skill.

4 Click the Update All and Commit Changes buttons to apply the changes. If you want to undo the change before clicking the Update All button, click the Discard Changes button.
System-Wide Agent Settings

The **Advanced Configuration** page for the Contact Center server enables you to configure system-wide agent settings, including the **WrapUp Timeout** option, **Not Ready** reason settings, and agent audit settings for all agents system-wide.

The agent group setting (refer to [Create Agent Groups on page 69](#)) overrides the system-wide setting, and the agent setting (refer to [Agent Settings Tab on page 74](#)) overrides the agent group setting.

**Note:** For information regarding the other settings on this tab, not explained in the following procedures, refer to the online help topic "Contact Center Server Configuration: Additional Contact Center Configurations."

► **To Configure Agent WrapUp Timeout System-Wide:**

1. In the Management Portal, click **System Configuration>**Contact Center Server>**Advanced Configuration**. The **Advanced Configuration** page opens.

2. In the **Agent WrapUp Timeout** field, select **on** if you want to enable the Agent Wrap-Up Timeout option for all agents system-wide, or **off** if you do not. The default setting is **off** (disabled), meaning that agents must manually set themselves to the **Ready** state after taking a call.

3. If you selected **on** in the **Agent WrapUp Timeout** field, specify in the **Seconds** field the number of seconds an agent can be in the **After-Call Work** state before the server automatically switches the agent to the **Ready** state.

4. Click the **Update** and **Commit Changes** buttons to apply the change, or click the **Discard Changes** button to discard the change.

► **To Configure System-Wide Not Ready Reason Settings:**

1. In the Management Portal, click **System Configuration>**Contact Center Server>**Advanced Configuration**. The **Advanced Configuration** page opens.

2. In the **Not Ready Reasons Are Mandatory** field, select **yes** if you want it mandatory for all agents system-wide to designate a **Not Ready** reason, or **no** if you do not. The default setting is **no** (disabled), meaning agents do not have to specify a **Not Ready** reason.
Routing Rules

3. In the **Initial Agent Status** field, select **Ready** if you want that status to be set for the agent upon login; select **Not Ready** if you want that status set for the agent upon login.

4. If you set the **Initial Agent Status** to **Not Ready**, you can specify the **Not Ready** reason default (if you created additional **Not Ready** reasons, or made changes to the names of the default reasons, they will appear in the list of options):
   - <no reason>
   - Lunch
   - Break
   - Meeting
   - Away from Desk

5. Click the **Update** and **Commit Changes** buttons to apply the change, or click the **Discard Changes** button to discard the change.

To Configure System-Wide Agent Audit Settings:

1. In the Management Portal, click **System Configuration>**Contact Center Server>**Advanced Configuration**. The **Advanced Configuration** page opens.

2. In the **Audit agents** field, specify if you want to record agent state changes in the IPCM database for historical reports:
   - **Yes** - Select this option to enable auditing for agents.
   - **No** - Select this option to disable auditing for agents.

3. Click the **Update** and **Commit Changes** buttons to apply the change, or click the **Discard Changes** button to discard the change.

Routing Rules

A routing rule is a set of conditional instructions the system follows to determine the best destination for a call and how calls are prioritized. For example, you can configure a rule to route a call to:

- The agent who has the most qualified skill set to handle the call.
- The agent who has not taken a call for the longest period.
- The first available agent.

IPCM comes with one pre-configured default routing rule called the **Generic skill-based matcher** (refer to for **Generic Skill-Based Routing** information about how this type of rule operates), or you can create your own rules. You can also configure a rule to give priority to:

- A call that has been waiting in the queue for the longest amount of time.
- A call that is more urgent than other calls in the queue.
- A call from a gold-level account.

You can create multiple routing rules. When selecting which routing rule to apply to each call, the system analyzes the following:

- Criteria you establish in the routing rule configuration.
- Information the voice application provides about the call, which can consist of caller identification information, the reason for the call, etc. (for information on voice applications, refer to Chapter 9, Preparing for Incoming Calls).
- Agent configuration, including each agent’s skill set.
Organizing the Contact Center

There are two ways to create routing rules:

- Use the Application Builder to create a routing rule within a voice application by using the Route to Agent block (refer to the online help topic "Voice Application Design: Building Block Definitions: Route to Agent Block" for details).

- Create routing rules on the Routing Rules page (in the Management Portal, click Agents/Skills/Services>Routing Rules), then specify the desired rule in the voice application using the Route to Agent block.

  **IMPORTANT:** Routing rules created on the Routing Rules page can be used by multiple voice applications; a routing rule created within an application in Application Builder can only be used by the voice application in which you create the rule.

**Configure Routing Rules**

Routing rules consist of one or more time intervals, referred to as escalation intervals, each containing a set of criteria for routing calls during that interval.

Each interval contains a default set of criteria:

- **Customer Time In Queue** - The total time the caller spent in the queue during a single call.

- **Agent Idle Time** - For an agent in the Ready, Not Ready, or Reserved states, the Contact Center server calculates idle time as the amount of time since the agent was last in the After-Call Work state. If the agent has not yet been in the After-Call Work state, the idle time is the amount of time since the agent logged in. The idle time resets to 0 when the agent logs into the system or enters the Busy state. The idle time begins to increment again when the agent leaves the After-Call Work state.

- **Priority** - The priority value of the call; the system uses this value to gauge the urgency or critical nature of the call. If your business needs require call prioritization, you can use the Set Interaction Property block in a voice application to set a value (from 0 to 100) for an interaction property named Priority (refer to the online help topic “Voice Application Design: Building Block Definitions: Set Interaction Property Block” for details). This criterion can then be used in an interval of the routing rule.

  **Note:** The voice application uses the Set Interaction Property block to set the priority.

**Skill Requirement Criteria**

You can also add skill requirements to the set of criteria for an interval. This criteria is based on the skill levels assigned to agents, in range of 0 to 100 (it is convenient to think of them as percentages). If a skill is not defined for an agent, the skill level is assumed to be 0. Skills are arranged in skill groups.

If the voice application allows caller input pertaining to skill requirements, the call will be routed accordingly.

For each interval, a set of skill requirements, thresholds, default skills and importance can be specified. Often, you configure the intervals to lower the skill thresholds over time, possibly dropping entire skill requirements. For example, after 45 seconds in queue, you may simply want the call answered, so you drop the Technical skill requirement. Or, in a routing rule with multiple skills such as Technical and Language skills, after 45 seconds you may drop the Technical skills requirement and leave only the Language requirement.
Routing Rules

For each skill selected by a call, a **Threshold** can be defined in the routing rules. This will effectively limit available **Ready** agents to those who have requested skill values set higher than the thresholds. For example: Language **Threshold = 60** means the routing searches for an agent with the requested language skill value of at least **60**.

**Note:** A threshold is set per skill group rather than per actual skill, because it is the skill group which is chosen in the voice application.

Criteria Importance

The criteria within each interval is listed in the order of **Importance** (highest to lowest) - a value you assign to each criterion when configuring the rule. The system uses this information to determine which call gets priority and which agent gets the call during each escalation interval in the rule.

Importance comes into play only if there are multiple agents for a call or multiple calls for an agent (for example, an agent who has just become **Ready**, with several calls in the queue). Importance is used to find the best possible match. The default set of criteria defined in the routing rule includes a level of importance for each of the following, which also enters into the overall calculation:

- **Skill Requirement Importance** - This importance factor controls how much weight is given to the skill set of the agent. The importance factor is multiplied by the agent skill level. If there are multiple skill requirements in an interval, the algorithm calculates the sum of the products derived by multiplying the importance factor by the skill level for each skill requirement.

- **Customer Time In Queue Importance** - This importance factor controls how much weight is given to the length of time a target has been queued vs. the call priority importance set, when choosing the next call to be delivered to the next available agent. The importance factor is multiplied by the time in queue for each call, expressed as a percentage. The call which has been in queue longest will have a normalized time in queue of 100, and all other calls will be represented as a percentage of the time in queue for that call.

- **Agent Idle Time Importance** - This importance factor controls how much weight is given to the length of time an agent has been ready vs. the importance of the skill set match, when choosing the next agent for this campaign. The importance factor is multiplied by the agent idle time, expressed as a percentage. The agent who has been idle the longest will have a normalized idle time of 100, and all other agents will be represented as a percentage of that agent’s idle time.

- **Priority Importance** - This importance factor controls how much weight the call’s priority will be given when determining which call will be selected for the next available agent. The importance factor is multiplied by the value of the priority interaction property set in the voice application.
Weight Calculation

To find the best match, the system first checks required skills (if the routing rule contains this criteria). If an agent’s skill level is lower than the threshold value for at least one skill in the rule, the agent is excluded as a match for the call. If agent skills are equal to or higher than the threshold value, the system uses agent skill level and skill importance, customer time in queue and its importance, idle time and its importance, and call priority and its importance to calculate the weight, which is a number that represents the best match between a single agent and a single call. The following equation is the calculation performed by the system:

\[
\frac{\sum (\text{Skill}(i) \times \text{IFactorSkill}(i)) + \text{TIQ} \times \text{IFactorTIQ} + \text{IdleTime} \times \text{IFactorIT} + \text{Priority} \times \text{IFactorP}}{\sum \text{IFactorSkill}(i) + \text{IFactorTIQ} + \text{IFactorIT} + \text{IFactorP}}
\]

where:

- \(\sum (\text{Skill}(i) \times \text{IFactorSkill}(i))\) is the sum of the products derived by multiplying the agent skill level by the skill importance value set for that skill, for as many skill requirements as are defined in the interval.

- \(\text{TIQ} \times \text{IFactorTIQ}\) is the call time in queue multiplied by the time in queue importance value set in the interval.

- \(\text{IdleTime} \times \text{IFactorIT}\) is the agent idle time multiplied by the idle time importance value set in the interval.

- \(\text{Priority} \times \text{IFactorP}\) is the call priority (the value of the priority interaction property set in the voice application) multiplied by the priority importance value set in the interval.

**Note:** For the purposes of this calculation both time in queue and idle time are expressed as comparative percentages; for example, given that 2 calls are in the queue, one for 60 seconds and the other for 30 seconds, the time in queue for the first call will be 100, the second call 50. The same for idle time: if an agent has been idle for 2 minutes and another has been idle for 30 seconds, the idle time is expressed as 100 and 25, respectively.

- Priority \(\times\) IFactorP is the call priority (the value of the priority interaction property set in the voice application) multiplied by the priority importance value set in the interval.

**Note:** Criteria importance values set to 0 in a routing rule interval will not affect the weight calculation.

The higher the importance value of the criterion (compared with the other criteria in the interval), the less likely it is that criteria of lower importance will be considered. To achieve this result, it is recommended that importance values be set in powers of 100 (for example, 1, 100, 10000).

The use of powers of 100 in importance values for skills, for instance, means the most important skill group is of primary consideration, since the difference between the importance values is so great. However, if the difference between skill importance values is less, then the skills with lower importance values will also be considered.

In some cases, you may want the differential to be less, since some skills may offset other skill deficiencies. For example, in a given interval, language importance is set at 100, product importance is set to 300. That causes an agent with language skill level of 100 and product knowledge of 30 to be equal to an agent with language skills of 7 and product knowledge of 61 (using the weight equation: \((100 \times 100) + (300 \times 30)/100 + 300 = 47.5\) vs. \((100 \times 7) + (300 \times 61)/100 + 300 = 47.5\), assuming for this example that all other variables in the equation are 0).
Call Prioritization

You may want to create routing rules that give priority to certain calls in the queue, causing those calls to jump ahead of other calls in the queue. To achieve this, in the voice application, use the Set Interaction Property block to create an interaction property called Priority and assign the property a value between 0 and 100. For example, you might look up a customer’s SLA Priority using a Search block, and, based on the results, if the customer is Gold assign a Priority of 100, Silver assign a Priority of 50, and Bronze assign a priority of 1.

In the routing rules, give the Priority Importance setting a value of 100 and the Customer Time In Queue Importance setting a value of 1. This will reorder all calls by priority first and secondarily by time in queue.

Escalation Interval Time Frame

Each escalation interval is labeled with a time frame indicating where the interval occurs in the sequence. For example, typing 30 in the field to the right of the Last Interval - infinite text in the first interval results in a new label: Escalation Interval 1, ending at 30 seconds (from the time the call entered the queue), which indicates this interval is the first and ends after 30 seconds. Typing 45 in the field to the right of the Last Interval - infinite text for the second interval results in a new label: Escalation Interval 2, ending at 45 seconds (from the time the call entered the queue), which indicates the escalation interval begins after the first interval concludes, and ends 15 seconds after the first escalation concludes (total duration for the caller in queue is 45 seconds). Leaving the field at Last Interval - infinite -1 indicates the interval occurs at the end of the sequence and does not end until the caller hangs up.

At least one escalation interval must be defined. If the last escalation interval has a finite end time (that is, not -1, which designates an infinite end time), upon reaching the limit, the call will leave the queue with a No Matching Agents result code.

Skill-Based Routing: Common Approaches

If you decide to use skill-based routing, there are four possible scenarios you may want to consider:

- **Generic Skill-Based Routing** - Using skill groups to route calls by agent skill level and/or a service type.
- **Group-Based Routing** - Skill groups are created using agent group names as skills to enable you to route calls to the desired agent group.
- **Priority-Based Routing** - Using skill groups to represent customer type (or account type).
- **Specific Agent-Based Routing** - Routing to a specific agent.

Generic Skill-Based Routing

You can use skill groups to route calls by agent skill level and/or a service type (in this case, the skill in the skill group you create would be a service - refer to Services on page 90 for more information about services).

| Note: If you create a services skill group (such as the Service Type skill group in the table below), skills in that skill group must have the same names as the services created on the Services page (in the Management Portal, click Agents/Skills/Services>Services) so the skill group will double as a call’s Service folder designator for statistics, allowing you to report on calls routed by skill. |
• Skill groups with skills must be created first.

  Example:

<table>
<thead>
<tr>
<th>Skill Group</th>
<th>Skills</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>English, Spanish</td>
</tr>
<tr>
<td>Product</td>
<td>Microwave, Refrigerator</td>
</tr>
<tr>
<td>Service Type</td>
<td>Sales, Support</td>
</tr>
</tbody>
</table>

• Agents must be assigned skill values 0 to 100

• A voice application must be modified to select skills from skill groups. This is usually done by having Request Skill blocks on each of the Menu block branches, then accessing the Route to Agent block.

• In the Route to Agent block, routing rules must be specified by either selecting the routing rule you created on the Routing Rules page (in the Management Portal, click Agents/Skills/Services>Routing Rules) or by creating routing rules within the block. The importance level of the skills in the routing rule may diminish with each escalation interval. For example, you may create a rule with three intervals:

  » In the first interval, the system would look for the best possible agent match within the first 15 seconds, with agent skills assigned the highest level of importance.

  » Within the next 45 seconds, the second interval would be configured to find an agent with a less stringent skills match (maybe sacrificing product knowledge in favor of adequate language skills).

  » After the caller has waited 60 seconds (the total time of the first two intervals), the third interval would specify time in queue as the highest priority and the system would search for any available agent.

Group-Based Routing

For group-based routing, a skill group can be created, with agent group names as skills. For example, if you have created agent groups called Support Group and Sales Group, then create a skill group called Agent Groups containing the skills Support Group and Sales Group. Then set the skills for all support agents at: Support Group = 100 and Sales Group = 0, and for all sales agents at: Support Group = 0 and Sales Group = 100.

In the routing rules, the skill group Agent Groups must be used with the threshold set to 1. This enables you to limit the agents considered for a call to a specific group. To enhance this scheme, varying skill values could be used from 2 to 100 to denote how good a particular agent is within that group.

Priority-Based Routing

Using priority-based routing causes some calls to jump ahead of other calls in the queue. One way to achieve this is by creating a skill group using priority levels as skills.
For example, first you can create a skill group called **Customer Level** containing skills **Gold**, **Silver**, and **Bronze**. Agents are then assigned values of skills in order of importance; for example, Bronze = 30, Silver = 60, Gold = 90. Then, in the routing rules, put the skill group **Customer Level** above **Customer Time in Queue** by giving it a higher importance value. This will reorder all calls by priority first and secondarily by time in queue. To enhance this scheme, skills values can vary from agent to agent, so comparisons can easily be made within the context of the varying customer levels. For example, you may set skill levels per customer type = Bronze 1-30, Silver 31-60, Gold 61-90. If John is good at handling Bronze-level callers and Peter is good with Gold-level callers, then John’s Bronze skill will be set to a value greater than Peter’s Bronze skill and John’s Gold skill value will be set lower than Peter’s Gold skill.

### Specific Agent-Based Routing

Occasionally, you may have a need to route calls to a specific agent (for instance to a specific account owner or to the supervisor handling escalation of difficult calls), rather than to a group of agents with varying skill levels. To achieve this, in the voice application, the interaction property **AssignedAgentID** must be set to that agent’s login name before sending a call into queue (this can be done using the Set Interaction Property block, followed by a Route to Agent block to enable the system to enact a conditional exit, should the agent be unavailable). In this case, all routing rules are ignored and the call waits for that specific agent.

**Note:** In the voice application, you may want to create a contingency in the event the specific agent is not available to take the call. To achieve this, use the Custom JavaScript Code block to remove the **AssignedAgentID** property from consideration: `objAppCtx.Config.Item("Interaction").Attributes.Delete("AssignedAgentID"); Follow this block with another Route to Agent block containing the routing rule needed to get the call to an appropriate agent. Or, you can just send the call to the agent’s voice mail using the Connect Call block.

### Create and Configure Routing Rules

The following procedure contains examples for routing rule configuration. The Application Builder Demonstration 2 also contains an example of configuring a routing rule (within the Route to Agent block); refer to the online help topic "Voice Application Design: Application Builder Demonstrations" to view the tutorial.

**To Create and Configure a Routing Rule:**

1. In the Management Portal, click **Agents/Skills/Services>Routing Rules**. On the **Routing Rules** page, type the name of the routing rule in the empty field at the bottom of the table. There are no naming restrictions.

2. Click the **Add** button. The screen refreshes and the routing rule appears in the table.

3. To configure the routing rule, click the link in the **Rule Name** column. The **Routing Rules** properties page opens.
4 In the **Rule Name** field, you can replace the existing name with a new name for the routing rule, if needed. The new text you enter is red. Click the **Update** button next to the field - the text turns black.

**CAUTION:** If you change the routing rule name after the rule has been created and included in a voice application, the name change does not change the name of the routing rule in the voice applications that use the rule. Therefore, if you change the name of a routing rule, modify all voice applications using that routing rule to reflect the name change.

5 Click the **New interval** button. A default set of criteria for the interval displays: **Customer Time in Queue**, **Agent Idle Time**, and **Priority**.

6 Change the **Importance** value for the **Customer Time in Queue**, **Agent Idle Time**, and **Priority** to establish the desired importance (the criterion with the highest Importance value will be at the top of the list after the **Update** button is clicked). For example, if, for this interval, Agent Idle Time is most important, give it the highest importance rating.

7 Click the **Update** button (either the one just above the interval or the one at the bottom of the page).
To add a skill requirement to the interval, click the **Add Skill Requirement** button. The **New skill requirement** dialog box opens.

9 Select a **Skill Group**.

10 Select a **Default Skill**.

11 In the **Threshold** text box, type a skill value the system will search for when matching an agent to a call. For example, if you type **80**, the matcher will look for an agent with a skill level of 80 or above for the specified skill.

The **Threshold** value is the minimum skill level an agent must have to be considered for call distribution. In order to receive the call, the agent’s skill value for this skill must equal or exceed all thresholds specified for the interval.

12 In the **Importance** text box, type a value.

13 Click **Add**. The skill requirement values are now part of the criteria for this interval. The criteria for the interval are listed in the order of importance, the highest at the top of the list.

14 Repeat steps 5 through 13 to create additional intervals for this routing rule, if needed.

- If you create multiple intervals for the routing rule, you will need to use the interval field at the top of each interval to establish the time frame for the progression of intervals.

**Example:** The first interval created specifies skills as the most important criteria and have a time frame ending at **30** seconds; during that 30 seconds the system will route the call to the first available agent with a skills match. After 30 seconds, the second interval, which specifies agent idle time as the criteria of highest importance and has a time frame ending at **50** seconds, will activate; during that 20 second interval, the system will route the call to the agent who has been idle the longest. After 50 seconds, you may simply want the call answered, so the third interval would have time in queue as the highest importance rating; the system will route the call to the next available agent regardless of skills or idle time. If it is also the last interval of the rule, the interval field would remain at the default: **Last Interval - infinite = -1**.

15 Once all intervals for the rule have been created and the interval time frames specified, click the **Update** button at the bottom of the page, then click the **Commit Changes** button. This configuration takes effect immediately.
Delete Routing Rules

Deleting a routing rule prevents you from using the routing rule in future voice applications; however, the deletion *does not* remove the routing rule from the voice applications that currently use it.

1. On the **Routing Rules** page (in the Management Portal, click **Agents/Skills/Services>Routing Rules**), click the red x icon next to the routing rule you want to delete. A confirmation dialog box opens.

2. Click **OK**. The screen refreshes and the routing rule is deleted.

3. Click the **Commit Changes** button to apply the change.

Services

A service is a label you create to categorize interactions for statistical, routing, and monitoring purposes. For example, you might have a customer call for purchase inquiries or to offer feedback. If you create a service for each of these categories, you can track how many purchase inquiries you receive, or view a list of calls waiting in a queue to offer feedback.

IPCM determines whether or not to affix a service label to an interaction while the interaction is in the voice application. The voice application uses the Set Service block to associate the interaction with a service, according to criteria you establish. For example, you can design a voice application that sets the service if the interaction originates from a telephone number with a certain prefix, or if the caller inputs a certain code.

Queued Calls Limit Option

Use the **Queued calls limit** field on the **Services** page to set the maximum number of calls IPCM allows in the queue for a particular service at one time. For example, if you set the value in the **Queued calls limit** column for **Customer Service** to **85**, the maximum number of calls that can be in the queue for **Customer Service** is **85**.

**Note:** The **Service Queue Limit Exceeded** conditional exit in the **Route to Agent block** in Application builder determines where IPCM routes a call intended for a queue that has reached its call limit. Refer to the online help topic "Voice Application Design: Building Block Definitions: Route to Agent Block" for more information.
Create Services

► To Create a Service:

1 On the Services page (in the Management Portal, click Agents/Skills/Services>Services), type a name for the service in the empty field at the bottom of the page.

   Note: Once you create a service, you cannot change the service name.

2 In the Queued calls limit field, enter the maximum number of calls IPCM will allow in the queue for this service. If you do not want the system to limit the number of possible calls in the queue, enter -1 or leave the field blank.

3 Click the Add button. The service is added to the table.

4 Click the Update and Commit Changes buttons to apply the change.

Delete Services

Deleting a service makes the service unavailable for use in future queue monitor configurations and voice application designs; however, deleting a service does not remove the service from existing configurations and designs.

► To Delete a Service:

1 Click the red x icon at the end of the row. A confirmation dialog box opens.

2 Click OK. The screen refreshes and the service is removed from the list.

3 Click the Update and Commit Changes buttons to apply the change.

Queues

A queue is a list of calls with one or more properties in common. Some examples of queues include:

- A list of all calls IPCM routes to a specific agent.
- A list of all calls for a specific service.
- A list of all calls that are part of a particular integration.

You can also base queues on logical categories that mirror your routing rules and skill sets. For example, if you base your routing rules on languages and technical skills, you might have the following queues:

- English
- Spanish
- Hardware
- Software
Queues can have one or more subqueues, which are queues within a queue. Subqueues let users further classify calls within a queue; for instance, by department, product, geographical area, etc.

The Call Center server has queue position protection, which prevents a call from losing its place in a queue. For example, if a call waits in a queue for 45 seconds and the server tries to deliver the call to an agent but fails for some reason (in this example, the agent does not pick up the phone within 30 seconds), the server returns the call to the queue without resetting the call’s Time In Queue call property to 0. Instead, the server increments the Time In Queue property from 45 seconds.

**Note:** Queue position protection primarily affects routing rules and estimated wait time calculations.

The Agent Dashboard *Queue* tab displays queues and the data for calls within each queue. The type of call data the Agent Dashboard displays depends on the queue configuration. For example, one queue might display the ANI (Automatic Number Identification) and DNIS (Dialed Number Identification Service) of calls while another queue displays the ServiceType and TimeInQueue properties of calls.

**Note:** For information on the Agent Dashboard *Queue* tab, refer to the Agent Dashboard User’s Guide.

The *Filters* tab on the *Queue Monitor Settings* page (Management Portal>System Configuration>Contact Center Server>Queue Monitor Settings) lets you manage queues:

- Create and delete queues.
- Configure which calls and call data are displayed in a queue.
- Configure the text and background colors the Agent Dashboard displays on the *Queue* tab for specific conditions.
- Configure the sounds the Agent Dashboard plays for specific conditions.

### Create and Delete Queues

The *Queue Monitor Settings* page lists the names of existing queues. Subqueues appear as indented links beneath parent queues.

Depending on options selected during installation, IPCM comes with as many as five default queues:

- **My Personal Queue** - Displays data about all calls assigned to the agent logged into the Agent Dashboard.
- **All Queued Interactions** - Displays data about all calls waiting in all queues.
- **ISM Demo Queue** - Displays data about calls that are part of the ISM configuration demo voice application included with IPCM.
- **ITSM Demo Queue** - Displays data about calls that are part of the Information Technology Service Management (ITSM) configuration demo voice application included with IPCM.
- **GoldMine Demo Queue** - Displays data about calls that are part of the GoldMine configuration demo voice application included with IPCM.

**Note:** IPCM does not have default subqueues.

You can modify or delete predefined queues, and create new queues according to your business needs.
To Create a Queue:

1. On the Filters tab of the Queue Monitor Settings page (in the Management Portal, click System Configuration> Contact Center Server> Queue Monitor Settings), type a name for the queue in the Filter Name field. The queue name has no restrictions.

2. In the Parent drop-down list:
   - If you are creating a subqueue, select the queue you want designate as the parent queue.
   - If you are not creating a subqueue, select Top.

3. Click the Add button.

4. Click the Commit Changes button to save your changes.

To Delete a Queue:

1. Select the radio button next to the queue you want to delete.

2. Click the Remove button. A confirmation dialog box opens.

3. Click OK. The screen refreshes and the queue is deleted.

4. Click the Commit Changes button to apply the change.

Note: Deleting a parent queue also deletes its subqueues.
Queue Configuration

Each queue has its own **Queue** properties page containing configuration settings. To open the **Queue** properties page, click the name of the queue in the list on the **Queue Monitor Settings** page.

There are five components of queue configuration:

- **Language** - If you have Agent Dashboards running on a non-English version of Windows and want to localize the Queue pages, use the **Language** field to select the language. You may define the queue **Title** and **Column Titles** for every language configured in IPCM.

  The **Neutral** setting is used when an Agent Dashboard user is running a Windows version in a language you have not chosen to support in IPCM. With the language field set to **Neutral**, specify the queue **Title** and **Column Titles** to be displayed in such a case.

- **Title** - The text in the Title field is the name of the queue that will display in the Agent Dashboard. There are no naming restrictions. For convenience, the browse button opens a Localization dialog box which displays the queue name for all languages configured in IPCM.

- **Filter Conditions** - Use the **Filter Conditions** table to specify the requirements a call must meet for IPCM to put the call in the queue. Each row of the **Filter Conditions** table represents one requirement. The call must meet all the requirements in the **Filter Conditions** table for IPCM to put the call in the queue.

- **Columns** - Use the **Columns** table to configure which call data the Agent Dashboard displays in the columns of the **Queue** tab (when the user selects the queue), and how the Agent Dashboard formats the data. Each row of the **Columns** table configures one column on the **Queue** tab.
The Agent Dashboard **Queue** tab displays the columns you configure in the order they appear in the **Columns** table (i.e., the columns in the Agent Dashboard display in order from left to right).

- **Conditional Formatting** - The conditional formatting of the queue specifies the fonts and colors the Agent Dashboard **Queue** tab uses when displaying calls in the queue, as well as the sound the Agent Dashboard plays when a call arrives in the queue. For example, you can configure the **Queue** tab to use red text with a yellow background when displaying calls waiting in the queue for more than 30 seconds. You can also configure the Agent Dashboard to play an alarm for this condition.

Use the **Conditional Formatting** table to configure the conditional formatting of the queue. The table displays conditions as rows with adjacent radio buttons. Within the row are parameters that control the formatting and alarms the condition uses, as well as the criteria the call must meet for IPCM to apply the formatting and alarms.

► **To Configure a Queue:**

1. On the **Queue Monitor Settings** page (in the Management Portal, click **System Configuration>**Contact Center Server>**Queue Monitor Settings**), click the queue name. The queue properties page opens (on the **Filters** tab).

2. In the **Language** field, select the language for which you want to specify the queue **Title** and **Column Titles**. Click the **Set** button.

3. In the **Title** field, type the queue name that will display in the Agent Dashboard. Click the **Update** button next to the **Title** field.

   **Note:** For convenience, the browse button opens a **Localization** dialog box which displays the queue **Title** for all languages configured in IPCM.

4. Configure the **Filter Conditions** settings:

   a) In the **Property** field, specify the call property(s) a call must have in order for IPCM to place the call in this queue. You can either type the name of the call property in the **Property** field, or click the browse button next to the **Property** field to select the call property from the **Properties** dialog box.

   b) In the **Type of match** field drop-down list, select one of the following:
» **attribute-match** - IPCM checks each call for the call property you specified in the **Property** field. If the call has that property, IPCM checks the value of that property. If the value of the call property matches the value you specify in the **Value** field (refer to step 4c), IPCM classifies the call as meeting the requirement.

» **self-match** - IPCM checks each call for the call property you specified in the **Property** field. If the call has that property, IPCM classifies the call as meeting the requirement. IPCM does not check the value of the call property for **self-match** requirements.

c) If you selected the **attribute-match** option, you need to set a **Condition type** and **Value**:

   **Example**: If you enter the **ANI** call property in the **Property** field, the **attribute-match** option in the **Type of match** field, and a value of 415-222-1212 in the **Value** field, IPCM places all calls from phone number 415-222-1212 in this queue. If you enter the **ANI** call property in the **Property** field and the **self-match** option in the **Type of match** field, IPCM places all calls with the **ANI** call property in this queue, but does not check the value of the call property.

   » If you select **Equal** in the **Condition type** drop-down list, in the **Value** field enter the value the property must have in order for IPCM to place the call in this queue.

   » If you select **Not Equal** in the **Condition type** drop-down list, in the **Value** field enter the value the property must not have in order for IPCM to place the call in this queue.

   **Note**: The **Value** fields activate only if you select the **Attribute-match** option in the **Type of Match** field.

d) Click the **Add** button at the end of the row. IPCM adds the row to the **Filter Conditions** table.

e) When all filter conditions have been added, click the **Update** button for the **Filter Conditions** section.

   **Note**: To delete a filter condition, click the red x icon at the end of the row.

5. Configure the **Columns** settings. Each row in the **Columns** table represents a column that will display in the **Agent Dashboard**.

   **IMPORTANT**: For the queue to operate correctly, you must configure a column for each call property you are using in the **Filter Conditions** section.
Configure the following settings for each **Column**:

**a)** In the **Property** field, enter the call property containing the data you want IPCM to display in this column on the **Queue** tab. Either type the name of the call property in the **Property** field, or click the browse button to the right of the field to select the call property from the **Properties** dialog box.

**b)** In the **Column Title** field, type the heading you want the Agent Dashboard to display at the top of the column on the **Queue** tab. If you do not specify a column title, the **Property** name will be used. The **Column Title** is localizable and should be defined for every language you want to support.

*Note: For convenience, the browse button to the right of the field opens a Localization dialog box which displays the queue Column Title for all languages configured in IPCM.*

c) In the **Column Refresh** field, select the rate at which you want the Agent Dashboard to refresh the data in the column:

» **No refresh** - Select this option for columns containing data that does not need to be refreshed.

» **Auto-duration** - The column data refreshes approximately once every second.

» **New timer** - The column data refreshes at a rate you specify. If you select this option, in the field next to the **Column Refresh** drop-down list, enter the number of seconds you want IPCM to wait between refreshing the data.

» **3 sec** - The column data refreshes every three seconds.

**IMPORTANT:** The **Auto-duration** setting uses a clock within the client application; the **New timer** and **3 sec** settings use clocks within the IPCM server. To avoid network congestion, Ivanti recommends using the **Auto-duration** setting whenever possible.

d) In the **Column Type** field, select the type of values the column displays. Select **String** if the values are in alphanumeric format, or **Number** if the values are in a numeric format.

e) In the **Format as** field, indicate the format in which you want IPCM to render the data in the **Queue** tab:

» **Not formatted** - IPCM does not format the data.

» **Number** - IPCM formats the data as an integer.

» **HEX** - IPCM formats the data in hexadecimal format.

» **Duration** - IPCM formats the data as a duration.

f) In the **Format Prefix** field, specify data (such as an area code) for IPCM to prefix to the value.

*Note: This field is inactive if you select the Not formatted option in the Format as field.*
Organizing the Contact Center

**g)** Click the **Add** button at the end of the row. IPCM adds the row to the **Columns** table.

**h)** To change the order in which the columns appear in the **Queue** tab, select the radio button next to the column you want to move, then click the **Up** or **Down** button to position the column in the order you want it to appear on the Agent Dashboard **Queue** tab.

**i)** When all filter conditions have been added and are in the desired order, click the **Update** button for the **Columns** section.

*Note: To delete a column, click the red x icon at the end of the row.*

6. Configure the **Conditional Formatting** settings:

![Conditional Formatting](image)

**a)** To configure the formatting the **Queue** tab uses for this condition, select the desired **Text color** and **Background color**.

**b)** To configure the alarm the Agent Dashboard sounds when it receives a call that meets the condition, select the alarm in the **Alarm Name** drop-down list (refer to **Alarms on page 99** for information on populating the **Alarm Name** drop-down list).

**c)** Click the **Update** button for the **Conditional Formatting** section before continuing with the next step.

**d)** To set the conditions the call must meet for the Agent Dashboard to use the formatting and alarm functionality, use the following fields to create logical expressions within each condition:

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Type</th>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater</td>
<td>Auto-duration</td>
<td>TimeInQueue</td>
<td>30</td>
</tr>
</tbody>
</table>

**Example:** For example, to configure the Agent Dashboard to apply the conditional formatting to a call waiting in the queue for more than 30 seconds, configure: **Trigger** = **Greater**, **Type** = **Auto-duration**, **Attribute** = **TimeInQueue**, **Value** = 30.

» **Trigger** - The operator used to compare the values of the call attribute with the value in the **Attribute** field. Select one of the following: **If greater**, **If less**, or **If equal**.

» **Type** - The type of values the logical expressions uses:
  - **String** for alphanumeric values
  - **Integer** for numeric values
  - **Auto-duration** for auto-duration values

» **Attribute** - Type an attribute to use in the logical expression or click the browse button to the right of the field to select an attribute from the **Properties** dialog box.

» **Value** - Specify the value of the attribute in the logical expression.
e) Click the **Add** button to add a new logical expression to the table.

   **Note:** *Click the red x next to the logical expression name if you need to delete it.*

f) To add another condition to the table, click the **New Condition** button and repeat steps a through d.

g) To change the order of the conditions, select the radio button next to the condition you want to move, then click the **Up** or **Down** button to position the condition in the desired order. The order of the conditions establishes the condition priority. Only the first satisfied condition formats the way the interaction appears in the queue, and triggers an audible alarm if configured to do so. The higher you move a condition in the table, the greater priority the condition has over the other conditions.

h) When all **Conditional Formatting** settings have been configured, click **Update**.

   **Note:** *To delete a condition, click the red x in the row containing the condition name.*

7. Click the **Commit Changes** button to apply all settings configured for this queue.

### Alarms

You can customize the sound the Agent Dashboard plays when a call in the queue meets the conditional formatting you configure.

> **To Add a Custom Alarm:**

1. Use a third-party audio editor to create a `.wav` file that contains the alarm.
2. On the server computer, copy the `.wav` file(s) into the `FrontRange Solutions\IP Communications Management\Data\Alarms` directory.
3. On the Management Portal **Queue Monitor Settings** page, click the **Alarms** tab. The **Alarms** page opens, displaying a table listing the current custom alarms.

![Alarms Table](image)

4. To enable alarms, click the **Yes** radio button.

5. In the **Sound Name** field, you will see a list of `.wav` files you placed in the `FrontRange Solutions\IP Communications Management\Data\Alarms` directory. Select a file name from the list.

6. In the **Description** field, type a description of the sound (optional).

7. Click **Add**, then click **Update** and **Commit Changes**.

The alarms you add on the **Alarms** page appear as options in the **Alarm Name** drop-down list in the **Conditional Formatting** section of the **Queue** properties page for a queue.

The Agent Dashboard has a default alarm that plays if the alarm you specify in the **Alarm Name** drop-down list is missing (for example, it may have been deleted accidentally).
Preparing for Incoming Calls

Voice applications implement call processing scenarios specific to your business needs. IPCM provides multiple voice applications used to implement various call processing scenarios.

In addition, IPCM has a development tool called Application Builder that enables you to create new voice applications and edit existing applications.

After creating a voice application, you will use the Applications Selector to configure how and when IPCM uses the application.

Voice Application Support

Voice applications are telephony applications that answer calls and automate interactions with callers. IPCM uses multiple voice applications, each dictating a different call processing scenario that can include:

- Caller identification and authentication - The voice application can connect to customer information stored in a database and use the data to verify the caller's identity. The voice application can also display the data to the contact center agent who receives the call, which saves time since the agents does not have to collect the information from the caller.

- Prompts - Communicate automatically with callers using audio prompts generated either by recorded audio files or a text-to-speech (TTS) engine. Use prompts to greet callers, convey menu options, request data, play hold music, etc. If your contact center receives calls from speakers of foreign languages, configure IPCM to dynamically play prompts in multiple languages.

- Data collection - Callers can input data into the voice application either by pressing numbers on a phone keypad or by speaking, if you have an integrated Automatic Speech Recognition (ASR) application. The voice application attaches this data to the call by setting call properties.

- Call routing - Call processing scenarios end with the voice application routing the call to a destination, which is usually an agent’s phone or voice mailbox. The voice application routes the call according to routing rules, which are conditional instructions that determine the destination of a call. Refer to Routing Rules on page 81 for details. You can configure the voice application to route a call to:
  - The agent who is most qualified to handle the call.
  - The agent who has not taken a call for the longest period.
  - The first available agent.

- Messaging - Callers can use the voice application to send voice mail and email to IPCM users.
Preparring for Incoming Calls

Application Builder

The Application Builder is a development tool that lets you create multilingual voice applications by connecting and configuring blocks of code called building blocks (also referred to as "blocks").

Note: The IPCM online help contains tutorials that demonstrate how to build a voice application. Refer to the online help topic “Voice Application Design: Application Builder: Application Builder Demonstrations” to view the tutorials.

Applications Page

To open Application Builder click Start>Programs>FrontRange Solutions>Communications Management>Management Portal>Application Builder.

The applications page opens, displaying two columns:

- **Available Applications** - A list of applications available on this IPCM server.
- **Open Applications** - All applications currently open in the Application Builder. When you open an application, the application remains open until you close it. If you close the browser with the application still open, Application Builder closes the open application 20 minutes after you close the internet browser.

Use the applications page to:

- **Open an Application**. When you open an application, IPCM removes it from the list of applications in the Available Applications column.
- **Delete an application**.
- **Close an application**. When you close an open application, IPCM again displays the application in the Available Applications column.
- **Create a New Application**.

Note: IPCM ships with Common Data Speakers and Unified Messaging prompts in English (both US and UK). A Localization kit is available to enable you to expand your IPCM deployment to include other languages.
Application Building Blocks

Application Builder has a graphical user interface you use to connect blocks to build your voice application. This is done within a flowchart that represents the sequence of call processing events in the call scenario. Different types of blocks perform different functions, such as recording voice messages, playing prompts, collecting input, etc.

Blocks are listed on two tabs: System and Telephony and Routing. If you choose to install integration options, you will also see the Integration tab and blocks.

For a complete list of blocks with block descriptions and configuration information, refer to the online help topic "Voice Application Design: Building Block Definitions."

Each block has its own configuration parameters, which appear in the edit pane when the block is added to the flowchart, or selected within the flowchart. The parameters specify, for example, which prompts to play, where to send voice mail, etc.
Create a New Application

The following procedure describes how to create a new voice application. Additional topics which explain in greater detail important aspects of creating a voice application include:

- Working in the Application Flowchart
- Adding blocks to Conditional Exits
- Working with Prompts
- Best practices for creating voice applications (Best Practices: Voice Applications)

牢固

To Create a New Application:

1. On the applications page, click the New icon above the list of applications. The new application opens. Notice that the flowchart is currently empty.
2. Click a tab in the edit pane to display the desired list of blocks.
3. Click a block icon. The block is added to the flowchart with the parameters displayed in the edit pane.
4. Configure the parameters for the block.
5. To add the next block to the flowchart, click the Add icon in the toolbar above the flowchart. The blocks are again displayed in the edit pane.
6. Click a block icon. The new block is added below the selected block in the flowchart.
7. Continue to add the blocks needed to complete the call flow.
8. When all blocks have been added and configured click the Save As button above the edit pane.
9. In the Save application as dialog box, type the name for the new application, then click Save as.
10. Click the Close Application button. Your new application appears in the list on the applications page.

Open an Application

On the applications page, open an application by clicking the Open button next to the desired application. The left side displays the application flowchart, which depicts the flow of operation for the application. Labeled icons in the flowchart display the blocks comprising the application. The right side of the builder page features the edit pane, which displays editable fields of the block selected in the flowchart.

Working in the Application Flowchart

In the application flowchart, you can:

- Expand and collapse the branches in the flowchart by clicking the plus and minus signs.
- View and edit the properties of a block by selecting the block in the flowchart. The edit pane displays the editable properties of the selected block.
- Edit the flowchart by selecting a block and using the toolbar above the flowchart:
» **Add** - Displays all blocks in the edit pane. Select a block from the edit pane and the block is inserted into the flowchart below the currently selected block in the flowchart.

» **Remove** - Removes the selected block from the flowchart.

» **Cut** - Removes the selected block from the flowchart and places it on the clipboard.

» **Copy** - Copies the selected block to the clipboard.

» **Paste** - Inserts the clipboard contents below the selected block.

» **Clipboard** - Located above the toolbar; displays the last block you copied or cut.

» **Applications** - Located above the toolbar; returns you to the applications page, displaying the list of applications.

» **Prompt Manager** - Located above the toolbar; opens the **Prompt Manager** dialog box. Refer to **Prompts on page 106** for details.

» **History** - Located above the toolbar; enables you to retrieve an unsaved version of the open application. If the Management Portal session times out (after 20 minutes with no activity), the unsaved application is retrievable by clicking the **History** link and selecting the version in the **Autosaved versions** dialog box. You can then save your application by clicking **Update** and **Commit Changes**.

- **Find text.** When working in a complex application, it may be helpful to search for specific text within the flowchart:
  - Click anywhere in the flowchart, press Ctrl+F to open a **Find** dialog box, type the text you want to search for, then click **Next**.

As you make changes to the flowchart and edit pane, the Application Builder displays one or more the following buttons above the edit pane:

- **Commit Changes** - Saves changes to the application. Click the appropriate **Update** button (there may be several on the edit pane) before clicking the **Commit Changes** button.

- **Discard Changes** - Discards the changes you made since last clicking the **Commit Changes** button.

- **Save As** - Saves the application under the specified name. You can also use this button to save a version of an existing application; this is helpful if you want to use the existing application as a basis for creating a new application.

► **To Add a Block to the Beginning of the Application Flowchart:**

The Application Builder adds new blocks **below** the selected block in the flowchart, but it is possible to add a block at the beginning of the flowchart, **above** existing blocks.

1. Select the first block in the flowchart.
2. Click the **Add** icon in the toolbar above the flowchart.
3. In the edit pane, click the block you want to add to the beginning of the flowchart. The block appears in the flowchart beneath the first block.
4. Select the first block in the flowchart.
5. Click the **Cut** icon. The block is removed from the flowchart and copied to the clipboard. The block you added previously is now the first block, and is also the selected block.
6. Click the **Paste** icon. The block you cut is placed in the flowchart as the second block.
Conditional Exits

The voice application typically processes blocks sequentially; however, some blocks have multiple paths the voice application can take after processing the block. These paths are called conditional exits. Conditional exits enable you to determine how the voice application responds to certain conditions that may occur during the processing of a call, such as a database not opening when needed or an agent not responding to a call.

Each conditional exit appears in the flowchart as green text beneath the block to which it applies. A conditional exit may contain a flow of blocks to handle specific situations.

► To Add Blocks to a Conditional Exit:

1. In the flowchart, select the conditional exit. The edit pane displays the available blocks.
2. In the edit pane, click to select the block that will start the flow initiated by the conditional exit. The block appears below the conditional exit in the flowchart.
3. Configure the block parameters.
4. Add more blocks as needed.
5. Click the Commit Changes button.

Prompts

Many blocks use voice prompts to request input from callers, inform callers about events, or play music while callers are waiting for an agent. These prompts can be either pre-recorded audio files or static prompts that IPCM generates using Text-to-Speech (TTS) functionality from textual prompt descriptions.

Note: Ivanti recommends using TTS prompts during voice application development to focus on application functionality (rather than constant prompt recording and editing), and replacing the TTS prompts with prerecorded prompts once development is complete. For more information on TTS applications, refer to Text-to-Speech (TTS) Voice Specification on page 122.

The Prompt Manager dialog box in Application Builder (click the Prompt Manager link above the flowchart in an open application) lists all prompts the open voice application uses, and lets you set the languages in which the voice application can play prompts.

Languages

In the Prompt Manager dialog box, on the Languages tab, the Languages in use table lists the languages the voice application supports (i.e., every language in which the voice application can generate or play prompts).

The start-up language for an application is defined in the Default Language field. This is also the language used to display prompt contents in blocks, if the translation for that prompt exists in the application (if not, the prompt Description field will not display content). During run time, the language can be changed using the Set Prompt Language block (refer to the online help topic “Voice Application Design: Building Block Definitions: Set Prompt Language Block”). For example, if the Set Prompt Language block sets the voice application language to German, the voice application automatically plays the version of the prompt configured for German in the Prompt Manager dialog box.
IMPORTANT: To enable IPCM to generate prompts in a different language, install a TTS engine for that language. Note that a TTS engine is a third party software product; IPCM does not supply any TTS engines.

Languages can be added to the Languages in use table.

► To Add a Language to the List:

1. In the Prompt Manager dialog box, on the Languages tab, select the language in the drop-down list below the Languages in use table.

2. Click the Add button.

► To Remove a Language from the List:

- Click the red x icon to the right of the language.

Add Prompts

On the Prompts tab of the Prompt Manager dialog box, all prompts the voice application blocks can use are listed within a table. The left side lists the prompt language and the right side displays the prompt content. You can use the Prompt Manager to add and edit prompts.

► To Add a Prompt to an Application or Edit a Prompt:

1. Click the Prompt Manager link above the flowchart in an open application. The Prompt Manager dialog box opens.
Preparing for Incoming Calls

2 On the Prompts tab, type a name for the prompt in the Prompt name field (at the bottom).

3 Click the Add button. An new prompt appears in the table.

4 To configure what the prompt will play, click the prompt link. The Prompt Editor dialog box opens.

5 The Prompt Editor dialog box lists all languages from the Prompt Manager Languages tab (refer to Languages on page 106), enabling you to configure a version of the prompt in every language the voice application supports. Click the Add Voice Segment link to the right of the language.
6 In the drop-down list of the first field in the row, select the prompt segment type you want to configure (refer to Prompt Segment Types and Descriptions on page 110 for details of each option). The screen refreshes to display fields relevant to the selected prompt segment.

![Prompt Editor](image)

7 Complete the fields for the prompt segment.
- Ivanti recommends using Voice segment types for most prompts.
- If you selected a Voice prompt segment, you can upload a .wav file for this segment by clicking the yellow folder icon that appears (this icon will only appear for Voice prompt segment types). After the file has been uploaded, a Play voice file icon will appear: click the icon to listen to the voice file.
- If needed, click the green + icon to add more prompt segments for the language.
- To delete a prompt segment, click the red x icon.

8 Repeat steps 5 through 7 to configure the prompt segments for each language for the prompt.

9 Click the Update button to apply the changes.

10 Click the Back button. The content of the prompt is displayed below the prompt name in the table. This prompt can now be used in blocks in the open application.

►To Delete a Prompt from the List:
- Click the red x icon to the right of the prompt name.

►To Edit an Existing Prompt:
- Click the prompt link, which opens the Prompt Editor dialog box, then make the necessary changes.
Prompt Segment Types and Descriptions

Each row of the Prompt Editor dialog box contains fields pertaining to prompt segments, which determine what the prompt plays for a particular language. The values of the prompt segment fields consist of static values and variables (such as interaction properties). There may be more than one prompt segment per language. When processing the prompt, the voice application reads the prompt segments in the order in which they are listed beneath each language, either by playing pre-recorded audio files or using the Common Data Speaker (CDS) functionality to read variables and the Text to Speech (TTS) functionality to read text.

**Note:** The CDS functionality cannot play ordinals with more than ten digits or numbers with more than fifteen digits.

The following table describes each prompt segment type and its corresponding fields.

**Note:** Ivanti recommends using Voice segment types for most prompts.

<table>
<thead>
<tr>
<th>Prompt Segment Types</th>
<th>Descriptions and Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice</td>
<td>A static voice prompt file. If the file does not exist, it is rendered automatically from text in the Content field, using an installed TTS engine for the language. To upload a .wav file for this segment, click the yellow folder icon (this icon only appears for Voice prompt segment types). After the file has been uploaded, a Play voice file icon appears: click the icon to listen to the voice file.</td>
</tr>
</tbody>
</table>
| Number               | A number read by the CDS. This option has the following fields:  
  • **Property** - The name of the interaction property containing the number.  
  • **Precision** - The number of digits following the decimal point to be read by the CDS. The IPCM server rounds the number to the specified decimal place before playing. For example, 22.63 with a Precision value of 0 will be rounded to 23; 22.67 with a Precision value of 1 will be rounded to 22.7.  
  • **Gender/Category** - Language-specific options (this field is not available for all languages). |
| Ordinal              | An ordinal (position in a numbered series) read by the CDS. This option has the following fields:  
  • **Property** - The name of the interaction property containing the ordinal.  
  • **Gender/Category** - Language-specific options (this field is not available for all languages). |
| Currency             | A monetary value with currency type read by the CDS.  
  • **Property** - The name of the interaction property containing the monetary value.  
  • **Currency** - The type of currency. |
<table>
<thead>
<tr>
<th>Prompt Segment Types</th>
<th>Descriptions and Fields</th>
</tr>
</thead>
</table>
| **Date**             | A calendar date read by the CDS.  
• **Property** - The name of the interaction property containing the date.  
• **Format** - The format of the date (optional); the default is `%A%d%B%Y`. May contain the following elements:  
  - `%A` - Weekday name  
  - `%B` - Month name (00-11)  
  - `%d` - Day of month as decimal number (01 - 31)  
  - `%H` - Hour in 24-hour format (00 - 23)  
  - `%M` - Minute as decimal number (00 - 59)  
  - `%S` - Second as decimal number (00 - 59)  
  - `%y` - Year without century, as decimal number (00 - 99)  
  - `%Y` - Year with century, as decimal number  
Entries are case-sensitive. |
| **Time**             | A timestamp read by the CDS.  
• **Property** - The name of the interaction property containing the timestamp.  
• **Format** - The format of the timestamp (optional); the default is `%H%M%S`.  
Entries are case-sensitive. |
| **Phone**            | A telephone number read by the CDS.  
• **Property** - The name of the interaction property containing the phone number. |
| **Characters**       | A string read by the CDS, character-by-character (spelled out).  
• **Property** - Enter the name of the interaction property containing the string to spell.  
• **Case sensitive** - Use this option to differentiate between upper-case and lower-case letters; if you select Yes, **Uppercase** will be stated for uppercase letters (lower case letters are indicated by the absence of the word **Uppercase**); if you select No, no differentiation will be stated.  
• **Use phonetic** - Use this option to enable English phonetic spelling (also known as the NATO phonetic alphabet) where words are utilized to represent the letters of the alphabet (such as **alpha** for **a**, **bravo** for **b**, etc.). |
| **Text**             | Text dynamically read by a TTS engine.  
• **Property** - Enter the name of the interaction property containing the text to be read. |
| **Local Voice File** | The location of a prerecorded audio file the voice application plays, for prompts that can be re-recorded by using the Record File block, or modified by another application.  
• **File path** - The location of the folder containing the audio file. |
Select a Prompt

Blocks may use multiple prompts. For example, the Route to Agent block uses one prompt to play hold music, a second prompt to play a reminder message that repeats at specific intervals, and a third prompt that announces the estimated time it will take for an agent to answer the call.

If a block uses prompts, the edit pane for that block displays a Prompts table that lists all prompts for the block. The Prompts table contains the following columns:

- **Name** - The name reflects the purpose of the prompt. For example, the Route to Agent block uses the Music Prompt for hold music, the Reminder Prompt for the reminder message, and the Estimated Wait Time Prompt for the estimated time it will take an agent to answer the call. The prompt name cannot be changed.

- **File** - The actual prompt the block uses. This is the name typed in the Prompt name field when it was added to the application and can be changed when editing the prompt. If a prompt has not yet been selected, empty brackets are displayed in the File field.

- **Description** - A read-only display of the prompt content (this is the message the prompt will play).

From the Prompts table, you can open the Prompt Browser dialog box to select the prompt IPCM plays for each purpose.

► To Select a Prompt for Use in an Application:

1. In the edit pane of the block containing the prompt, click the link in the Name column of the Prompts table. For example, if you want to configure the hold music for the Route to Agent block, click the Music Prompt link. The Prompt Browser dialog box opens.

2. In the Prompt Browser dialog box, click the green + icon next to the prompt you want to use.
• If no prompts are listed, then no prompts have been added to this application. Click the **Add/Remove/Edit Prompts** button to add prompts (you can also use this button to edit or delete existing prompts or you can click the **Edit** link to the right of an existing prompt). Refer to **Add Prompts on page 107** for information about adding, deleting, or editing prompts.

3 The **Prompt Browser** dialog box closes, and the name and description of the prompt you selected appears in the **File** and **Description** columns of the **Prompts** table. Notice you can click the link in the **File** column to edit the prompt if needed.

![Prompt Browser Table]

---

**IMPORTANT:** Most blocks do not have default prompts. The caller hears silence if the block is supposed to play a prompt but the prompt is not configured. Optional voice prompts are specifically marked as optional.

**Prompt Storage**

Prerecorded prompt files should be placed in the `C:\Program Files\FrontRange Solutions\IPCommunicationsManagement\Applications\<applicationname>\Prompts\<languageID>\Recorded` folder. IPCM automatically encodes the prompt into the required voice format as needed.

If you want to provide your own prompts encoded for each required format, place the files in the `C:\Program Files\FrontRange Solutions\IPCommunicationsManagement\Applications\<application name>\Prompts\<languageID>\<codec>` folder.

**Prerecorded Prompts**

► **To Add Prerecorded Prompts to an Application:**

1 Use a third-party audio application to record the prompt in each language the voice application uses; save the recordings as audio files.

2 Use a third-party application to encode a version of the audio file using each codec the voice application uses.

3 Copy the audio files into the appropriate directory (mentioned above in Prompt Storage).

4 Click the **Update** and **Commit Changes** buttons.
### Best Practices: Voice Applications

<table>
<thead>
<tr>
<th>Best Practice</th>
<th>Example/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit the number of options to four or five per branch.</td>
<td>It is acceptable to list four or five options that are available for selection by callers. If the list goes beyond five items, callers lose patience and interest.</td>
</tr>
<tr>
<td>Minimize demands on the caller's memory.</td>
<td>First say the option, then specify the option key. For example, For Customer Care, press 1.</td>
</tr>
<tr>
<td>Organize menu choices in a way that saves time for the caller.</td>
<td>Present the most likely menu choice first, the second most likely next, etc.</td>
</tr>
<tr>
<td>Keep menu descriptions brief and to the point.</td>
<td>Instead of: If you wish to speak with a representative concerning your recent bill, press 4, use: For billing inquiries, press 4.</td>
</tr>
<tr>
<td>Keep caller touch-tone input to a minimum.</td>
<td>It is acceptable to ask callers to enter a zip code or account number (even 16 to 20 characters long). It is inadvisable to ask callers to enter their complete address.</td>
</tr>
<tr>
<td>Keep menu options consistent throughout a script and a company (common navigation techniques).</td>
<td>If the star (asterisk) key is used in one part of the voice application to reach an agent, use this consistently throughout the application.</td>
</tr>
<tr>
<td>Use words, terms, and expressions that are commonly understood by the public.</td>
<td>Avoid using company or even industry-specific jargon (unless you are sure the customer is familiar with it): for example, use account number for the caller’s account rather than your company’s terminology for the account.</td>
</tr>
<tr>
<td>Make it easy for callers to transfer from the voice application to an agent.</td>
<td>Tell callers throughout the script which key to press to transfer from the application to an agent.</td>
</tr>
<tr>
<td>Select a voice with an accent that is acceptable to the customer base.</td>
<td>Avoid accents that may be difficult to understand outside the region.</td>
</tr>
<tr>
<td>Set caller expectations for all fulfillment and actions requested within the voice application.</td>
<td>If it will take 10 business days for a copy of a requested document to reach a caller, provide that time frame.</td>
</tr>
<tr>
<td>Do not use humor in voice applications.</td>
<td>Humor is personal (and culture-specific) - what is funny to one person may not be funny to someone else.</td>
</tr>
<tr>
<td>Provide confirmation and feedback announcements.</td>
<td>If confirmation is needed, read back a caller’s entry to allow the caller to confirm it. Provide a feedback announcement such as Please wait while your information is located when necessary to apprise the caller that the information entered is being processed.</td>
</tr>
</tbody>
</table>
**Applications Selector**

**Application Builder Applications: File Locations**

IPCM stores voice applications you build with Application Builder in subfolders of the Program Files\FrontRange Solutions\IP Communications Management\Applications directory. Each application has a separate folder that shares its name. Inside the folder is an application.xml file containing the application flow, prompt directories, and automatic backups of unsaved application files IPCM creates if a user session expires without saving changes.

If you create an application outside of your production environment, copy its folder (and the folder contents) to the Program Files\FrontRange Solutions\IP Communications Management\Applications directory of the IPCM server in your production system.

**Applications Selector**

Applications Selector is used to register voice applications with IPCM, and configure how and when IPCM uses voice applications.

Applications Selector lets you make multiple applications available to IPCM for call handling, and allows you to create multiple configurations for each application. Each configuration consists of the following:

- **Start criteria** - The conditions under which IPCM uses each application configuration. For example, you can configure IPCM to use one application configuration for calls with a DNIS of 415-555-1234 and another for calls with a DNIS of 510-555-1234.

- **Initial interaction properties** - The initial values for the application properties. For example, you can configure IPCM to initially set the NoAnswerTimeout property to 20 seconds when IPCM uses the application before noon, and to 30 when IPCM uses the application after noon.

IPCM automatically selects a voice application to answer each call according to criteria you specify. For example, you can specify criteria that directs Applications Selector to:

- Run one voice application on weekends and another on weekdays.
- Run a specific voice application when IPCM receives a call from a number with a certain prefix.
- Run one voice application during the day and another in the evening (for instance, if your business closes in the evenings).
- Dial the voice server. The system is pre-configured to dial 501 to reach the voice server, so you can use phone numbers starting with 501 for your voice applications. If you have outside phone numbers which need to reach a given voice application, consider adding 501 to the beginning of your inbound numbers using prefix manipulation. For instance, if you have an incoming phone number of (800) 555-1200 for your support department, adding 501 in the incoming trunk prefix manipulation would then modify the incoming phone number to 501 800 555 1200. Then configure the voice application to start whenever a DNIS of 501 800 555 1200 is received.
Preparing for Incoming Calls

The following simple scenario describes how the Applications Selector and a voice application work together in IPCM.

1. A call enters IPCM from a public network.
2. Applications Selector uses configured criteria to select the appropriate voice application to answer the call.
3. The selected voice application answers the call and initiates an automated call processing scenario.
4. The voice application attempts to deliver the call to a destination.

Configure an Application for Use

To open the Applications Selector, click Management Portal>System Configuration>Applications.

On the Applications Selector page, you can create a configuration (or multiple configurations) for any application in the drop-down list at the top of the page, which contains all delivered applications and those created in Application Builder.

The list at the bottom of the Applications Selector page displays all applications currently configured.

Note: Depending on which IPCM components you choose to install, IPCM includes configurations for several default applications, including the HEAT, GoldMine, and ITSM demo applications.

The Start Criteria column lists one of the following for each application configuration:

- **Selected Always** - The application configuration is always enabled. IPCM will use this application if the start criteria for higher-priority applications is not met.
- **Disabled** - The application configuration exists but IPCM does not use it.
- **View** - The application configuration is available only when certain conditions are met. Click the View link to see the criteria IPCM uses to determine when to use the application.
To Create a Voice Application Configuration:

Before creating and configuring an application, you may want to view the Applications Selector tutorial in the online help; refer to the online help topic “Voice Application Selection: Applications Selector: Applications Selector Demonstration”

1. On the Applications Selector page, click the drop-down list at the top of the page (below the Entry Name field) to check that your application is listed. If your application is not listed, click the Reload button to refresh the list of available applications.

   CAUTION: If you modify an application (in Application Builder, for example) after loading it in Applications Selector, reload it by selecting the application from the drop-down list and clicking the Reload button; otherwise, your changes may not take effect.

2. In the Entry Name field, type a name for the application configuration.

3. In the drop-down list, select the application.

4. Click the Add Application button. The application configuration properties page opens.

   Note: IPCM generates a unique ID for the application configuration (displayed in the CLSID field).
5 In the **APPLICATION SELECTION CRITERIA** section, do one of the following:
   - Select **Selected Always**.
   - Select **Disabled**.
   - Select **Criteria Builder**.

6 If you selected the **Criteria Builder** option, you can then configure the specific circumstances for which IPCM uses the application. Otherwise, continue to step 7.

   - Click the **Add Column** button to add AND conditions to the criteria, which appear as additional columns in the table (all AND conditions must be met). The **Add new column** dialog box opens. Select a **Type** and **Property**, then click **Add**. A new column is added. Click the link in the new column. The **Set Condition** dialog box opens, enabling you to configure the **Type** of condition (such as a specific value or a range), then specify the value for that Type. Click **Set**. Add more columns as needed to establish the application criteria. To delete a column, click the red x icon next to the column name.

   - Click the **Add Alternative** button to add OR conditions to the criteria, which appear as additional rows in the table (the OR conditions are alternative conditions). The row appears with a link in each column. Click the link. The Set Condition dialog box opens, enabling you to configure the **Type** of condition (such as a specific value or a range), then specify the value for that Type. Click **Set**. Add more rows as needed to establish the application criteria. To delete a row, click the red x icon at the end of the row.

   **Note:** You can use call properties such as DNIS and ANI as variables; for example, configure the criteria so an application runs if IPCM receives a call with a DNIS of 501.
• The following example demonstrates how to configure start criteria:

Example: The following example demonstrates how to use the Criteria Builder to configure the start criteria for an application IPCM will use after 6:00 AM to calls placed to 800-555-1212.

• Select the Criteria Builder radio button.
• In the Call property:DNIS column, click the link.
• In the Type field, select Value.
• In the field that appears below the Type field, type the phone number 5018005551212 (the 501 is for the voice server) and click Set.
• Click the Add Column button. The Add new column dialog box opens.
• Click Add. A Time column is added to the criteria.
• Click the link. The Set condition dialog box opens.
• From the Type drop-down list, select Time.
• Click Add. A Time column is added to the criteria.
• Set the HH:MM for 06:00 and click Set. IPCM adds the Time criteria After '06:00' to the column, meaning 6:00 AM (the criteria is red until the Update button is clicked). Note that in military time, 6:00 PM would be 18:00.
• Click the Update button for the APPLICATION SELECTION CRITERIA section.

7 Click the Update button for the APPLICATION SELECTION CRITERIA section.

8 In the Parameters section, the Single application instance option configures IPCM to direct inbound calls into the same instance of the application, as opposed to starting a new instance of the application for each inbound call. The need for this option is rare, but it is useful for some applications. For example, if your deployment uses a telephone conference call application, run the application as a single instance to process calls coming into the conference, setting this option for applications designed to handle multiple inbound calls (applications that are not designed to work with multiple inbound calls might fail if you set the option).

9 Click the Update button for the Parameters section.

10 In the Initial Interaction Property Values section, use the Property Name, Property Value, and Comment fields to configure initial values for application properties. For instance, if you use the Applications Selector to load multiple configurations of a voice application, use this section to define different initial properties for each application configuration.

11 Click Add.

12 Repeat steps 10 and 11 to add more properties as needed.

13 Click the Update button for the Initial Interaction Property Values section.

14 Click the Commit Changes button to apply the changes. The new application configuration is added to the Applications Selector page.
Order of Applications

With each incoming call, IPCM evaluates the start criteria of each application configuration on the page starting with the application at the top of the list, and selects the first application configuration with start criteria matching the call. IPCM then uses the application configuration to process the call.

► To Change the Order of the Application Configurations:

1. On the Applications Selector page, click the radio button of the application configuration you want to reposition.
2. Click the Up or Down button below the table to reposition the selected application configuration, thereby changing the order in which IPCM evaluates the configurations.
3. Click the Commit Changes button to apply the changes.

► To Delete an Application Configuration:

• Click the radio button to the left of the application configuration, then click the red x icon.

Application Builder Example

The following example demonstrates how to use Application Builder to build a simple voice application that plays a synthesized voice message for callers.

Note: The IPCM online help contains tutorials that demonstrate how to build a voice application. Refer to the online help topic "Voice Application Design: Application Builder: Application Builder Demonstrations" to view the tutorials.

3. On the Telephony and Routing tab, click the Play Prompt block. The block is added to the flowchart on the left and the edit pane on the right displays the block parameters.
4. In the edit pane, click the Prompt link in the Name column. The Prompt Browser dialog box opens.
5. Click the Add/Remove/Edit Prompts button.
6. On the Prompts tab, type HelloWorld in the Prompt name field (at the bottom of the dialog box).
7. Click Add. The prompt HelloWorld is now listed as a link.
8. Click the HelloWorld link. The Prompt Editor dialog box opens.
9. Click Add Voice Segment.
10. Make sure the Voice option is selected in the drop-down list. In the Content field, type Hello, World!
11. Click Update and Back. The content is now listed below the HelloWorld link.
12. Click Back and then click the green + icon to select the new prompt. Notice the prompt is now associated with the File named [HelloWorld] and a Description of Hello, World!.
13. Click Update. Notice in the flowchart the Play block symbol now contains the file name of the prompt: Play “HelloWorld”.
14. Click Save As. The Save application as dialog box opens.
In the **New application name** field, type **Hello**.

Click **Save as**.

Click **Close Application**. The **Hello** application you created appears in the applications list.

### Applications Selector Example

The following example demonstrates how to register and configure the start criteria for the **Hello** application (from the previous example) using Applications Selector. In this example, the criteria for the voice application will specify this application is to be used for inbound calls to a specific toll-free number (800 555-1234) placed after 6:00 AM.

**Note:** The IPCM online help contains a tutorial that demonstrates how to configure the start criteria for a voice application. Refer to the online help topic "Voice Application Selection: Applications Selector: Applications Selector Demonstration" to view the tutorial.

1. Select **Start**>**Programs**>**FrontRange Solutions**>**Communication Management**>**Management Portal**, then click **System Configuration**>**Applications**. The **Applications Selector** page opens.

2. Click **Reload**. The list refreshes and the newly created application is now listed in the drop-down list at the top of the **Applications Selector** page.

3. In the **Entry Name** field, type **Hello (8005551234)**.

   **Note:** Using the toll-free number as part of the name enables you to see the criteria for this voice application at a glance. Otherwise you would need to click the **View** button to see the application criteria.

4. From the drop-down list, select **AppBuilder:Hello**.

5. Click **Add Application**. The application configuration properties page opens.

6. In the **APPLICATION SELECTION CRITERIA** section, select **Criteria Builder**.

7. In the **Call property:DNIS** column, click the link to specify the phone number for which this voice application will be used.

8. In the **Set condition** dialog box, select **Value** from the **Type** drop-down list, then type **8005551234** in the field that appears below it. Click **Set**. The value appears in the **Call property:DNIS** column.

9. Click the **Add column** button.

10. In the **Add new column** dialog box, select **Time** from the **Type** drop-down list, then click **Add**.

11. In the new **Time** column, click the link to specify the time of day this application will be used.

12. In the **Set condition** dialog box, select > from the **Type** drop-down list, then specify the time in the hours and minutes fields: **06:00**. Click **Set**. The time value appears in the **Time** column.

13. Click the **Update** button for the **APPLICATION SELECTION CRITERIA** section, then click the **Commit Changes** button to apply the change.

14. Select the **Applications** link in the left navigation panel to return to the **Applications Selector** page. The new application configuration, **Hello (8005551234)**, is now included in the list.

15. Select the **Hello (8005551234)** radio button.

16. Click the **Up** button to move the application to the top of the list.

17. Click **Commit Changes**.
Preparing for Incoming Calls

To see how the new call scenario works, dial into IPCM from another phone. You should hear the Hello, World! prompt.

Text-to-Speech (TTS) Voice Specification

Install at least one TTS engine for each language in which you want IPCM to generate dynamic prompts (for more information, refer to Prompts on page 106). IPCM switches TTS engines automatically if a situation occurs in which one TTS engine does not provide the necessary functionality. For example, if you have a TTS engine that does not support Russian and another TTS engine that does, IPCM switches to the TTS engine that supports Russian if IPCM needs to generate a Russian prompt.

You can install TTS engines before and after installing IPCM. If you install several TTS engines for one language, set one TTS engine as a default for that language:

2. Click the AppServer tab.
3. In the TTSSpeaker drop-down list, select the voice the TTS engine will use as the default.
   - The options in the TTSSpeaker drop-down list depend on the TTS engines installed and listed in the Windows Speech Properties dialog box: on the Text to Speech tab, you can specify the desired Voice selection option. Then, in IPCM, select the Use System Voice Selection option in the TTSSpeaker drop-down list to utilize the Windows setting.
   - If you install a TTS engine after installing IPCM, you must restart the voice server for the TTS engine to appear as an option in the TTSSpeaker drop-down list.
4. Click the Update and Commit Changes buttons to apply the change.
5. Launch the Management Console (Start>Programs>FrontRange Solutions>Communications Management>Management Console) and restart the voice server:
   a) Right-click the Voice Server icon and select Stop Application. The icon turns red, indicating the server has stopped.
   b) Right-click the Voice Server icon and select Start Application. The icon turns green, indicating the server is running.
Office Phone System

There are two ways IPCM can be deployed: as part of an existing phone system or as a stand-alone phone system. In the latter case, you may want to implement the following features in IPCM:

- **Unified Messaging (UM)** - Enables a user to access voice, fax, and text messages via a single email or telephone account. System-wide and user settings; user-based and system-wide settings can be configured.

- **Phone Groups** - Lets you organize phones into groups identified by a single extension to enable call-pickup and call-hunt capabilities.

- **Class of Restrictions (COR)** - Enables you to set limitations for dialing, transferring/forwarding, and receiving calls.

- **Authorization Codes** - Lets you establish codes users can enter on a phone keypad to override the default set of restrictions (COR) of the phone and access a set of restrictions for which the phone is not configured.

- **User Codes** - Lets you create a code that can be used to log into a phone to override the original COR/forwarding configuration of the phone, replacing it with the COR/forwarding configuration of the user entering the code.

### Unified Messaging (UM)

Unified Messaging enables a user to access voice, fax, and text messages via a single email or telephone account. Configure the system-wide UM settings in the Management Portal to use Unified Messaging in your IPCM deployment.

*Note: Unified Messaging may require additional licensing to meet your needs; check with your sales representative for more information.*

IPCM comes with three UM applications:

- Unified Messaging AppBuilder Attendant Application
- Unified Messaging AppBuilder Answering Application
- Unified Messaging Access Application

*IMPORTANT: Ivanti recommends that you do not edit or modify any of these applications in Application Builder.*
Attendant Application

The Attendant application answers inbound calls, plays a prerecorded greeting, and prompts callers to specify the extension or name of a call destination. The SIP Soft Switch connects an incoming call to the Attendant application if one of the following occurs:

- The call meets the start criteria specified in Applications Selector for the Attendant application (the call starts with 5011).
- The caller dials a SIP Soft Switch dial plan number allocated to the Attendant application.

The Attendant application lets callers enter DTMF input to specify the extension or name of the user they want to reach. The Attendant application also accepts voice input if integrated with a third-party ASR application. The SIP Soft Switch interprets the input to determine the call destination, and does one of the following:

- If the SIP Soft Switch finds the user and the user is available, the Attendant application connects the call to the requested user.
- If the SIP Soft Switch finds the user but the user is unavailable, the Attendant application forwards the call to the Answering application, which lets the caller leave a voice message for the user.
- If the SIP Soft Switch does not find the user, the Attendant application transfers the call to a live operator.

Dial-by-Name

IPCM uses a Name Search Mechanism (NSM) to interpret DTMF input as first and last name combinations, letting callers specify the intended recipient of a call or voice mail by pressing phone keys to type the recipient’s name. This capability is included in the Attendant application. You can specify if any particular user should be included or excluded in the Dial-By-Name in the user configuration.

IPCM accepts first names, last names, or any combination of the two in any order, as well as initials and incomplete input, and can also accept variants for each user name. For example, a caller could specify a user named John Smith by entering any of the following:

- John
- Smith
- John Smith
- Smith John
- J S
- J Smith
- John S

The NSM starts searching for a match when the caller first presses a key. With each key the caller enters, the number of users whose names match the input reduces. The NSM stops searching when one of the following occurs:

- Only one name matches.
- The caller presses the pound key (#).
- The number of potential matches will not change if a new key entered.
Answering Application

The Answering application lets callers record voice mail for users. The SIP Soft Switch connects a call to the Answering application if one of the following occurs:

- The caller dials a number which meets the start criteria specified in Applications Selector for the Answering application (the call starts with 5012). In such cases, the Answering application prompts the caller for input to determine the destination of the voice mail.
- The Attendant application forwards the call to the Answering application if the intended recipient does not answer, is busy, or is unavailable. In such cases, the Answering application uses the DNIS of the forwarded call to automatically determine the destination of the voice mail.

In addition, a caller can dial the Answering application number followed by the extension of the user for whom they want to leave a message. For example, if the Answering application number is 5012 and the target user extension is 601, the caller can dial 5012601 to directly reach the target user’s voice mail.

The Answering application begins recording after the voice prompt, using an audible tone to signal the start of the recording. To stop the recording and save the message, the caller must hang up or press any key except the star key (*).

**IMPORTANT:** If the caller presses the star key (*), the Answering application stops the recording without saving the message, and transfers the caller to the Access application.

When a caller finishes recording a voice message, the Answering application saves the voice message as an audio file, and sends it as an attachment to an email address associated with the extension.

The Answering application uses Voice Activity Detection (VAD) to discard empty messages or stop recording if the sound of a voice is stopped for a specified time. VAD does not detect the audio source type (such as answering machine, fax, etc.), but only detects the activity.

Two options control the VAD feature: initial silence cut-off and silence cut-off, which are configured on the General tab of system-wide Unified Messaging settings in the Management Portal. Refer to General UM Settings on page 128 for more information.
Access Application

The Access application lets IPCM users access their voice mailboxes by phone to retrieve and manage their voice mail and email. The Access application also lets IPCM users customize their voice mailboxes by phone.

The SIP Soft Switch connects a call to the Access application if one of the following occurs:

- The call meets the start criteria specified in Applications Selector for the Access application (the call starts with **5013**).
- The caller presses the star key (*) while connected with the Answering application.

When an IPCM user connects to the Access application, the Access application attempts to use the ANI call property to identify the IPCM user. If the Access application does not recognize the ANI, it prompts the user to enter a mailbox number or extension.

After identifying the user, the Access application prompts the user to enter a PIN:

- If the PIN is not entered or is invalid, the Access application terminates the call.
- If the PIN is valid, the Access application accesses the user’s mailbox, announcing the number of new messages and the total number of messages in the mailbox.

The Access application plays voice mail and reads email according to the configured message processing order. For current messages, the Access application announces menu options.

When working with the Access application:

- If the user opts to forward or send the message, the application lets the user specify the destination by extension or by name. If the user presses the star key (*), the Access application invokes the search by name feature.
- If the user opts to reply to, forward, or send a message, the application offers to record a voice message.

When specifying a call destination:

- If the user chooses to specify the destination by extension, the Access application searches the user’s list.
- If the user chooses to specify a destination by name, the Access application searches the user’s list, the IPCM global address book, and the user’s personal address book.

While connected to the Access application, IPCM users can press **0** to access the Access application settings menu, which lets users configure mail preferences (such as the order in which the Access application plays messages) and record a personal greeting. The Answering application plays the personal greeting if the SIP Soft Switch fails to connect a caller trying to reach the user, or if the user does not answer during a predefined time interval. If the user does not record a personal greeting, the Answering application plays a generic prompt inviting the caller to leave a message.

---

**Note:** If the UM email protocol is IMAP, IPCM users can navigate folders in the voice mailbox by pressing **2** on the phone keypad.
Changing the Start Criteria for UM Applications

When you install IPCM, each UM application automatically registers in the Applications Selector and the default start criteria (as specified in the previous application descriptions) is used for calls. Since the default extension of the voice server is 501, the voice server receives all calls placed to extensions 5011, 5012, and 5013. For each call it receives, the voice server uses the Applications Selector to check the start criteria of each application to find the right application for the call. The voice server directs calls intended for extension 5011 to the Attendant application, calls intended for extension 5012 go to the Answering application, and calls intended for extension 5013 go to the Access application.

You can change the start criteria for each application such that the SIP Soft Switch directs a call to the application if the DNIS of the call matches a value you specify. For this to work, the number callers dial to access each application must start with the voice server extension, which has the default of 501.

To Change the Start Criteria for the UM Applications:

2. Click the name of the application you want to modify.
3. In the APPLICATION SELECTION CRITERIA section, click the Starts with link in the Call property:DNIS column.
4. In the Set condition dialog box, change the number in the Starts with field to reflect the number callers will dial to start this application.
5. Click Set.
6. Click the Update button for the APPLICATION SELECTION CRITERIA section.
7. Click the Commit button to apply the change.
8. Repeat these steps for each application for which you want to change the start criteria.

Note: Refer to Applications Selector on page 115 for more information about configuring start criteria for applications.
General UM Settings

System-wide UM settings are configured on the **General** tab on the **Unified Messaging** page.

**IMPORTANT:** In addition to the general Unified Messaging configurations, configure user profile UM settings for each user who plans to use UM. Refer to the online help topic "User Configuration: Unified Messaging (UM) User Configuration."

► To Configure the UM Settings on the General Tab:

1. In the Management Portal, click **System Configuration>Users>Unified Messaging**.

2. On the **General** tab:
   - In the **Forwarding prefix for Answering TUI** field, type the extension of the Answering application. The voice application forwards calls to the Answering application using this extension. The prefix should be the same prefix the SIP Soft Switch uses to forward calls to the Answering application from the PSTN. The default is **5012**.
     
     **Note:** The Answering application removes the prefix from the number to determine the original DNIS of each forwarded call.

   - In the **Extension for live secretary** field, type the extension of the live operator. If the UM functionality does not recognize the caller input as a valid destination, a message is left on the live operator’s extension. The Attendant application and Answering application also transfer client calls to this extension in other cases, such as input timeouts.

   - In the **Maximum time for message recording** field, type the maximum number of seconds the Answering application and Access application allow for recording a single message (optional).
     
     **Note:** You can also set maximum recording time limits for individual mailboxes - refer to **Unified Messaging (UM) User Settings** on page 130. If you do not set a recording time limit on an individual mailbox, the mailbox uses the value you set in this field.
• In the **Initial silence cut-off** field, type the number of seconds the Answering application will wait for the sound of a voice to begin before terminating the call and discarding the message. The default value of 5 seconds tells the Answering application to stop recording and discard the message if the sound of a voice has not started within 5 seconds after the tone. The caller then hears the prompt **An empty message cannot be sent**, followed by call termination. If the field is empty or 0, initial silence is not monitored.

**Note:** Initial Silence Cut-Off value can also be specified at the user level - refer to Unified Messaging (UM) User Settings on page 130. When not empty, the field at the user level is used by the Answering application instead of the system-wide value. If empty, the system-wide value is used.

• In the **Silence cut-off** field, type the number of seconds the Answering application will wait when the sound of a voice stops before ending recording and sending the message. The default value of 10 seconds tells the Answering application to end the recording 10 seconds after the sound of a voice stops and send the voice mail. If the field is empty or 0, an indefinite, lengthy terminating silence is allowed.

1. Click the **Update** and **Commit Changes** buttons to apply the changes.
2. On the **User Defaults** tab:

   ![Unified Messaging tab](image)

   • In the **Read voice mails only** field, select **Yes** to configure IPCM read only voice mail when a user calls the Access application; select **No** to configure IPCM also read email to the user.
   • In the **Play message from** field, select **Yes** to configure IPCM to announce the name of the message sender.
   • In the **Play message subject** field, select **Yes** to configure IPCM to announce the subject of the message (if provided).
   • In the **Play message time stamp** field, select **Yes** to configure IPCM to announce the time IPCM received the message.
   • In the **Play message duration** field, select **Yes** to configure IPCM to announce the amount of time the message lasts.

   **Note:** These settings can be overridden on a user-by-user basis when configuring individual user profiles - refer to Unified Messaging (UM) User Settings on page 130.
5 Click the **Update** and **Commit Changes** buttons to apply the changes.

**IMPORTANT:** For information on configuring the settings on the **E-Mail configuration** tab refer to the online help topic “Unified Messaging Configuration: System Email Configuration.” For information on configuring the settings on the **Indication** tab, refer to the online help topic “Unified Messaging Configuration: MWI Configuration (Indication Tab).”

### Unified Messaging (UM) User Settings

The system administrator must configure the settings on the **Unified Messaging** tab of the user’s properties page to allow an IPCM user to access the Unified Messaging functionality.

► **To Configure the User’s Unified Messaging Settings:**

1. In the Management Portal, click **System Configuration>Users**.
2. In the **Login** column on the **Users** page, click the name of the user. The **User** properties page for that user opens.
3. Click the **Unified Messaging** tab. Unified Messaging is configured on three sub-tabs: **General**, **E-Mail**, and **Other**.
4. Click the **General** tab. You can set (or reset) the user personal identification number (PIN):

   ![Unified Messaging Tab](image.png)

   - Click the **Clear PIN** button. A confirmation dialog box opens.
   - Click **OK**. A dialog box opens, confirming that user’s PIN has reset to **0000**. Click **OK**.
   - Click the **Set new PIN** button. The **Set new PIN** dialog box opens.
   - In the **Current PIN** field, type **0000**.
   - In the **New PIN** field, type a new PIN.
   - In the **Confirm New PIN** field, re-type the new PIN.
   - Click **OK**. A confirmation dialog box opens. Click **OK**.

**Note:** Users can also set their own PIN by following the audio instructions of the Access application. If a user forgets the PIN, click the **Clear PIN** button to reset the PIN to **0000**, then advise the user of the temporary PIN and have the user call the Access application to create a new PIN.

5. Click the **Update** button to apply the settings.
6 Click the **E-Mail configuration** tab:

![Unified Messaging (UM) User Settings](image)

- In the **E-mail address** field, type the user email address, as specified on the user profile **General** tab. IPCM uses this email address as the recipient address for voice messages sent to the user, and as the sender address when the user utilizes the Access application to send email.

- In the **E-mail login** field, type the login for the user email account.

- Click the **Enter Password** button, type the user PIN and email account password in the dialog box, and click **OK**.

  **IMPORTANT:** For information on configuring other user email settings on this tab, refer to the online help topic "User Configuration: Unified Messaging Tab Configuration."

7 Click the **Update** button to apply the settings.

8 Click the **Test Email Connection** button beneath the **Incoming mail TCP port** field to test the connection to the user email account (this can only be done after clicking the **Update** button). The **Enter Password** dialog box opens. Enter the user PIN and email account password, then click **OK**. The **Check result** line at the bottom of the page informs you of the test result.
9 Click the **Other** tab:

![Office Phone System](image)

- In the **Communication Language** field, select the language in which the Access application plays prompts and reads text messages for this user (or leave the setting as **Default**).
- In the **Text-to-Speech Speaker** field, select the Text-To-Speech speaker the Access application uses to read text messages (or leave the setting as **Default**).
- The **Order of sorting messages** works in conjunction with the **Current position for sorted messages** field to determine the order in which the user’s voice mailbox plays messages (refer to **Mail Processing Order Examples on page 133**). Select either **Recent** or **Oldest**.
- In the **Name of Deleted Items** field, type the name of an **existing** mailbox folder in which IPCM will place messages the user deletes.
- In the **Maximum time for message recording** field, type the maximum number of seconds the Answering application and Access application allow for recording a single messages (optional). If this field is empty, IPCM uses the system-wide setting (refer to **General UM Settings on page 128** for more information).
- In the **Initial silence cut-off** field, type the number of seconds the Answering application will wait for the sound of a voice to begin before terminating the call and discarding the message. The default value of 5 seconds tells the Answering application to stop recording and discard the message if the sound of a voice has not started within 5 seconds after the tone. The caller then hears the prompt **An empty message cannot be sent**, followed by call termination. If this field is empty, the system-wide setting is used.
- In the **Read voice mails only** field, select **Yes** to configure IPCM read only voice mail when this user calls the Access application; select **No** to configure IPCM to also read email to the user. Select **Default** if you want IPCM to use the settings on the system-wide **User Defaults** setting (refer to **General UM Settings on page 128** for details).
- In the **Play message from** field, select **Yes** to configure IPCM to announce the name of the message sender. Select **Default** if you want IPCM to use the settings on the system-wide **User Defaults** setting (refer to **General UM Settings on page 128** for details).
• In the **Play message subject** field, select **Yes** to configure IPCM to announce the subject of the message (if provided). Select **Default** if you want IPCM to use the settings on the system-wide **User Defaults** setting (refer to General UM Settings on page 128 for details).

• In the **Play message time stamp** field, select **Yes** to configure IPCM to announce the time IPCM received the message. Select **Default** if you want IPCM to use the settings on the system-wide **User Defaults** setting (refer to General UM Settings on page 128 for details).

• In the **Play message duration** field, select **Yes** to configure IPCM to announce the amount of time the message lasts. Select **Default** if you want IPCM to use the settings on the system-wide **User Defaults** setting (refer to General UM Settings on page 128 for details).

10 Click the **Update** button to apply the settings.

### Mail Processing Order Examples

The *Order of sorting messages* and *Current position for sorted messages* fields determine the order in which the user voice mailbox plays messages when the user presses the 6 (next) button on the phone to scroll through messages. The following examples describe each combination of settings, and use the following sample messages:

- **Message 1**, received 5/20/08 (read)
- **Message 2**, received 5/21/08 (read)
- **Message 3**, received 5/22/08 (read)
- **Message 4**, received 5/23/08 (unread)
- **Message 5**, received 5/24/08 (unread)
- **Message 6**, received 5/25/08 (unread)

#### Example 1:

If the *Order of sorting messages* = Recent and the *Current position for sorted messages* = Recent, the voice mailbox first plays any unread messages in the order of newest to oldest, and then plays read messages in the order of newest to oldest. For example:

- Message 6, received 5/25/08 (unread)
- Message 5, received 5/24/08 (unread)
- Message 4, received 5/23/08 (unread)
- Message 3, received 5/22/08 (read)
- Message 2, received 5/21/08 (read)
- Message 1, received 5/20/08 (read)

#### Example 2:

If the *Order of sorting messages* = Recent and the *Current position for sorted messages* = Oldest, the voice mailbox first plays the oldest unread message. Then, the voice mailbox plays the read messages in order of newest to oldest. If there are additional unread messages, the voice mailbox plays these in the order of newest to oldest after playing the read messages. For example:

- Message 4, received 5/23/08 (unread)
- Message 3, received 5/22/08 (read)
- Message 2, received 5/21/08 (read)
- Message 1, received 5/20/08 (read)
Example 3:
If the Order of sorting messages = Oldest and the Current position for sorted messages = Oldest, the voice mailbox first plays any unread messages in the order of oldest to newest, and then plays read messages in the order of oldest to newest. For example:

- Message 4, received 5/23/08 (unread)
- Message 5, received 5/24/08 (unread)
- Message 6, received 5/25/08 (unread)
- Message 1, received 5/20/08 (read)
- Message 2, received 5/21/08 (read)
- Message 3, received 5/22/08 (read)

Example 4:
If the Order of sorting messages = Oldest and the Current position for sorted messages = Recent, the voice mailbox first plays the newest unread message. Then the voice mailbox plays the read messages in order of oldest to newest. If there are additional unread messages, the voice mailbox plays these in the order of oldest to newest after playing the read messages. For example:

- Message 6, received 5/25/08 (unread)
- Message 1, received 5/20/08 (read)
- Message 2, received 5/21/08 (read)
- Message 3, received 5/22/08 (read)
- Message 4, received 5/23/08 (unread)
- Message 5, received 5/24/08 (unread)

Global Address Book Management

Note: An uneditable version of the Global Address Book appears in the Agent Dashboard as the Common Contact list.

► To Add an Entry to the Global Address Book:
1. Fill in the empty fields in the bottom row.
2. Click the Create button. IPCM adds the entry to the Global Address Book table.

► To Edit an Entry in the Global Address Book:
1. Type over the information you wish to edit.
2. Click the Update button.
Phone Groups

To Delete an Entry from the Global Address Book:

1. Click the red x icon to the right of the entry. A confirmation dialog box opens.
2. Click OK. The entry is deleted from the table.

Phone Groups

The Phone Groups page lets you organize phones into groups identified by a single extension. A phone group can contain any number of phones. Also, a single phone can be a member of multiple groups.

Note: When you assign a phone to a phone group, the phone still keeps its own extension.

You can enable the following features for phone groups:

- **Call hunt** - When a caller dials the phone group extension, the SIP Soft Switch connects the call to a randomly selected extension in the group. If all extensions in a hunt group are busy, the SIP Soft Switch will queue the call and play music until the group member extension becomes available.

- **Call pickup** - Lets you use any phone to answer inbound calls to other phones. When an extension in the phone group rings, a user can answer the call by using another phone in the group to dial the **Call pickup group** number, which you configure on the **Special Numbers** page.

  Note: You can also configure call pickup for extensions outside of phone groups, letting IPCM users answer calls to other extensions in the company by dialing a special number (**Call pickup directed** number) followed by the extension of the ringing phone. Refer to the online help topic "SIP Soft Switch Configuration: Special Numbers."

Create and Delete Phone Groups

To Create and Configure a Phone Group:

1. In the Management Portal, click **System Configuration>SIP Soft Switch>Phone Groups**. The Phone Groups page opens.
2. In the empty field, type the extension of the phone group.
3. Click **Add**. The extension is added to the list of Phone Groups.
4. Click the new phone group link to configure the settings.
5. On the **Membership** tab, the **Group Number** field displays the extension you typed on the Phone Groups page. Change this number if needed.
6. In the **Group Members** field, add an extension to this group by typing the extension in the empty field and clicking the **Add** button (remove phones by clicking the red x icon). Do this for all extensions to be included in this group.
7. Click the **Update** button.
8. Click the **Features** tab.
9. In the **Enable call pickup in this group** field, select **Enable** to let users answer inbound calls to this group by dialing the **Call pickup group** number from any phone in the group (the call pickup group number is configured on the **Special Numbers** page - refer to the online help topic "SIP Soft Switch Configuration: Special Numbers"). The **Disable** option requires users to physically answer the ringing phone to answer inbound calls to this group.
10 In the **Enable call hunt in this group** field, select **Enable** to allow the SIP Soft Switch to route calls to phones in this group when a caller dials the phone group extension. If all extensions in a hunt group are busy, the SIP Soft Switch will queue the call and play music until a group member extension becomes available. The **Disable** prevents the SIP Soft Switch from routing calls to any extension when a caller dials the extension of the group.

11 Click the **Update** button.

**To Delete a Phone Group:**

1. On the **Phone Groups** page (in the Management Portal, click **System Configuration>SIP Soft Switch>Phone Groups**), click the red x icon next to the phone group extension.
2. Click **OK** to confirm the deletion.

### Class of Restrictions (COR)

A class of restrictions (COR) is a set of limitations you apply to collections of extensions. The class of restrictions:

- Determines the numbers an extension can dial. For example, you can prevent extensions in a certain class from dialing external numbers, making long distance calls, etc.
- Determines the numbers to which an extension can transfer or forward calls. For example, you can prevent users in a certain class from transferring calls outside the system.
- Determines the numbers from which an extension can receive calls, including forwarded calls and transfers. For example, you can prevent extensions in a certain class from receiving external calls, calls from other internal departments, etc.

### Call Restriction Levels

CORs let you set incoming and outgoing call restriction levels, which determine the priority IPCM grants to extensions (including phones, trunks, and gateways) when allocating system resources. Extensions with an assigned outgoing call restriction level can only call extensions with an incoming call restriction level the same or lower. This enables you to reserve expensive resources (such as high-quality trunks) for certain extensions or subsets of users, such as company executives.

If there are multiple extensions to which IPCM can route the call, and each has an incoming call restriction level lower than the outgoing call restriction level of the calling extension, IPCM routes the call to the resource with the highest incoming call restriction level.

Refer to the online help topic "SIP Soft Switch Configuration: Class of Restrictions (COR)" for COR and call restriction level examples, as well as information and examples for least-cost routing.

### Create and Delete a Restriction Class

The **Restrictions** page (in the Management Portal, click **System Configuration>SIP Soft Switch>Restrictions**) lets you create and configure CORs to assign when configuring extensions. All tabs, except **Levels**, contain the **Allow List** and **Deny List** fields, into which numbers or an asterisk (*) can be entered (the asterisk indicates any number).

**To Create and Configure a Restriction Class:**

1. In the Management Portal, click **System Configuration>SIP Soft Switch>Restrictions**. The **Restrictions** page opens.
2. In the empty field, type a name for the restriction.
3 Click **Add**. The properties page opens, displaying five tabs: **Calling Device, Called Device, Transfer, Forward**, and **Levels**.

4 On the **Calling Device** tab:

   ![Image of properties page with Allow List and Deny List]

   - In the **Allow List** fields, type the numbers you want to allow extensions in this restriction class to call, then click the **Add** button.
   - In the **Deny List** fields, type the numbers you want to prevent extensions in this restriction class from calling, then click the **Add** button.

   For both the **Allow List** and **Deny List** fields:
   - You do not need to enter a specific phone number to be allowed or denied, you can type a prefix instead. For example, to disallow all calls beginning with the digit 9, type 9 in the **Deny List**.
   - If a number is not in either the **Allow List** nor **Deny List**, the SIP Soft Switch allows extensions in the class to call the number.
   - The **Allow List** overrides the **Deny List**. This enables you to allow calling exceptions in denied groups. For example, if you want to prevent extensions in the COR from calling all numbers beginning with a 9 except for the number 91-415-555-1212, type 9 in the **Deny List** and the specific number to be allowed (914155551212) in the **Allow List**.

   **Note:** Click the red x icon to remove allowed or denied entries.

5 Click the **Update** button to apply the configuration.

6 On the **Called Device** tab:

   - In the **Allow List** fields, type the numbers from which you want extensions in this restriction class to receive calls, then click the **Add** button.
   - In the **Deny List** fields, type the numbers from which you want extensions in this restriction class to not receive calls, then click the **Add** button.

   For both the **Allow List** and **Deny List** fields:
   - If a number is not in either the **Allow List** nor **Deny List**, the SIP Soft Switch allows extensions in the class to receive calls from the number.
- The **Allow List** overrides the **Deny List**. This lets you allow exceptions for specific numbers in denied groups. For example, you can use the **Deny List** to prevent the extension from receiving calls from the PSTN unless the call originates from a number you specify in the **Allow List** (for example, allowing calls from the number of a remote office).

  **Note:** Click the red x icon to remove allowed or denied entries.

7 Click the **Update** button to apply the configuration.

8 On the **Transfer** tab:

- In the **Allow List** fields, type the numbers to which you want to allow extensions in this restriction class to transfer calls, then click the **Add** button.
- In the **Deny List** fields, type the numbers to which you want to prevent extensions in this restriction class from transferring calls, then click the **Add** button.

For both the **Allow List** and **Deny List** fields:

- If a number is not in either the **Allow List** nor **Deny List**, the SIP Soft Switch allows extensions in the class to transfer calls to the number.
- The **Allow List** overrides the **Deny List**. This lets you allow extensions in this restriction class to transfer calls to specific numbers from denied groups. For example, you can use the **Deny List** to prevent the extension from transferring the call to any international number except the number of an overseas office you specify in the **Allow List**. When transfer is restricted, the extension, such as hard phone, will not be able to complete a blind or consult transfer (nothing happens when the **Transfer** button on the phone is pressed). The phone typically provides no indication on its LCD.

  **Note:** Click the red x icon to remove allowed or denied entries.

9 Click the **Update** button to apply the configuration.

10 On the **Forward** tab:

- In the **Allow List** fields, type the prefixes to which you want to allow extensions in this restriction class to forward calls, then click the **Add** button.
- In the **Deny List** fields, type the prefixes to which you want to prevent extensions in this restriction class from forwarding calls, then click the **Add** button.

For both the **Allow List** and **Deny List** fields:

- If a prefix is not in either the **Allow List** nor **Deny List**, the SIP Soft Switch allows extensions in the class to forward calls to the number.
- The **Allow List** overrides the **Deny List**. This lets you allow extensions in this restriction class to forward calls to specific numbers from denied prefix groups. For example, you can use the **Deny List** to prevent the extension from forwarding the call to any international number except the number of an overseas office you specify in the **Allow List**.

  **Note:** Click the red x icon to remove allowed or denied entries.

11 Click the **Update** button to apply the configuration.
12 On the Levels tab, you can configure restriction levels that control the accessibility of phones or trunks/gateways in this restriction class. Each device has two restriction levels:

- **Outgoing calls restriction level** - An integer that determines the resources a device in this class of restrictions can access. Devices in this restriction class can only access devices belonging to restriction classes with incoming call restriction levels equal to or lower than the integer you specify in this field. The default is 10.

- **Incoming calls restriction level** - An integer that determines which resources can access devices in this class of restrictions. To use a device in this class, the calling device must have an outgoing call restriction level greater than or equal to this integer. The default is 5.

13 Click the Update button to apply the configuration.

To Delete a Restriction Class:

1. On the Restrictions page (in the Management Portal, click System Configuration>SIP Soft Switch>Restrictions), click the red x icon to the right of the COR.

2. Click OK to confirm the deletion.

Authorization Codes

The Authorization Codes page lets you establish codes users can enter on a phone keypad to override the default COR of the phone and access a COR for which the phone is not configured. The override begins when the user dials the Override Class of Service Prompt extension (configured on the Special Numbers page - refer to the online help topic "SIP Soft Switch Configuration: Special Numbers") and enters an authorization code followed by the pound sign (#). The override ends when the user dials the Override Class of Service Prompt extension and presses only the pound sign key.

The Authorization Codes page lists the CORs you configured on the Restrictions page.

To Specify an Authorization Code for a COR:


2. In the Auth Code field next to the COR, type the numeric authorization code.

3. Click the Update button to apply the configuration.

User Codes

The User Ids page lets you create a code that can be used to log into a phone in the IPCM environment and override the original COR/forwarding configuration of the phone. The phone’s original COR/forwarding configuration is replaced by the COR/forwarding configuration of the user entering the code.

To Create and Configure a User Code:

1. In the Management Portal, click System Configuration>SIP Soft Switch>User Codes. The User Ids page opens.

2. In the empty field, type a numeric user code.

3. Click Add. This is the code the user dials to assume control of the extension. This code becomes a virtual extension, capable of receiving and originating calls. The phone’s original extension still can be used to receive calls.
4 To configure the user code, click the user code link. The properties page opens, displaying two tabs: User Code and Forwarding.

5 On the User Code tab:

- To set the PIN the user enters after dialing the user code, click the Set button. In the Change Dialable PIN dialog box, type the user code extension in the Dialable User Code field, type the PIN number in both the Dialable User PIN and the Confirm Dialable User PIN fields, then click Set.
- In the User field, select the user who will be allowed to utilize this code. Each user code can be assigned to only one user.
- In the Default Class of Restrictions field, select the COR that will be used for this extension while the user is logged in.

6 Click the Update button to apply the configuration.

7 Configure the settings on the Forwarding tab. Click the online help icon for field explanations.

- For each forwarding category you want to enable, indicate in the Strip, # of digits field the number of digits the SIP Soft Switch removes automatically from the beginning of the telephone numbers of forwarded calls. In the Prefix with these digits field, indicate the digits the SIP Soft Switch prefixes automatically to the beginning of the telephone numbers of forwarded calls.

**Note:** The voice application may disable call forwarding on a per call basis. For example, if an extension belongs to an agent and the queued call is routed to the agent, the call forwarding for this extension will be disabled to avoid routing queued calls to the agent's voice mail.

8 Click the Update button to apply the configuration.

> To Delete a User Code:

1 On the User Ids page (in the Management Portal, click System Configuration>SIP Soft Switch>User Codes) click the red x icon to the right of the extension.

2 Click OK to confirm the deletion.
IPCM Communicator

IPCM Communicator is a softphone client application that ships with IPCM and allows end-users to perform basic telephony tasks such as making phone calls, initiating conference calls, placing calls on hold, transferring calls, etc. Users can also park calls by transferring the call to a parking orbit number from which other users can retrieve the call (by dialing a special pickup code and a unique number to identify the parked call).

The Communicator softphone can receive multiple calls at once, playing an alert when each call arrives and displaying the caller ID of each calling party. If you do not answer an incoming call, the caller can leave a voice mail. A message waiting indicator (MWI) on the IPCM Communicator activates. The call history lists each call the IPCM Communicator receives, dials, and misses.

Note: IPCM can override the From SIP header with information provisioned at the server, providing a centralized and secure way of provisioning calling party names. IPCM also supports Remote-Party-ID SIP headers used to communicate the name and number to and from the call destination. Media gateways can use the Remote-Party-ID to convey caller ID information, which the voice server and Communicator generate for every new call. The SIP Soft Switch propagates this field from one call leg to another.
IPCM Communicator features on-demand call recording. The record button displays during active calls. A buffering mechanism can capture a configurable portion of the phone conversation, including the portion of the conversation occurring before you click the record button.

**WARNING:** You may record phone calls through the use of the licensed software. The laws on recording phone calls vary from country to country and state to state. Ivanti recommends you inform the other party or parties to your phone call that you are recording their conversation; however, it is your responsibility to comply with all applicable laws and regulations in your use of the licensed software. You agree to abide by all applicable communication, privacy, and similar rules, directives, and other laws in your use of the licensed software. In no event will Ivanti be liable for any action or inaction on your part which leads to or causes you to break the law.

**Configuring the Communicator**

▲To Configure the IPCM Communicator:

Some communicator settings (on the SoftPhone, SIP Registration, and STUN tabs) are pre-configured during installation, but can be edited as needed.

1. Open the IPCM Communicator by clicking `Start>Programs>FrontRange Solutions>Communications Management>Communicator`.
2. Click the Communicator Information tab.
3. On the Information tab, click the Settings link.
4. On the General tab, select the *Hide the main window when it is minimized* option if you do not want the Communicator to display in the Windows Taskbar when you minimize the Communicator interface. If you select this option, click the icon in the lower right Windows notification area when you want the Communicator to reappear on the screen.

5. Configure the settings on the SoftPhone tab:
   - **Number** - Type the extension assigned to this instance of the Communicator.
   - **Display Name** - Type the name that will appear on the readout of devices receiving calls from this instance of the Communicator.
   - **Make private** - Select this option to block the display name, preventing devices you are calling from displaying the display name.
   - **SIP Port Number** - The SIP port number specific to the Communicator as specified in the SIP server settings. The default is **5060**.
Configuring the Communicator

• **Session interval** - The interval at which the Communicator sends verification messages (pings) to ensure that both parties are still connected. If a verification message does not receive a reply, the Communicator drops the call. Most devices do not support intervals smaller than 1800 seconds. The default is **3600**.

• **Session timer** - The minimum session interval a device must have for this instance of the Communicator to accept calls from the device. If the remote party proposes a shorter session interval, the Communicator declines the call. The default is **90**.

• **First RTP port number** - The first RTP port number specific to the Communicator. The default is **15600**.

• **Auto select** - Select this option to configure the Communicator to attempt to use SIP port numbers in a range starting with the number in the **SIP Port Number** field. If the port number in the **SIP Port Number** field is not available, the Communicator attempts to use the next highest port number until finding an available port.

• **Mirror RTP** - Select this option to configure the Communicator to send outbound RTP messages to the address from which inbound RTP messages are received to achieve NAT traversal.

6 Configure the settings on the **SIP Registration** tab:

• **Primary Proxy Address** - Enter the network name or IP address of your primary SIP Soft Switch, or accept the default.

• **Primary Proxy Port** - Enter the port number of your primary SIP Soft Switch, or accept the default.

• **Primary Proxy Domain** - Enter the domain of your primary SIP Soft Switch.

• **Backup Proxy Address** - If you have set up a backup SIP Soft Switch, enter the network name or IP address of the backup SIP Soft Switch.

• **Backup Proxy Port** - If you have set up a backup SIP Soft Switch, enter the port number of the backup SIP Soft Switch.

• **Backup Proxy Domain** - Enter the domain of your backup SIP Soft Switch.

• **Register with registrar** - Select this check box if you want the SIP Soft Switch to register with the SIP registrar.

• **Primary Registrar Address** - Enter the network name or IP address of your primary SIP registrar, or accept the default.

• **Primary Registrar Port** - Enter the port number of your primary SIP registrar, or accept the default.

• **Backup Registrar Address** - If you have a backup SIP registrar, enter the network name or IP address of the backup SIP registrar.

• **Backup Registrar Port** - If you have a backup SIP registrar, enter the port number of the backup SIP registrar.

• **Registration interval** - The interval at which registration stays valid. Registration will be renewed at the end of the interval.

• **Include account credentials in registration** - Select this option if you want the Communicator to use the user name and password values below when registering with a SIP registrar.

• **User Name and Password fields** - If you created a user name and password for this extension in the Management Portal, enter those credentials here. If not, leave these fields empty.
On the **Media** tab are settings for input and output audio devices. IPCM automatically locates the input and output audio devices (such as sound cards and headsets) installed on your computer, and lists them in the drop-down lists. Select the **Use default device** radio button to use the default device, or select the **Select device** radio button and select the audio devices for each function. For example, if your computer has a microphone and earpiece installed, you can select the microphone to handle voice input and the earpiece to handle voice output.

On the **Voice Codecs** tab, you can configure the codecs the Communicator uses. The box on the left lists available codecs; the box on the right lists the codecs the Communicator is using. Click a codec then click the **Add Codec** or **Remove Codec** button to move the codecs between the two boxes as needed. The Communicator uses the codecs in the right box in the order listed. Click a codec and click the **Move Up** and **Move Down** buttons to change the order.

On the **Recording** tab, you can change the default location of the audio files containing conversations recorded while using the Communicator. To change the location, do one of the following:

- In the **Recordings folder** field, enter the path to the folder in which you want to store recorded files.
- Click the **Select** button and navigate to the folder in which you want to store recorded files.

**WARNING:** You can record phone calls through the use of the licensed software. The laws on recording phone calls vary from country to country and state to state. Ivanti recommends you inform the other party or parties to your phone call that you are recording their conversation; however, it is your responsibility to comply with all applicable laws and regulations in your use of the licensed software. You agree to abide by all applicable communication, privacy, and similar rules, directives, and other laws in your use of the licensed software. In no event will Ivanti be liable for any action or inaction on your part which leads to or causes you to break the law.

You can also configure the following recording settings:

- **Keep ___ seconds of voice for recording** - Configures the Communicator to buffer the specified amount of seconds of each call. This lets the Communicator create recordings containing the buffered portion if the user chooses to record the call. For example, if the value is 30 and the user clicks the record button 45 seconds into the call, the recording contains the entire conversation beginning after the first 15 seconds into the call. The maximum value is 999.

- **Compress recorded voice** - Configures the Communicator to create lower quality recordings that consume less disk space. The compression is approximately 6 times.

On the **STUN** tab, if you use a STUN server, select the **Use STUN to traverse NAT** check box, then type the host name or IP address of the STUN, the port, and the refresh interval, or accept the defaults. A STUN icon on the Communicator (to the left of the phone icon on the lower left below the keypad) indicates the STUN status:

- Green indicates **STUN OK** - The STUN, when contacted for a media IP/port, provided a response.

- Orange indicates **STUN Timed Out** - The STUN timed out, so no media IP/port was provided for the call.
Configuring the Communicator

11 On the **Tones** tab, IPCM automatically locates and lists the audio devices (such as sound cards and headsets) installed on your computer.

- Select the **Use default device** option to use the default device for playback of ring tones.
- Select the **Select device** option and select from the drop-down list the audio device you want to use.
- To configure the Communicator to use custom ring tones:
  » Select the **Use custom ring tone** check box.
  » Click the **Select** button.
  » Navigate to the audio file containing the ring tone you want to use.
  » Click **Open**.
- To configure the Communicator to use custom busy tones:
  » Select the **Use custom busy ring tone** check box.
  » Click the **Select** button.
  » Navigate to the audio file containing the ring tone you want to use.
  » Click **Open**.

12 When all configuration settings have been made, click **Apply**, then click **OK**.
Resources

Additional Documentation

In addition to this guide, the following resources are available to provide you with information about IPCM:

- **Online Help** - Accessed by clicking a help icon in the Management Portal, online help provides page-specific topics and step-by-step instructions to walk you through basic tasks, in addition to a comprehensive table of contents and search function.

- **IPCM Agent Dashboard User's Guide** - Provides IPCM agents and supervisors with the information necessary to use the Agent Dashboard client application.

- **IPCM Web Statistics Guide** - Provides administrators with the information necessary to configure the Web Statistics product, which works in conjunction with IPCM to allow users to view IPCM real-time statistical data in a browser.

- **IPCM Outbound Dialer Guide** - Provides administrators with the information necessary to create and manage outbound campaigns (such as telesales) using the Outbound Dialer product in conjunction with IPCM.

  **Note:** Guides are available in PDF format from the Installation kit or from [https://www.ivanti.com/](https://www.ivanti.com/) for maintenance customers.

- **Training Courses** - Information regarding training courses for Ivanti family of products can be found at: [https://ivanti.com](https://ivanti.com)
Contact Us

Support Site

Ivanti can answer your technical support questions about ISM, Foundation/ITSM, CSM, and GMEE, GoldMine, and other Ivanti product families. Visit:

http://www.ivanti.com

Contact Information

Ivanti
Tel: 1.801.308.8047

Offices are also located in Latin America, Asia Pacific, Europe, and South Africa. For international contact information, go to the Ivanti Web site and click Support.
Supervisor Functions

The Contact Center Supervisor can monitor agent activity through the use of the Agent Dashboard and the Statistics Console. While logged into the Agent Dashboard, the supervisor can assign calls to agents, monitor and participate in conversations, perform whisper conferencing (coaching heard only by the agent, and record agent conversations.

Supervisors can use the Statistics Console to view real-time statistics for agents, agent groups, services, as well as the entire contact center, and can also log out agents, if needed.

- Agent Dashboard Interface
- Assign Calls to Agents
- Participate in Conversations
- Monitor Conversations
- Recording Agent Conversations
- Whisper Conferencing
- Statistics Console
- Log Out Agents
- Interaction Reports

Monitor Agents Using the Agent Dashboard

The Agent Dashboard is a client application running on the computer of each agent and supervisor in the contact center. Each Agent Dashboard installation has a softphone: a built-in application with a graphical user interface for performing basic telephony tasks such as answering, dialing, transferring, and hanging up calls. A microphone and speaker or headset attached to the computer enables agents to audibly converse with callers, just as you would using a desktop phone.

Agents use the Agent Dashboard to:

- Perform call handling tasks, such as answering, transferring, and dialing calls using the buttons on the Control Bar and the Softphone tab.
- View the properties of calls in the queue using the Queue tab.
- Notify the server of their availability to receive calls using the Agent State bar.

Supervisors use the Agent Dashboard to:

- View the states of all agents and monitor calls using the Quality Management tab.
- View the properties of calls in the queue and assign calls to an agent using the Queue tab.

Log In

To Log into the Agent Dashboard:

1. Select Start>Programs>FrontRange Solutions>Communications Management>Agent Dashboard.

2. In the login dialog box, type the IPCM user name and password provided by your system administrator. Do not change other fields on the dialog box unless instructed to do so by the system administrator.

3. Select the Save password check box to have the Agent Dashboard remember your password.

4. Click OK. The Agent Dashboard interface displays your user name and extension.

Note: If the Agent Dashboard does not connect, the softphone might still work depending on the configuration of the contact center; however, the Agent Dashboard cannot receive calls the server distributes. Contact the system administrator for assistance if this occurs.

Agent Dashboard Interface

The Agent Dashboard has the following tool bars:

- **Menu Bar** - Provides access to commands and configuration options.

- **Control Bar** - Contains call controls for the softphone, a drop-down list of the calls the Agent Dashboard is currently handling, a missed call indicator, and a voice mail indicator (only for installations with unified messaging).

- **Agent State Bar** - Contains controls to indicate availability to take calls, and displays the current state of the agent or supervisor.

- **Tabs** - The Agent Dashboard displays two tabs for agents and supervisors (the SoftPhone tab and the Queue tab), and a third tab (the Quality Management tab) for supervisors only.
Agent Dashboard Interface

- **Status Bar** - Displays connectivity and user information. Select **View> Status** to hide the Status bar.

Depending on the system configuration, the Agent Dashboard may display a list of all online agents and their status. Toggle this view by selecting **View> Agents**. If your system configuration does not give you this option, the **Agents** option in the **View** menu is inactive.

**Softphone Tab**

The **SoftPhone** tab lets you perform basic telephony tasks using your computer. The arrow icons in the top right corner of each section minimize and maximize the section.

*Note: Depending on the Agent Dashboard configuration, the SoftPhone tab may not be visible to agents and supervisors using a SIP-enabled desk phone.*

The **SoftPhone** tab features include:

- **Current Active Calls Display** - Displays information about the calls you are currently handling. A red arrow symbol indicates an inbound call; a green arrow symbol indicates an outbound call.

- **Control section** - Contains call controls for the softphone, similar to those available on the **Control** bar. The field at the bottom of the **Control** section enables you to enter a string of digits while you are on a call (also enabling you to edit them). For example, you could use this field to dial an authorization code after dialing an outside extension (type the digits, then click the arrow to the right of the field).

- **Audio section** - Controls volume levels for the current call. The left slider controls your speaker, and the right controls the your microphone. You can click the **Mute** check box to temporarily disable the microphone so a caller cannot hear your voice.

- **Keypad section** - Displays the keys you click to dial telephone numbers and enter Dual Tone Multi-Frequency (DTMF) digits while making outbound calls. The number you enter appears in the **Control** field.
Queue Tab

The Queue tab lets you view the various queues containing current calls waiting for agents. The Queue tab does not list calls between agents or calls between agents and supervisors.

The left pane of the Queue tab displays a hierarchy of contact center queues. Select a queue and the right pane displays the calls in that queue, as well as information about each call including the amount of time the call has been in the queue, the call service type (customer service, technical support, etc.), the agent to which IPCM assigned the call, etc.

Note: The information the Queue tab displays depends on the IPCM configuration.

The Queue tab contains the following default queues:

- **My Personal Queue** - Displays all calls assigned to you. A call is assigned to a personal queue when one of the following occurs:
  - The Interactive Voice Response (IVR) system assigns the call to a user.
  - A supervisor assigns a call to an agent; the call appears in the agent’s personal queue. (refer to Assign Calls to Agents on page 154).
  - A call is parked in a personal queue (refer to "Parking Calls" in the Agent Dashboard User’s Guide).

- **All Queued Interactions** - Displays all calls waiting in all queues.

- **ISM Demo Queue** - Displays calls that are part of the ISM configuration demonstration application included with IPCM.

- **ITSM Demo Queue** - Displays calls that are part of the Foundation/ITSM, CSM, and GMEE configuration demonstration application included with IPCM.

- **GoldMine Demo Queue** - Displays calls that are part of the GoldMine configuration demonstration application included with IPCM.

- **Outbound calls** - Display only if IPCM Outbound Dialer is installed (refer to the IPCM Outbound Dialer Guide).

Note: For information on HEAT, Foundation/ITSM, CSM, and GMEE, and GoldMine, refer to the documentation accompanying those products.

The Queue tab may contain other queues, depending on the system configuration.
Agents can remove a call from any of the visible queues and place the call in their personal queue by selecting a call in the Queue tab and clicking the Pull button. If the agent is ready to receive the call, the phone rings; if not ready, the call goes into their personal queue.

Quality Management Tab

The Quality Management tab lets supervisors monitor the activity of agents logged into IPCM and displays agent states. IPCM categorizes the status of each agent, call, and interaction into states. Each agent, call, or interaction can be in only one state at a time. For example, an agent can be in the Ready state, meaning the agent is ready to take calls. If IPCM routes a call to the agent, IPCM changes the agent from the Ready state to the Reserved state, during which time the agent’s phone rings and the agent becomes unavailable to take other calls. When the agent answers the call, IPCM changes the agent to the Busy state, during which time the agent has an active conversation with the caller.

IPCM automatically triggers some types of state changes, while the actions of agents and callers trigger other types of state changes. For example, an agent hanging up a call places the agent in the After-Call Work state. State changes can also be manual: you can allow agents to manually put themselves in the Not Ready state, meaning they are logged into IPCM but unavailable to take calls. This notifies IPCM to re-route calls that would normally go to that agent.

The Quality Management tab displays the following information:

- **State** - The state of the agent.
  - Logged Out - The agent is not logged into the Agent Dashboard.
  - Not Ready - The agent is unavailable to take calls because the agent clicked the Not Ready button on the Agent Dashboard.
  - Ready - The agent is available to take calls.
  - Reserved - IPCM is routing a call to the agent, making the agent unavailable to take other calls. The agent’s phone rings during this state.
  - Busy - The agent is engaged in an active conversation with the caller or is transferring the call.
  - After-Call Work - The agent has completed the call and is engaged in after-call work, which consists of tasks related to the call. These tasks can include completing the fields on a call management record or editing notes about the call. The agent is unavailable to take calls while in the After-Call Work state. Depending on the system configuration, agents either automatically return to the Ready state after a configured period of time elapses, or manually place themselves back in the Ready state after completing the post-call tasks.
Supervisor Functions

• **Reason** - The **Not Ready** reason the agent selected if the agent is in the **Not Ready** state (not ready reasons may or may not be required; refer to Not Ready Reasons Configuration on page 67).

• The agent’s last and first name.

• **Number** - The agent’s telephone number or extension.

• **Recorded by** - The name of the supervisor recording the conversation (if the conversation is being recorded).

• **Monitoring type** - The type of monitoring the supervisor is using, if any.

• **Monitored by** - The name of the supervisor monitoring the conversation (if the conversation is being monitored).

• **ID** - The agent’s user name.

**Note:** While on the on the SoftPhone and Queue tabs, supervisors can also display the Quality Management tab information in an additional pane by selecting View>Agents.

Assign Calls to Agents

When you log into the Agent Dashboard as a supervisor, the **Queue** tab displays the **Assign** button. The **Assign** button lets you assign a queued call to a specific agent.

► **To Assign Calls:**

1. On the **Queue** tab, select a queued call. The **Assign** button becomes active.
2. Click the **Assign** button. The Agent Dashboard displays a list of agents.
3. Select an agent. The Agent Dashboard assigns the call to that agent. If the agent is in the **Not Ready** state, the call goes into the agent’s queue.

Participate in Conversations

Supervisors with the Quality Management supervisor role can join a conversation between an agent and a third party.

► **To Participate in a Conversation:**

1. On the **Quality Management** tab, select an agent who is on a call. The **Participate in Conversation** button becomes active.
2. Click the **Participate in Conversation** button. Your phone rings.
3. Answer the call. Both the agent and third party can hear your voice. The agent and possibly the third party may hear a notification message when a supervisor joins a conversation, depending on the IPCM configuration in the voice application (refer to the online help topic “Voice Application Design: Building Block Definitions: Connect Call Block.”).
Monitor Conversations

Supervisors can use the Agent Dashboard to listen to agent calls. The system administrator configures the voice application to enable the Agent Dashboard to allow one of following:

- **Undisclosed monitoring** - The agent and the person with whom the agent is talking are unaware the supervisor is listening.
- **Disclosed monitoring** - The Agent Dashboard plays a tone when the supervisor begins listening, notifying the agent and the person with whom the agent is talking that their conversation is being monitored.

► **To Monitor a Call:**

1. On the Quality Management tab, select an agent who is on a call. The Monitor Conversation button becomes active.
2. Click the Monitor Conversation button. Your phone rings.
3. Answer the call and listen to the conversation between the agent and the caller.

Recording Agent Conversations

Supervisors with the Quality Management supervisor role can use the Agent Dashboard to record agent calls.

**WARNING:** You may record phone calls through the use of the licensed software. The laws on recording phone calls vary from country to country and state to state. Ivanti recommends you inform the other party or parties to your phone call that you are recording their conversation; however, it is your responsibility to comply with all applicable laws and regulations in your use of the licensed software. You agree to abide by all applicable communication, privacy, and similar rules, directives, and other laws in your use of the licensed software. In no event will Ivanti be liable for any action or inaction on your part which leads to or causes you to break the law.

The system administrator configures the voice application to enable the Agent Dashboard to allow one of following:

- **Undisclosed recording** - The agent and the person with whom the agent is talking are unaware the supervisor is recording the conversation.
- **Disclosed recording** - The Agent Dashboard plays a tone when the supervisor begins recording, notifying the agent and the person with whom the agent is talking that their conversation is being recorded.

**Note:** A Contact Center Supervisor who has been granted the Configure Quality Management privilege can schedule agent recordings; refer to the online help topic "Contact Center Server Configuration: Agent Configuration: Agent Interaction Recording Option" for details.

► **To Record a Call:**

1. On the Quality Management tab, select an agent who is on a call. The Record Conversation button becomes active.
2. Click the Record Conversation button. IPCM records the conversation.
Supervisor Functions

► To Access the Recorded Conversation:
  • Use the Management Portal>Reporting>Interactions feature as described in Interaction Reports on page 160.

Whisper Conferencing

Whisper conferencing lets a supervisor with the Quality Management supervisor role join a call between an agent and a third party and converse with the agent without the third party hearing the supervisor. The supervisor and agent can hear each other and the third party, but the third party can hear only the agent. This feature gives supervisors the ability to coach agents on a call without the third party noticing.

► To Enable Whisper Conferencing:
  1 On the Quality Management tab, select an agent who is on a call. The Whisper button becomes active.
  2 Click the Whisper button. Your phone rings.
  3 Answer the call. The whisper conference is active. The agent can hear your voice, but the third party cannot. The agent and possibly the third party may hear a notification message when the supervisor whispers into the conference, depending on the IPCM configuration in the voice application (refer to the online help topic "Voice Application Design: Building Block Definitions: Connect Call Block").

Statistics Console

The Statistics Console is a client application for supervisors that displays real-time statistical data about:
  • Agents
  • Agent groups
  • Services
  • The contact center as a whole

These statistics include the number of calls coming into the contact center, the average time each agent spends talking to a caller, the maximum duration for which a caller is on hold, the number of callers who hung up when calling about a specific service, etc. Some of these statistics are current values (such as the current number of busy lines) while others are values calculated over a specific monitored period (such as the number of calls answered in the last hour, or the minimum call duration since midnight).

► To Open the Statistics Console:
  1 Click Start>Programs>FrontRange Solutions>Communications Management>Statistics Console.
  2 In the left panel, click the Connection button.

The Statistics Console automatically detects a local IPCM installation. Use the following procedure to establish a connection between a remote Statistics Console and the Contact Center server, or add a new Contact Center server connection to the Statistics Console.
To Establish or Add a Connection:

1. Open the Statistics Console by clicking Start>Programs>FrontRange Solutions>Communications Management>Statistics Console.

2. Select File>New Connection. The New Connection screen opens and a New Connection tab is added to the left pane.

3. Click the Configure button to activate the fields on the New Connection screen, and complete the fields:

- **Title** - Type the name of the new connection as you want it to display on the tab in the left pane of the Statistics Console.

- **Connect To** section - Select the Remote System radio button, which activates the Name/Address and Port Number fields.

- **Name/Address** - Type the IP address or computer name of the Contact Center server host computer to which you want to connect.

- **Port Number** - Type the port number of the Contact Center server to which you want to connect (the default is 1972).

- **Description** - Type a description of the connection.

- **Connect Automatically** - Select this check box if you want this connection to occur every time you start the Statistics Console.

4. Click the Connect button. The Statistics Console connects to the Contact Center server you specified.

**IMPORTANT:** If the Statistics Console cannot connect, error messages display in the left pane. Click Start>Settings>Control Panel>Administrative Tools>Services and restart the IPCM Message Bus and IPCM Statistics and Metrics Engine services to correct the problem.
Supervisor Functions

► To Close a Connection:
1. At the bottom of the left pane, click the tab for the connection.
2. Click File>Disconnect.

► To Delete a Connection:
1. At the bottom of the left pane, click the tab for the connection.
2. Click File>Delete Connection.

Viewing Statistics

You can view statistics for an agent, agent group, or service by selecting the desired object in the hierarchy on the left. The statistics pertaining to the object you select appear on the right.

With the 2018.1 release, a new option has been added where agents can be viewed with their full name i.e. First name and Last name in Statistics Console. This will avoid confusion between agents have similar first name or login id’s. This option can be selected from the View menu.

For example, to view the statistics for an individual agent, expand the hierarchy until the name of the agent appears, then select the agent’s name.

Select All Agents to view a compilation of the statistics for all agents. Select Contact Center to view a compilation of the statistics for the entire contact center. Select a service to view the statistics pertaining to that service.
One Statistics Console can monitor multiple IPCM deployments. Use the tabs at the bottom of the hierarchy on the left to choose the IPCM deployment you want to monitor.

**Note:** When the IPCM Statistics and Metrics Engine service is down, all real-time statistics reset to zero.

The tabs at the bottom of the right pane of the Statistics Console let you view different types of statistics as well as statistics from different time periods. The tabs change depending on the object selected in the hierarchy on the left:

- **Last hour** - Displays statistics IPCM calculates using data recorded from 60 minutes ago to the present.
- **Outbound** - Displays outbound call statistics (refer to the Outbound Dialer Guide).
- **Overview** - Displays a combination of statistics IPCM calculates using data recorded since midnight, and data recorded from 60 minutes ago to the present.
- **Staging** - Displays statistics based on queue stages (queue stages are a series of timers that begin when an initiating event, such as answering a call, occurs, and end a configurable number of seconds later; refer to the online help topic "Statistics" for more information).
- **Today** - Displays statistics IPCM calculates using data recorded since midnight, or a time specified in the configuration by your system administrator.
- **Services** - Displays services statistics IPCM calculates using data recorded since midnight, and data recorded from 60 minutes ago to the present.
- **Inbound** - Displays inbound call statistics.

**Note:** Refer to the online help topic "Web Statistics Overview" or the IPCM Web Statistics Guide if your company has chosen to use Web Statistics, which is a configurable tool for statistics viewing.

---

## Log Out Agents

You might need to log out an agent when a system problem arises. This is done from the Management Console:

1. Open the Management Console by clicking **Start>Programs>FrontRange Solutions>Communications Management>Management Console**.
Supervisor Functions

2 In the Objects panel, click the Contact Center Server. The Agents and Interactions tabs appear in the right pane.

3 Click the Agents tab to display all configured agents.

4 Right-click the agent you want to log out and select Logout Agent. The agent changes to the Logged Out state.

Interaction Reports

Interaction reports are reports listing records of previous interactions within IPCM. Records include audio recordings of agent calls.

You can search for recordings, then play the recordings and rate the agent performance.
**Recordings: Search, Listen, and Rate**

The **Interactions** page (Management Portal>Reporting>Interactions) lets you search for interaction records in the IPCM database, and save the searches you perform. You can create a new search or run a saved search to find the desired recordings. The search parameters can include a default time frame (such as This month) or you can define a specific time frame.

Once you perform the search, you can listen to audio recordings of agent conversations listed on the **Found Interactions** page. These recordings are triggered by any of the following:

- A supervisor clicking the Record Conversation button on the Quality Management tab of the Agent Dashboard interface.
- A voice application (refer to the online help topic "Voice Application Design: Building Block Definitions: Connect Call Block").
- The Contact Center Quality Management schedule (refer to the online help topic "Contact Center Server Configuration: Agent Configuration: Agent Interaction Recording Option").

**Note:** An agent can record a call by clicking the Record button on the Agent Dashboard. However, this action records the call only locally (on the client workstation). Local recordings are not available on the server (or in the Management Portal). Only server side recordings are tracked by server.
To Find, Listen to, and Rate Recordings:

1. In the Management Portal, click Reporting>Interactions.
2. On the Interactions page, set the Search Parameters:

   - **Time zone** - Select your time zone in the drop-down list.
   - **Dates** - The time frame from which you want to retrieve interaction records. Either select a defined period such as Today, or select the Custom option and specify a range in the From and To fields.
   - **From** and **To** fields - If you select the Custom option in the Date field, specify the time frame for which you want the search to retrieve interaction records: either specify the earliest date and time using the From field, the latest date and time using the To field, or a range of time using both fields. Either click the calendar icon next to the field and specify a date and time in the pop-up, or type the date/time in the field using the following format: <month>/<day>/<year> <hour>:<minute>:<second>. For example: 06/05/2006 15:53:25.
   - **Show** - Select All calls if you want the search to return records of all interactions. Select Only calls with recordings if you want the search to include only calls that were recorded.
   - **Rows in result** - Select the number of rows you want the search to return.
   - **Filter by** - Select the interaction property you want to use as the search key, or select the Custom option to manually enter both Field and Value.
   - **Value** - Enter or select the value of the attribute you selected in the Filter by field.

1. Click the Search Interactions button. IPCM searches the database and refreshes the page to display the results.
2. On the Found Interactions page, recordings are marked with an audio icon. Click the audio icon to listen to a recording. The Listen Interaction screen opens, displaying audio controls that control the playback of the recording, as well as several different categories of ratings that enable you to rate the recording on a scale of 1 to 10 in various categories.

   **Note:** The red icon indicates a recording error occurred and provides an explanation.
3 Rate the recording by selecting ratings from the drop-down lists. You can also add comments in the **Record Note** field (maximum 255 characters). The notes will be visible to anyone else subsequently viewing the interaction. Click the **Update** button.

**Note:** You can download the recording if needed: in the **Listen Interaction** dialog box click the **Download** button, in the **File Download** dialog box click the **Save** button, in the **Save as** dialog box click the folder in which you want to store the recording and click **Save**, then click **Close**.

4 Click the **Close** button to return to the **Found Interactions** page.

5 You can listen to and rate other recordings or click the **Back** link at the top of the page, below the **Interactions** tab, to run another search.

**Saving Searches**

➤ **To Save a Search:**

1 On the **Interactions** page, configure your search by setting the parameters in the **Search Parameters** section.

2 Click the **Save(As)** button. The **Set Criteria Name** dialog box opens.

3 Type a name for the search and click **Ok**. The search is added to the **Saved Criteria** drop-down list.
Supervisor Functions

► To Run a Saved Search:

1 Select the search in the Saved Criteria drop-down list. The values in the Search Parameters change to reflect the search you select.

2 Click the Search Interactions button to run the search.

► To Delete a Saved Search:

1 Select the search in the Saved Criteria drop-down list.

2 Click the Remove button.

3 Click the OK to confirm the deletion.
create and delete, 136
create agent groups, 69
create agents, 72
create and configure roles, 57
create application, 104
create class of restrictions, 136
create phone groups, 135
create prompts, 107
create queues, 92
create routing rules, 87
create services, 91
create skill groups, 65
create users, 60

D
database planning, 12
delete agent groups, 72
delete agents, 73
delete class of restrictions, 136
delete phone groups, 135
delete queues, 92
delete roles, 58
delete routing rules, 90
delete services, 91
delete skill groups, 66
delete skills, 66
delete users, 61
develop simple call scenarios, 120
dial plan, 35
  best practices, 38
  implementation, 36
  shortcuts, 41
  worksheet, 40
disable agents, 73

G
generic skills-based routing, 85
global address book, 134
group-based routing, 86

H
hardware requirements, 10

I
installation
  Adobe SVG Viewer 3.0 Setup, 25
  client, 27
  overview, 19
  server, 19
  server verification, 26
integration options, 12
IPCM architecture, 5
IPCM communicator, 7
L
license file requirement, 12
license server, 6
log in
  agent dashboard, 150
log out agents, 159
M
management console, 6, 26
management portal, 6, 32, 33
  commit changes button, 34
  navigation, 33
media server, 6
message server, 6
monitor conversations, 155
N
navigation
  management portal, 33
network requirements, 11
not ready reasons
  configuration, 67
P
participate in conversations, 154
phone groups
  call hunt, 135
  call pickup, 135
  create and delete, 135
phone options, 13
ports and firewall settings, 16
prefix manipulation, 44
  examples, 46
priority-based routing, 86
privileges, 53
prompt manager, 106
prompts, 106
  create prompts, 107
  languages, 106
  prerecorded prompts, 113
  prompt manager, 106
  prompt segments types and descriptions, 110
  prompt storage, 113
  select a prompt, 112
Q
quality management tab, 153
queues, 91
alarms, 99
configuration, 94
create and delete, 92

R
record conversations, 155
recordings
listen to, 161
rate, 161
save searches, 163
search for, 161
require not ready reason, 75, 80
role configuration, 53
privileges, 53
roles
create and configure, 57
defined, 55
delete, 58
roles and privileges table, 55
routing rules, 81
common approaches, 85
configure, 82
create, 87
delete, 90
generic skills-based routing, 85
group-based routing, 86
priority-based routing, 86
specific agent-based routing, 87

S
server installation, 19
servers
hardware requirements, 11
services, 90
create, 91
delete, 91
SIP hardware requirements, 11
SIP soft switch, 6
skill configuration, 64
skill groups
create, 65
delete, 66
delete skills, 66
SME, 6
softphone, 13
software requirements, 10
specific agent-based routing, 87
statistics and metrics engine, 6
statistics console, 156
supervisor functions
assign calls to agents, 154
log out agents, 159
monitor conversations, 155
participate in conversations, 154
record conversations, 155
whisper conferencing, 156
system requirements
hardware, 10
software, 10
system-wide agent settings, 80
T
text-to-speech, 14
installation, 122
trunks and gateways, 41
add, 41
prefix manipulation, 44
U
unattended client installation, 31
unified messaging, 123
unified messaging settings
general tab, 128
users, 130
user codes, 139
user profile
configure, 61
user settings
general tab, 62
users
add, 60
delete, 61
V
view statistics, 158
voice applications
best practices, 114
voice server, 6
W
whisper conferencing, 156